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Module-1 
OFFICE AUTOMATION SYSTEM 

Introduction to Information Technology  

Data leads to information, information leads to knowledge, knowledge leads to wisdom, and 

wisdom is the key to existence of human civilizations. Our need of accuracy and revolution towards 

processing of information has led us to ‗Information Revolution‘. Computers and IT tools can take 

humans to the peak of new millennium or destroy human civilization. In simple words ‗IT‘ means 

collection, storage, dissimilation and use of information. It includes any technology used in capturing, 

storing and processing data into information and communicating that information to people. Computer 

and communication technologies are integral parts of today‘s information technology. Today IT has 

impacted every aspects of human life with incredible effect. IT is not confined to hardware and software 

but acknowledgement of importance of man and the goals he sets to the technology.  

Major activities that expedited the information age: 

A. In 1820‘s Charles Babbage invented the ever first computer called Babbage machine. It was based on 

mechanical gears and discs. This was the first step of human mankind towards computer.  

B. From 1890 to 1900, abundant and rapid development of electricity.  

C .In 1928, electron movement thesis came that opened various aspects towards pristine fields. Invention 

of electronic equipments fueled the revolutionary scenario of IT.  

D. In 1943, transistor was developed. 

E. In 1948, ENIAC, the first computer of modern age was invented by US; it was based on Vacuum Tubes. 

F. In 1958, transistors were used (Advantage: less power consumption, more accurate. Computers 

accommodated 100s and 1000s of transistors. Result: Computers size was as big as room).  

G. ICs replaced transistors. ICs evolved during last 35 years and have now become multi tasking, 

sophisticated algorithm design based chips. Computers of human types are replacing ICs by neuron type 

chips and neural networks.  

Technological aspects of IT:  

Enabling Technologies: Enabling Technologies involves:-  

a. Data Generation  

b. Data Processing  

c. Data Transportation  

d. Data Storage  

e. Data Retrieval  

f.  Data Representation  
 

Major Technologies evolved in the entire activity:  

i) Data Processing and storage by computers. In the form of silicon based IC (integrated circuit) 

technology.  

ii) Communication technology: Optical fibre communication resulting fibre optic link around the globe.  

iii) Memory technologies – Laser disc and CD-ROM.  

iv) Display technologies – LCD and digital.  

Applications of IT: IT applications are almost ubiquitous; key coverage areas include:  

i.  Education and training systems  

ii. E-governance  

iii. Industrial sector  

iv. Improvement in social interaction and it is expected that manufacturing discrimination will disappear  

v. Employment to multitude of people. 



School of Distance Education 
 

Information Technology for Business & Management                       6 
 

Office automation 

The history of modern office automation began with the typewriter and the copy machine, which 

mechanized previously manual tasks. Today, however, office automation is increasingly understood as a 

term that refers not just to the mechanization of tasks but to the conversion of information to electronic 

form as well. The advent of the personal computer revolutionized office automation, and today, popular 

operating systems and user interfaces dominate office computer systems. This revolution has been so 

complete, and has infiltrated so many areas of business, that almost all businesses use at least one 

commercial computer business application in the course of daily activity. Even the smallest companies 

commonly utilize computer technology to maintain financial records, inventory information, payroll 

records, and other pertinent business information. "Workplace technology that started as handy (but still 

optional) business tools in the 1980s evolved into a high-priority requirement in the 1990s, 

              The integration of office information functions, including word processing, data processing, 

graphics, desktop publishing and e-mail. Office automation was a popular term in the 1970s and 1980s as 

the desktop computer exploded onto the scene. The backbone of office automation is the company's local 

area network (LAN). All office functions, including dictation, typing, filing, copying, fax, microfilm and 

records management and the telephone switchboard, fall into this category. Office automation refers to the 

varied computer machinery and software used to digitally create, collect, store, manipulate, and relay office 

information needed for accomplishing basic tasks .Raw data storage, electronic transfer, and the 

management of electronic business information comprises the basic activities of an office automation 

system.  Office automation helps in optimizing or automating existing office procedures. 

      Office automation refers to the varied computer machinery and software used to digitally create, 

collect, store, manipulate, and relay office information needed for accomplishing basic tasks. Raw data 

storage, electronic transfer, and the management of electronic business information comprise the basic 

activities of an office automation system.  Office automation helps in optimizing or automating existing 

office procedures. 

The backbone of office automation is a LAN, which allows users to transmit data, mail and even voice 

across the network. All office functions, including dictation, typing, filing, copying, fax, Telex, microfilm 

and records management, telephone and telephone switchboard operations, fall into this category. Office 

automation was a popular term in the 1970s and 1980s as the desktop computer exploded onto the scene.  

Definition 

Application of information technology to the typical clerical and secretarial tasks such as communication, 

correspondence, documenting, and filing. The use of computer systems to execute a variety of office 

operations, such as word processing, accounting, and e-mail. Office automation almost always implies a 

network of computers with a variety of available programs. A general technology term that is used to 

describe any process being automated through the use of computers and computer software. Processes that 

have been automated require less human intervention and less human time to deliver. 

Objectives of Office Automation  

1. To improve customer relation  

2. To achieve better management control 

3. To simplify operations and minimize computational errors 

4. To improve quality of output in terms of presentation and reduction in processing time 

5. Documents preparation 

6. Data management 

7. planning of activities 

8. Presentation 

9. Dissemination of Information 

10. Communication 

http://www.answers.com/topic/typewriter
http://www.answers.com/topic/infiltrate
http://www.answers.com/topic/payroll
http://www.answers.com/topic/pertinent
http://www.answers.com/topic/handy
http://en.wikipedia.org/wiki/Computer
http://en.wikipedia.org/wiki/Software
http://en.wikipedia.org/wiki/LAN
http://www.businessdictionary.com/definition/information-technology-IT.html
http://www.businessdictionary.com/definition/typical.html
http://www.businessdictionary.com/definition/task.html
http://www.businessdictionary.com/definition/communication.html
http://www.businessdictionary.com/definition/correspondence.html
http://www.businessdictionary.com/definition/documenting.html
http://www.businessdictionary.com/definition/filer.html
http://www.webopedia.com/TERM/C/computer_system.html
http://www.webopedia.com/TERM/E/execute.html
http://www.webopedia.com/TERM/W/word_processing.html
http://www.webopedia.com/TERM/E/e_mail.html
http://www.webopedia.com/TERM/N/network.html
http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/P/program.html
http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/S/software.html
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Features of Office Automation  

1.      Improvement in quality of output 

2.      Improved productivity/ efficiency 

3.      Optimal utilization of resources 

4.      Reduction in time taken in execution of activities 

5.      Better Information sharing/ Transparency 

6.      Better way of delivery of information to user at a place convenient to him/her 

7.      Reduction in dependency on human beings 

8.      Look for simplification of procedures  

9.      Better customer support etc 

Document generation and facilitating equipments 

 A document is a written statement giving information, proof, evidence etc. document is a written or 

printed paper that bears the original, official, or legal form of something and can be used to furnish decisive 

evidence or information.  It is writing that provides information (especially information of an official 

nature) 

Document processing is the creation, handling, labeling, and modification of text documents, such as in 

word processing and in the indexing of documents for retrieval based on their content. Following are the 

important equipment concerned with document generation. 

 Dictation system 

Dictation system records voice inputs. This system has a microphone to capture voice inputs. Executive 

can use it to speed up document generation and to save their time since they are not going to dictate to their 

secretaries. Digital dictation is a method of recording and editing the spoken word in real-time for 

transcription and maximum intelligibility in a digital audio format. In some cases speech is recorded where 

sound quality is paramount and transcription unnecessary. 

Digital dictation offers several advantages over traditional cassette tape based dictation: 

 The user can instantly rewind or fast forward to any point within the dictation file to review or edit. 

 The random access ability of digital audio allows inserting audio at any point without overwriting the 

following text. 

 Dictation produces a file which can be transferred electronically, e.g. via WAN, LAN, USB, e-mail, 

telephony, BlackBerry, FTP, etc. 

 Large dictation files can be shared with multiple typists. 

 Sound may be CD quality and can improve transcription accuracy and speed [citation needed]. 

 Digital dictation provides the ability to report on the volume or type of dictation and transcription 

outstanding or completed within an organization. 

Electronic typewriter 

Typewriter is an instrument for writing by means of type, a type wheel, or the like, in which the operator 

makes use of a sort of   keyboard, in order to obtain printed impressions of the   characters upon paper. A 

typewriter whose operation is enhanced through the use of microprocessor technology to provide many of 

the functions of a word-processing system but which has at most a partial-line visual display. Also known 

as memory typewriter. Today‘s world typewriters have been replaced by inexpensive personal computers 

which have the advantage of having word processing software and can be used with a variety of printers 

available. 

 

http://en.wikipedia.org/wiki/Digital_audio
http://en.wikipedia.org/wiki/Cassette_tape
http://en.wikipedia.org/wiki/Random_access
http://en.wikipedia.org/wiki/Digital_audio
http://en.wikipedia.org/wiki/Audio_file
http://en.wikipedia.org/wiki/File_transfer
http://en.wikipedia.org/wiki/Electronics
http://en.wikipedia.org/wiki/Wide_Area_Network
http://en.wikipedia.org/wiki/Local_area_network
http://en.wikipedia.org/wiki/Universal_Serial_Bus
http://en.wikipedia.org/wiki/E-mail
http://en.wikipedia.org/wiki/Telephony
http://en.wikipedia.org/wiki/BlackBerry
http://en.wikipedia.org/wiki/File_Transfer_Protocol
http://en.wikipedia.org/wiki/CD_quality
http://en.wikipedia.org/wiki/Wikipedia:Citation_needed
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Document distribution and related Equipments 

Following are the important equipments in connection with document distribution; 

Copier 

        Copier is a machine that makes copies of printed or graphic matter. This is a machine which makes 

exact copies of writing or pictures on paper, usually by a photographic process.  It is an apparatus that 

makes copies of typed, written or drawn material. 

A xerographic copier is duplicator that copies graphic matter by the action of light on an electrically 

charged photoconductive insulating surface in which the latent image is developed with a resinous powder. 

It is also called as Xerox machine 

Telex 

A telex is a teletypewriter. They are to consoles (or more, in a network), sitting at opposite ends of a phone 

line. What is typed on one machine is automatically relayed, and typed by the machine on the other one. 

The machines can be in the same building, or at opposite ends of the globe. In other words it is a character 

printer connected to a telegraph that operates like a typewriter. 

Facsimile  

 Facsimile is duplicator that transmits the copy by wire or radio. This is a system of telecommunication for 

the transmission of fixed images with a view to their reception in a permanent form. 

Fax is a process by which fixed graphic material including pictures, text, or images is scanned and the 

information converted into electrical signals which are transmitted via telephone to produce a paper copy 

of the graphics on the receiving fax machine. 

Personal computers 

A small, relatively inexpensive computer designed for an individual user. All are based on the 

microprocessor technology that enables manufacturers to put an entire CPU on one chip. Businesses use 

personal computers for word processing, accounting, desktop publishing, and for running spreadsheet and 

database management applications. At home, the most popular use for personal computers is for playing 

games. Personal computers first appeared in the late 1970s. One of the first and most popular personal 

computers was the Apple II, introduced in 1977 by Apple Computer. During the late 1970s and early 

1980s, new models and competing operating systems seemed to appear daily. Then, in 1981, IBM entered 

the fray with its first personal computer, known as the IBM PC.  

Work station for PC 

A workstation is a place where work gets done. It refers to a computer (and often the surrounding area) that 

has been configured to perform a certain set of tasks, such as photo editing, audio recording, or video 

production. An office may have several workstations for different purposes, which may be assigned to 

certain employees. For example, one workstation may be used for scanning and importing images, while 

another is used for editing images. While workstations are often part of a network, they can be standalone 

machines as well. Even a home computer can be a workstation if it is used for certain kinds of work. So if 

you want to sound professional, the next time you send an e-mail to a friend from your home PC, you can 

let him know you are sending it from your home workstation. 

Printers 

A printer is an output device that produces text and graphics on paper.  Printers can be divided into two 

main groups, impact printer and non-impact printer.  Impact printer produces text and images when tiny 

wire pins on print head strike the ink ribbon by physically contacting the paper.  Non-impact printer 

produces text and graphics on paper without actually striking the paper. 

http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/U/user.html
http://www.webopedia.com/TERM/M/microprocessor.html
http://www.webopedia.com/TERM/C/CPU.html
http://www.webopedia.com/TERM/C/chip.html
http://www.webopedia.com/TERM/W/word_processing.html
http://www.webopedia.com/TERM/D/desktop_publishing.html
http://www.webopedia.com/TERM/R/run.html
http://www.webopedia.com/TERM/S/spreadsheet.html
http://www.webopedia.com/TERM/D/database_management_system_DBMS.html
http://www.webopedia.com/TERM/A/application.html
http://www.webopedia.com/TERM/A/Apple_Computer.html
http://www.webopedia.com/TERM/O/operating_system.html
http://www.webopedia.com/TERM/I/IBM.html
http://www.webopedia.com/TERM/I/IBM_PC.html
http://www.techterms.com/definition/standalone
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Printers can also be categorized based on the print method or print technology.  The most popular ones are 

inkjet printer, laser printer, dot-matrix printer and thermal printer.  Among these, only dot-matrix printer is 

impact printer and the others are non-impact printers. 

Some printers are named because they are designed for specific functions, such as photo printers, portable 

printers and all-in-one / multifunction printers.  Photo printers and portable printers usually use inkjet print 

method whereas multifunction printers may use inkjet or laser print method. 

Inkjet printers and laser printers are the most popular printer types for home and business use.  Dot matrix 

printer was popular in 70‘s and 80‘s but has been gradually replaced by inkjet printers for home use.  

However, they are still being used to print multi-part forms and carbon copies for some businesses.  The 

use of thermal printers is limited to ATM, cash registers and point-of-sales terminals.  Some label printers 

and portable printers also use thermal printing. 

Due to the popularity of digital camera, laptop and SoHo office (small office / home office), the demand 

for photo printers, portable printers and multifunction printers has also increased substantially in recent 

years. 

Popular Printers: Inkjet printer, Laser printer 

 Less Popular Printers: Dot matrix printer, Thermal printer 

 Specialty Printers: Photo printer, Portable printer, Multifunction printer 

Storage technologies 

A computer storage device is any type of hardware that stores data. The most common type of storage 

device, which nearly all computers have, is a hard drive (hard disk). The computer's primary hard drive 

stores the operating system, applications, and files and folders for users of the computer. While the hard 

drive is the most ubiquitous of all storage devices, several other types are common as well. Flash memory 

devices, such as USB keychain drives and iPod nanos are popular ways to store data in a small, mobile 

format. Other types of flash memory, such as compact flash and SD cards are popular ways to store images 

taken by digital cameras. 

External hard drives that connect via Fire wire and USB are also common. These types of drives are often 

used for backing up internal hard drives, storing video or photo libraries, or for simply adding extra 

storage. Finally, tape drives which use reels of tape to store data are another type of storage device and are 

typically used for backing up data. 

The most common storage devices are: 

Floppy Disk – They are plastic square disks, usually with a silver or black sliding piece going across the 

top. These disks come in a variety of colors and they hold about 144 million bytes. (Bytes are characters, 

symbols and letters). 

Zip Disk – They look like a floppy disk, but they are a little thicker. This disk also comes in a variety of 

colors and holds about 200 MB of data. 

CD + RW Disc (Compact Disc Rewriteable) – This disc looks like a regular CD. The only difference is 

that you can write on this disc and erase it as many times as you want. It works just like a floppy disk or a 

zip disk. A CD + RW disc holds about 650 MB. 

CD + R Disc (Compact Disc Recordable) – This one is a CD that you can record on. It‘s mostly used to 

record audio and once it‘s been written on, you cannot rewrite or erase anything off of it. This compact disc 

comes in different sizes, but they are usually silver in color. (Some CDs are black in color and they actually 

don‘t get as many scratches on them as the silver ones do. They are also a lot less fragile). 

http://www.techterms.com/definition/harddrive
http://www.techterms.com/definition/flashmemory
http://www.techterms.com/definition/ipod
http://www.techterms.com/definition/compactflash
http://www.techterms.com/definition/sd
http://www.techterms.com/definition/firewire
http://www.techterms.com/definition/usb
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A DVD – R Disc (Digital Video Recordable) – These discs hold the space of about 4.7 GB and are used to 

record movies on. 

 
The more uncommon storage devices are: 

Removable Hard Drive – This is a disk drive in which a plastic or metal case surrounds the hard drive. It 

can be inserted and removed just like a floppy disk. It holds about 2 GB of data. 

Internet Hard Drive – This one is a service on the Internet that provides storage space to computer users. 

This service offers about 25 MB of space, but it could be more, depending on the service type. 

Flash Drive – This a storage device that comes in many colors and has a stick shape to it. They are very 

small in size, but they can hold anywhere between 256 MB and 3 GB of material on them. 

PC Card – This is a thin credit card size device that fits into a PC card slot, usually on a notebook 

computer. This card simply adds storage to most notebooks. 

Smart Cards – These are the size of an ATM card. When inserted into a smart card reader, they can read 

and update data for you. 

Storage Tape – This one is a magnetically coated ribbon of plastic, capable of storing large amounts of 

data at a very low cost. Usually, storage tapes are a little bigger than audio tapes. Older computers used 

tape and tape drives, but even today, some people still back their systems up with storage tape. These tapes 

hold between 20 GB to about 110 GB of data. An external tape drive can be purchased separately as well, 

but those are even harder to find. 

Miniature Mobile Storage Media – This is used mostly with handheld computers and digital cameras. 

Memory Stick – This is a rectangular shaped disk that is used mostly with digital cameras and notebook 

computers. They hold approximately 128 MB as well. 

Micro Drive – This is a square disk that has 1 GB of space and is used with digital cameras and handheld 

computers. 

Smart Media Disc – This is a square disk that has 2 MB to about 128 MB of space on it. It‘s used with 

digital cameras, handheld computers and photo printers 
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Computer Networks 

A computer network, often simply referred to as a network, is a collection of hardware components and 

computers interconnected by communication channels that allow sharing of resources and information. 

Where at least one process in one device is able to send/receive data to/from at least one process residing in 

a remote device, then the two devices are said to be in a network. 

A computer network is the practice of linking two or more computing devices and share data. Networks are 

built with a mix of hardware and software. This interconnected system to share services and interact 

through a communication link. 

A computer network is very useful in a business. Most of the time the company will have more of an 

integrated team and often very beneficial for all network desktops. A local area network (LAN) will link 

the computers of your company. This will allow the participation rate and the exchange of different 

information.   

Before the advent of computer networks that were based upon some type of telecommunications 

system, communication between calculation machines and early computers was performed by human users 

by carrying instructions between them. Many of the social behaviors seen in today's Internet were 

demonstrably present in the 19th century and arguably in even earlier networks using visual signals. 

 

Computer networks -advantages 

Facilitate communications  

Using a network, people can communicate efficiently and easily via email, instant messaging, chat rooms, 

telephone, video telephone calls, and video conferencing. 

Permit sharing of files, data, and other types of information 

In a network environment, authorized users may access data and information stored on other computers on 

the network. The capability of providing access to data and information on shared storage devices is an 

important feature of many networks. 

Share network and computing resources 

In a networked environment, each computer on a network may access and use resources provided by 

devices on the network, such as printing a document on a shared network printer. Distributed computing 

uses computing resources across a network to accomplish tasks. 

 

Disadvantages 
May be insecure 

A computer network may be used by computer hackers to deploy computer viruses or computer worms on 

devices connected to the network, or to prevent these devices from normally accessing the network  (denial 

of service). 

May interfere with other technologies 

Power line communication strongly disturbs certain forms of radio communication, e.g., amateur radio. It 

may also interfere with last mile access technologies such as ADSL and VDSL 

May be difficult to set up 

A complex computer network may be difficult to set up. It may also be very costly to set up an effective 

computer network in a large organization or company 

http://www.mortalidadmaterna.org/
http://en.wikipedia.org/wiki/Distributed_computing
http://en.wikipedia.org/wiki/Computer_hacker
http://en.wikipedia.org/wiki/Computer_virus
http://en.wikipedia.org/wiki/Computer_worm
http://en.wikipedia.org/wiki/Denial-of-service_attack
http://en.wikipedia.org/wiki/Denial-of-service_attack
http://en.wikipedia.org/wiki/Power_line_communication
http://en.wikipedia.org/wiki/Last_mile
http://en.wikipedia.org/wiki/ADSL
http://en.wikipedia.org/wiki/VDSL
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 Networks Types 
 Local Area Network. 

 A Local Area Network (LAN) is a network that is confined to a relatively small area . It is generally 

limited to a geographic area such as a writing lab, school, or building. Computers connected to a network 

are broadly categorized as servers or workstations. Servers are generally not used by humans directly, but 

rather run continuously to provide "services" to the other computers (and their human users) on the 

network. Services provided can include printing and faxing, software hosting, file storage and sharing, 

messaging, data storage and retrieval, complete access control (security) for the network's resources, and 

many others.  

Workstations are called such because they typically do have a human user which interacts with the network 

through them. Workstations were traditionally considered a desktop, consisting of a computer, keyboard, 

display, and mouse, or a laptop, with integrated keyboard, display, and touchpad. With the advent of the 

tablet computer, and the touch screen devices such as iPad and iPhone, our definition of workstation is 

quickly evolving to include those devices, because of their ability to interact with the network and utilize 

network services.  

On a single LAN, computers and servers may be connected by cables or wirelessly. Wireless access to a 

wired network is made possible by wireless access points (WAPs). These WAP devices provide a bridge 

between computers and networks. A typical WAP might have the theoretical capacity to connect hundreds 

or even thousands of wireless users to a network, although practical capacity might be far less.  

Nearly always servers will be connected by cables to the network, because the cable connections remain 

the fastest. Workstations which are stationary (desktops) are also usually connected by a cable to the 

network, although the cost of wireless adapters has dropped to the point that, when installing workstations 

in an existing facility with inadequate wiring, it can be easier and less expensive to use wireless for a 

desktop.  

Wide Area Network  

Wide Area Networks (WANs) connect networks in larger geographic areas, such as Florida, the United 

States, or the world. Dedicated transoceanic cabling or satellite uplinks may be used to connect this type of 

global network.  

Using a WAN, schools in Florida can communicate with places like Tokyo in a matter of seconds, without 

paying enormous phone bills. Two users a half-world apart with workstations equipped with microphones 

and a webcams might teleconference in real time. A WAN is complicated. It uses multiplexers, bridges, 

and routers to connect local and metropolitan networks to global communications networks like the 

Internet. To users, however, a WAN will not appear to be much different than a LAN.  

Personal area network 

A personal area network (PAN) is a computer network used for communication among computer and 

different information technological devices close to one person. Some examples of devices that are used in 

a PAN are personal computers, printers, fax machines, telephones, PDAs, scanners, and even video game 

consoles. A PAN may include wired and wireless devices. The reach of a PAN typically extends to 10 

meters. A wired PAN is usually constructed with USB and Firmware connections while technologies such 

as Bluetooth and infrared communication typically form a wireless PAN. 

http://en.wikipedia.org/wiki/Personal_area_network
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 Metropolitan area network 

A Metropolitan area network (MAN) is a large computer network that usually spans a city or a large 

campus. 

 
 

 

Virtual private network 

          A virtual private network (VPN) is a computer network in which some of the links between nodes 

are carried by open connections or virtual circuits in some larger network (e.g., the Internet) instead of by 

physical wires. The data link layer protocols of the virtual network are said to be tunneled through the 

larger network when this is the case. One common application is secure communications through the public 

Internet, but a VPN need not have explicit security features, such as authentication or content encryption. 

VPNs, for example, can be used to separate the traffic of different user communities over an underlying 

network with strong security features.VPN may have best-effort performance, or may have a defined 

service level agreement (SLA) between the VPN customer and the VPN service provider. Generally, a 

VPN has a topology more complex than point-to-point. 

 

http://en.wikipedia.org/wiki/Metropolitan_area_network
http://en.wikipedia.org/wiki/File:EPN_Frame-Relay_and_Dial-up_Network.svg
http://en.wikipedia.org/wiki/Virtual_private_network
http://en.wikipedia.org/wiki/File:Virtual_Private_Network_overview.svg
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Intranets and extranets 
Intranets and extranets are parts or extensions of a computer network, usually a LAN. An intranet is a set 

of networks, using the Internet Protocol and IP-based tools such as web browsers and file transfer 

applications that are under the control of a single administrative entity. That administrative entity closes the 

intranet to all but specific, authorized users. Most commonly, an intranet is the internal network of an 

organization. A large intranet will typically have at least one web server to provide users with 

organizational information. 

An extranet is a network that is limited in scope to a single organization or entity and also has limited 

connections to the networks of one or more other usually, but not necessarily, trusted organizations or 

entities—a company's customers may be given access to some part of its intranet—while at the same time 

the customers may not be considered trusted from a security standpoint. Technically, an extranet may also 

be categorized as a CAN, MAN, WAN, or other type of network, although an extranet cannot consist of a 

single LAN; it must have at least one connection with an external network. 

ISDN 

ISDN stands for Integrated Services Digital Network. It is a design for a completely digital 

telephone/telecommunications network. It is designed to carry voice, data, images, and video, everything 

you could ever need. It is also designed to provide a single interface (in terms of both hardware and 

communication protocols) for hooking up your phone, your fax machine, your computer, your videophone, 

your video-on-demand system (someday), and your microwave. ISDN is about what the future phone 

network, and information superhighway, will look like (or would have looked like).  

ISDN offers the speed and quality that previously was only available to people who bought expensive, 

point-to-point digital leased lines. Combined with its flexibility as a dial-up service, ISDN has become the 

service of choice for many communications applications. Popular ISDN applications include:  

 Internet access  

 Telecommuting/remote access to corporate computing  

 Video conferencing  

 Small and home office data networking  

 

E-mail 

Electronic mail, commonly known as email or e-mail, is a method of exchanging digital messages from an 

author to one or more recipients. Modern email operates across the Internet or other computer networks. 

Some early email systems required that the author and the recipient both be online at the same time, in 

common with instant messaging. Today's email systems are based on a store-and-forward model. Email 

servers accept, forward, deliver and store messages. Neither the users nor their computers are required to 

be online simultaneously; they need connect only briefly, typically to an email server, for as long as it takes 

to send or receive messages. 

An email message consists of three components, the message envelope, the message header, and the 

message body. The message header contains control information, including, minimally, an originator's 

email address and one or more recipient addresses. Usually descriptive information is also added, such as a 

subject header field and a message submission date/time stamp. 

http://en.wikipedia.org/wiki/Intranet
http://en.wikipedia.org/wiki/Internet_Protocol
http://en.wikipedia.org/wiki/Extranet
http://en.wikipedia.org/wiki/Internet
http://en.wikipedia.org/wiki/Computer_network
http://en.wikipedia.org/wiki/Online_and_offline
http://en.wikipedia.org/wiki/Instant_messaging
http://en.wikipedia.org/wiki/Store-and-forward
http://en.wikipedia.org/wiki/Computer_server
http://en.wikipedia.org/wiki/E-mail_server
http://en.wikipedia.org/wiki/Email_address
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Advantages of using Email: 

Managing Email is Easy -You can manage all your correspondence on screen and so can your customers. 

Your proposal can be answered, revised, stored, and sent to others, all without reams of paper involved.  

Email is Fast- Mail is delivered instantly...from your office to anywhere in the world. No other method of 

delivery can provide this service. Timely buying and selling decisions can be made in a heartbeat.  

Email is Inexpensive- Compared to telephone calls, faxes, or overnight courier service, Email is less 

expensive. 

Email is Easy to Filter- The subject line on an Email makes it easy to prioritize messages. The reader can 

identify critical correspondence quickly and dealt with it immediately. Unlike regular mail which needs to 

be opened and reviewed, or voice mail which requires you to either listen to or scan all your messages for 

those that require immediate attention. 

Transmission is Secure and Reliable -The level of security in transmitting Email messages is very high, 

and the industry continues to strive to develop even tighter security levels. Email is private. Often 

telephone and fax messages are not. If the address information is correct, rarely does an Email go astray. 

Fax machines can be out of order or out of paper and this prevents an important message from being 

delivered in a timely manner. 

        Email is an Internet marketing tool that is fast, easy to use, inexpensive and effective. Email levels the 

playing field between the big corporations and small businesses. No longer is it just the big boys who have 

the resources to access the big advertising houses. Anyone can get their word out there using Email as the 

method of delivering the message.  

Messaging systems 

It is the Software that provides an electronic mail delivery system. It is made up of the following functional 

components, which may be packaged together or independently. 

Mail User Agent-The mail user agent (MUA or UA) is the client e-mail program, such as Outlook, 

Eudora, Mac Mail or Mozilla Thunderbird, which is used to compose, send and receive messages. 

Message Transfer Agent-The message transfer agent (MTA), also called the "mail transfer agent," either 

forwards the message from user agents (MUAs) and other mail servers (MTAs) or delivers it to its own 

message store (MS) if the recipient is local. Send mail and Microsoft Exchange are the most widely used 

MTAs on the Internet. In a large enterprise, there may be several MTA servers (mail servers) dedicated to 

Internet e-mail while others support internal e-mail. 

Message Store-The message store (MS) holds the mail until it is selectively retrieved and deleted by an 

access server. In the Internet world, a local delivery agent (LDA) writes the messages from the MTA to the 

message store, and the primary mailbox access protocols used to retrieve the mail are POP and IMAP (see 

POP3 and IMAP4). 

The Internet's SMTP-Internet e-mail, the most ubiquitous messaging system in the world, is based on the 

SMTP protocol. Prior to the Internet's enormous growth in the late 1990s, numerous proprietary messaging 

systems were widely used, including cc: Mail, Microsoft Mail, PROFS and DISOSS. See messaging 

middleware and SMTP. 

 

http://www.pcmag.com/encyclopedia_term/0,2542,t=POP3&i=49492,00.asp
http://www.pcmag.com/encyclopedia_term/0,2542,t=IMAP4&i=44808,00.asp
http://www.pcmag.com/encyclopedia_term/0,2542,t=messaging+middleware&i=46835,00.asp
http://www.pcmag.com/encyclopedia_term/0,2542,t=messaging+middleware&i=46835,00.asp
http://www.pcmag.com/encyclopedia_term/0,2542,t=SMTP&i=51566,00.asp


School of Distance Education 
 

Information Technology for Business & Management                       16 
 

Computer conference 

          Computer conference is a communication session, facilitated by means of a computer network, 

between several participants, each of them having access to all messages submitted. Note: Messages, in 

general, have no specified recipient, but are sent to the entire membership. Messages may contain text, 

video, audio, graphics, software, or a combination thereof. Some of these may be contained in the message 

and may be stored on line for future retrieval. Computer conferencing can be conducted either in real time 

or in store-and-forward mode. 

      Video conference means conducting a conference between two or more participants at different sites 

by using computer networks to transmit audio and video data. For example, a point-to-point (two-person) 

video conferencing system works much like a video telephone. Each participant has a video camera, 

microphone, and speakers mounted on his or her computer. As the two participants speak to one another, 

their voices are carried over the network and delivered to the other's speakers, and whatever images appear 

in front of the video camera appear in a window on the other participant's monitor. 

Desk top publishing (DTP) 

Desktop publishing is the use of the computer and specialized software to create documents for desktop or 

commercial printing. Desktop publishing refers to the process of using the computer to produce documents 

such as newsletters, brochures, books, and other publications that were once created manually using a 

variety of non-computer techniques along with large complex phototypesetting machines. Today desktop 

publishing software does it all - almost. But before PageMaker and other desktop publishing software there 

were e-scales, paste-up, and other non-desktop computer ways of putting together a design for printing.  

 Today innovate, we can define the Desktop publishing is the use of the computer and software to create visual 

displays of ideas and information. Desktop publishing documents may be for desktop or commercial printing or 

electronic distribution including PDF, slide shows, email newsletters, and the Web.  

Information retrieval system 

It is the technique and process of searching, recovering, and interpreting information from large amounts of 

stored data. It is the process of locating in a certain set of texts (documents) all those devoted to a requested 

subject or that contain facts or information necessary to the user. Information retrieval is accomplished by 

means of an information retrieval system and is performed manually or with the use of mechanization or 

automation. Human beings are indispensable in information retrieval. Depending on the character of the 

information contained in the texts output by the information retrieval system, information retrieval can be 

documentary, including bibliographic, or factual. Information retrieval must be distinguished from logical 

information processing, without which directs a reply to the questions posed by a human being is 

impossible. In information retrieval, only the information that was input to the information retrieval system 

is sought—only that information can be found. 

Questions 

1. What is information technology? 

2. What is office automation system? 

3. What are the objectives of OAS? 

4. Briefly discuss the evolution of IT? 

5. What is DTP? 

6. What is information retrieval? 

7. Explain the equipments and devices facilitating office automation?  

8. What are networks? Explain its types    9. What is email? What are the advantages of email? 

http://www.its.bldrdoc.gov/projects/devglossary/_computer_network.html
http://www.its.bldrdoc.gov/projects/devglossary/_access.html
http://www.its.bldrdoc.gov/projects/devglossary/_recipient.html
http://www.its.bldrdoc.gov/projects/devglossary/_video.html
http://www.its.bldrdoc.gov/projects/devglossary/_graphics.html
http://www.its.bldrdoc.gov/projects/devglossary/_software.html
http://www.its.bldrdoc.gov/projects/devglossary/_message.html
http://www.its.bldrdoc.gov/projects/devglossary/_on_line.html
http://www.its.bldrdoc.gov/projects/devglossary/_computer_conferencing.html
http://www.its.bldrdoc.gov/projects/devglossary/_real_time.html
http://www.its.bldrdoc.gov/projects/devglossary/_store-and-forward.html
http://www.its.bldrdoc.gov/projects/devglossary/_mode.html
http://www.webopedia.com/TERM/C/conference.html
http://www.webopedia.com/TERM/C/computer.html
http://www.webopedia.com/TERM/N/network.html
http://www.webopedia.com/TERM/V/video.html
http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/S/system.html
http://www.webopedia.com/TERM/W/window.html
http://www.webopedia.com/TERM/M/monitor.html
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Module- 2 
Word Processing 

 

           Originally ―writing‖ was a painful skill to learn and closely related to figurative art; then the printing 

system turned it into a dull standard of symbols; finally writing became a graphic art in this century. Now 

the computers have brought the potentials of professional printing to the average PC user.  

A WORD PROCESSOR is a modern version of paper, pen, typewriter, eraser, dictionary and 

thesaurus….all in one. They were introduced in the market in the 1960s and became a typical office tool by 

the 1970s. Word processor is a programme used to type documents. Document can be saved, closed and be 

opened again to continue working on them. The keyboard of word processor is similar to that of a 

typewriter, but its capabilities extend for beyond the typewriters. For example, you don‘t have press the 

Return or Enter key at the end of every line-in word processing, the line ―wraps around‖ when it reaches 

the margin you have set and allows you to continue typing without stopping, you only press Enter (Or 

Return) when you want to start a new paragraph or insert blank lines. If you make a mistake while typing 

use backspace or delete to erase it. 

Let us consider an office scene. Many letters are typed in the office. The officer dictates a letter. The typist 

first types a draft copy of the letter. The officer goes through it to check mistakes regarding spelling errors, 

missing words, etc. and suggests corrections. The typist changes the letter as suggested by the officer. This 

is a simple example of word processing. 

 Word processing is one of the most popular applications of computer. It means the process of 

manipulation of text using computer. It includes entering, editing, formatting and manipulation of text on a 

computer screen and printing of the processed text.  Word processing on computer significantly reduced 

the labour effort in document creation, communication and management.  

Features of word processing  

Software companies have launched on the market many word processors that have similar features. Some 

brands names are better known than others. There are many commercial word processing programs; Open 

office writer, Microsoft Word, Coral word Perfect etc… All modern word processors share some basic 

features; 

1. Basic editing tasks Easy to carry out. 

2. A pre-view window to see what the document really looks like. 

3. Possibility to store the document with a meaningful name. 

4. Document suitably formatted to be sent by fax or e-mail 

5. WYSIWIG features (What you see is what you get). 

Some Common Word Processing Packages 

The followings are examples of some popular word processor available  

1. Soft word                               

2. WordStar    

3. Word perfect 

4. Microsoft word 
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Advantages of word processing 

1. Mistakes can be corrected easily without leaving any trace;  

2. Much better presentation of text is possible with formatting features such as different font styles and 

sizes, coloured text and justification;  

3. Text can be easily inserted, deleted or rearranged without having to start again;  

4. Documents can be saved on disk and used again whenever necessary; 

5. Pictures, graphs, tables and charts can be easily included alongside text;  

6. Multiple copies of the same document can be easily produced;  

7. Standard letters can be mass-produced very quickly using mail merge;  

8. Documents can be transferred instantly anywhere in the world via electronic communications links;         

9. Spelling and grammar can be checked automatically.  

2.1 MICROSOFT-WORD 

There are many software packages to do the job of word processing. Some of them work in DOS 

environment. Examples are WordStar, Word Perfect and Professional Write. But in these days working in 

WINDOWS is becoming more and more popular. So let us consider software for word processing which 

works in WINDOWS. Our choice is MS-WORD because it is the most popular software in these days. MS-

WORD is a part of the bigger package called MS OFFICE, which can do much more than word processing. 

In fact when you open up MS OFFICE you will find four main components in it. They are MS-WORD (for 

word processing), MS EXCEL (for spreadsheet), MS ACCESS (for database management) and MS 

POWERPOINT (for presentation purposes)  

Microsoft Word 2007 Window and its Parts/components 

Microsoft Word is a word processing software package. You can use it to type letters, reports, and other 

documents. Microsoft Word 2007 is so different from previous versions of Microsoft Word; even 

experienced users may find it as more user-friendly.  

Advanced features/components of MS Word 2007 

The Microsoft Office Button 

In the upper-left corner of the Word 2007 window is the Microsoft Office button. When you click the 

button, a menu appears. You can use the menu to create a new file, open an existing file, save a file, and 

perform many other tasks. 

 

The Quick Access Toolbar 

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar provides you 

with access to commands you frequently use. By default Save, Undo, and Redo appear on the Quick 

Access toolbar. You can use Save to save your file, Undo to rollback an action you have taken, and Redo to 

reapply an action you have rolled back. 
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The Title Bar 

Next to the Quick Access toolbar is the Title bar. The Title bar displays the title of the document on which 

you are currently working. Word names the first new document you open Document1. As you open 

additional new documents, Word names them sequentially. When you save your document, you assign the 

document a new name. 

 

 
 

 

The Ribbon 

You use commands to tell Microsoft Word what to do. In Microsoft Word 2007, you use the Ribbon to 

issue commands. The Ribbon is located near the top of the screen, below the Quick Access toolbar. At the 

top of the Ribbon are several tabs; clicking a tab displays several related command groups. Within each 

group are related command buttons. You click buttons to issue commands or to access menus and dialog 

boxes. You may also find a dialog box launcher in the bottom-right corner of a group. Clicking the dialog 

box launcher gives you access to additional commands via a dialog box. 

 

 
 

 

 

The Ruler  

The ruler is found below the Ribbon. 

 

 
 

You can use the ruler to change the format of your document quickly. If your ruler is not visible, follow the 

steps listed here: 

 

 
 

1. Click the View tab to choose it. 

2. Click the check box next to Ruler in the Show/Hide group. The ruler appears below the Ribbon.  



School of Distance Education 
 

Information Technology for Business & Management                       20 
 

The Text Area  

Just below the ruler is a large area called the text area. You type your document in the text area. The 

blinking vertical line in the upper-left corner of the text area is the cursor. It marks the insertion point. As 

you type, your text displays at the cursor location. The horizontal line next to the cursor marks the end of 

the document. 

 

 

The Vertical and Horizontal and Vertical Scroll Bars  

The vertical and horizontal scroll bars enable you to move up, down, and across your window simply by 

dragging the icon located on the scroll bar. The vertical scroll bar is located along the right side of the 

screen. The horizontal scroll bar is located just above the status bar. To move up and down your document, 

click and drag the vertical scroll bar up and down. To move back and forth across your document, click and 

drag the horizontal scroll bar back and forth. You won't see a horizontal scroll bar if the width of your 

document fits on your screen. 

The Status Bar  

The Status bar appears at the very bottom of your window and provides such information as the current 

page and the number of words in your document. You can change what displays on the Status bar by right-

clicking on the Status bar and selecting the options you want from the Customize Status Bar menu. You 

click a menu item to select it. You click it again to deselect it. A check mark next to an item means it is 

selected. 

 

 

 

Create a New Document 

There are several ways to create new documents, open existing documents, and save documents  

in Word:     

 Click the Microsoft Office Button and Click New  or 

 Press CTRL+N (Depress the CTRL key while pressing the ―N‖) on the keyboard 

You will notice that when you click on the Microsoft Office Button and Click New, you have many 

choices about the types of documents you can create. If you wish to start from a blank document, click 

Blank.  If you wish to start from a template you can browse through your choices on the left, see the 

choices on center screen, and preview the selection on the right screen. 
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Opening an Existing Document 

 Click the Microsoft Office Button and Click Open, or 

 Press CTRL+O (Depress the CTRL key while pressing the ―O‖) on the keyboard, or 

 If you have recently used the document you can click the Microsoft Office Button and click the 

name of the document in the Recent Documents section of the window Insert picture of recent 

docs 

Saving a Document 

 Click the Microsoft Office Button and Click Save or Save As (remember, if you‘re sending  

the document to someone who does not have Office 2007, you will need to click the Office 

Button,  

click Save As, and Click Word 97-2003 Document), or 

 Press CTRL+S (Depress the CTRL key while pressing the ―S‖) on the keyboard, or 

 Click the File icon on the Quick Access Toolbar  

  

 
Renaming Documents 

To rename a Word document while using the program: 

 Click the Office Button and find the file you want to rename.  

 Right-click the document name with the mouse and select Rename from the shortcut menu.  

 Type the new name for the file and press the ENTER key.  

  

Working on Multiple Documents 
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Several documents can be opened simultaneously if you are typing or editing multiple documents at 

once.  All open documents will be listed in the View Tab of the Ribbon when you click on Switch 

Windows.  The current document has a checkmark beside the file name.  Select another open document 

to view it.   

 
 

 

Document Views  

In Word 2007, you can display your document in one of five views: Draft, Web Layout, Print Layout,  

Full Screen Reading, or Online Layout 

 Print Layout:  This is a view of the document as it would appear when printed.  It includes all 

tables, text, graphics, and images. 

 Full Screen Reading:  This is a full view length view of a document.  Good for viewing two 

pages at a time. 

 Web Layout:  This is a view of the document as it would appear in a web browser. 

 Outline:  This is an outline form of the document in the form of bullets. 

 Draft:  This view does not display pictures or layouts, just text. For selecting draft view follow 

the procedure below 

 

 
 

 

1. Click the View tab. 

2. Click Draft in the Document Views group. When the Draft option is selected it appears in a 

contrasting color. 

 

 

 

Click 
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To view a document in different forms, click the document views shortcuts at the bottom of the screen       

 or: 

 Click the View Tab on the Ribbon 

 Click on the appropriate document view.  

 
Close a Document 

To close a document: 

 Click the Office Button 

 Click Close 

Nonprinting Characters  

Certain characters, called nonprinting characters, do not print and will not appear in your printed 

document but do affect your document layout. You can elect to see these characters on the screen as you 

type or you can elect to have them remain invisible. For these lessons, opt to see them onscreen. This 

table describes most of them: 

To view nonprinting characters: 

 
 Typing and inserting Text 

    To enter text, just start typing! The text will appear where the blinking cursor is located. Move the 

cursor by using the arrow buttons on the keyboard or positioning the mouse and clicking the left button. 

The keyboard shortcuts listed below are also helpful when moving through the text of a document: 

Move Action  Keystroke  

Beginning of the line HOME  

End of the line END  

Top of the document CTRL+HOME  

End of the document CTRL+END  

Selecting Text 

      To change any attributes of text it must be highlighted first. Select the text by dragging the mouse 

over the desired text while keeping the left mouse button depressed, or hold down the SHIFT key on the 

keyboard while using the arrow buttons to highlight the text. The following table contains shortcuts for 

selecting a portion of the text: 

Selection  Technique  

Whole word double-click within the word 

Whole paragraph triple-click within the paragraph 

Several words or 

lines 

drag the mouse over the words, or hold down SHIFT while using the arrow 

keys 

Entire document choose Editing | Select | Select All from the Ribbon, or press CTRL+A 

De select the text by clicking anywhere outside of the selection on the page or press an arrow key on the 

keyboard. 
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Inserting Additional Text 

Text can be inserted in a document at any point using any of the following methods: 

 Type Text:  Put your cursor where you want to add the text and begin typing 

 Copy and Paste Text:  Highlight the text you wish to copy and right click and click Copy, put 

your cursor where you want the text in the document and right click and click Paste. 

 Cut and Paste Text:  Highlight the text you wish to copy and right click and click Cut, put your 

cursor where you want the text in the document and right click and click Paste. 

 Drag Text:  Highlight the text you wish to move, click on it and drag it to the place where you 

want the text in the document. 

 

 
 You will notice that you can also use the Clipboard group on the ribbon.  

Rearranging Blocks of Text 

To rearrange text within a document, you can utilize the Clipboard Group on the Home Tab of the 

Ribbon. 

Insert picture of clipboard group labeled 

 Move text:  Cut and Paste or Drag as shown above 

 Copy Text:  Copy and Paste as above or use the Clipboard group on the Ribbon 

 Paste Text:  Ctrl + V (hold down the CTRL and the ―V‖ key at the same time) or use the 

Clipboard group to Paste, Paste Special, or Paste as Hyperlink 

 

 
Deleting Blocks of Text 

Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will delete text to 

the left of the cursor and Delete will erase text to the right. To delete a large selection of text, highlight it 

using any of the methods outlined above and press the DELETE key. 

Search and Replace Text 
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To find a particular word or phrase in a document: 

 Click Find on the Editing Group on the Ribbon  

 To find and replace a word or phrase in the document, click Replace on the Editing Group of the 

Ribbon. 

 
Undo Changes                              

To undo changes: Click the Undo Button on the Quick Access Toolbar  

 
       There are many features to help you proofread your document.  These include:  Spelling and 

Grammar, Thesaurus, AutoCorrect, Default Dictionary, and Word Count. 

Bold, Italicize, and Underline 

When creating a document, you may need to emphasize particular words or phrases by bolding, 

underlining, or italicizing. Also, certain grammatical constructs require that you bold, underline, or 

italicize.  You can bold, underline, and italicize when using Word. You also can combine these features. 

In other words, you can bold, underline, and italicize a single piece of text. 

When you need to perform a task in Microsoft Word, you can usually choose from several methods. The 

exercises that follow show you how to bold, underline, or italicize using four different methods: using the 

launcher, the Ribbon, the Mini-toolbar/context menu, and the keyboard. 

Bold with the Dialog Box Launcher 

1. On the line that begins with Launcher, select the word "Bold."  You can place the cursor before 

the letter "B" in "Bold." Press the Shift key; then press the right arrow key until the entire word is 

highlighted. 

2. Choose the Home tab. 

3. Click the dialog box launcher in the Font group. The Font dialog box appears. 

4. Click Bold in the Font Style box. 

Note: You can see the effect of your action in the Preview window. To remove the bold, click 

Regular. 

5. Click OK to close the dialog box. 

6. Click anywhere in the text area to remove the highlighting. You have bolded the word bold. 

Italicize with the Dialog Box Launcher 

1. On the line that begins with Launcher, select the word "Italicize."  You can place the cursor 

before the letter "I" in "Italicize." Press the Shift key; then press the right arrow key until the 

entire word is highlighted. 

2. Choose the Home tab. 

3. Click the dialog box launcher in the Font group. The Font dialog box appears. 

4. Click Italic in the Font Style box. 

Note: You can see the effect of your selection in the Preview window. To remove the italics, 

click Regular in the Font Style box.  

5. Click OK to close the Font dialog box. 

6. Click anywhere in the text area to remove the highlighting. You have italicized the word Italicize. 

Underline with the Dialog Box Launcher 

You can underline when using Word. Word provides you with many types of underlines from which to 
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choose. The following are some of the underlines that are available if you use the dialog box launcher:  

1. On the line that begins with "Launcher," select the words "Underline these words." 

2. Choose the Home tab. 

3. Click the dialog box launcher in the Font group. The Font dialog box appears. 

4. In the Underline Style box, click the down arrow to open the pull-down menu. 

5. Click the type of underline you wish to use.  

Note: To remove an underline, you select none from the pull-down menu.  

6. Click OK to close the dialog box. The underline you selected appears under the words. 

7. Click anywhere in the text area to remove the highlighting. 

 

Proofing the document 

This includes checking and correcting spelling and grammar, thesaurus, Research and translate options 

 

Spelling and Grammar 

To check the spelling and grammar of a document 

 Place the cursor at the beginning of the document or the beginning of the section that you want to 

check 

 Click the Review Tab on the Ribbon 

 Click Spelling & Grammar on the Proofing Group.  

  
 

 Any errors will display a dialog box that allows you to choose a more appropriate spelling or 

phrasing. 

 

 
If you wish to check the spelling of an individual word, you can right click any word that has been 

underlined by Word and choose a substitution. 
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Thesaurus -The Thesaurus allows you to view synonyms.  To use the thesaurus: 

 Click the Review Tab of the Ribbon 

 Click the Thesaurus Button on the Proofing Group.   

 The thesaurus tool will appear on the right side of the screen and you can view word options. 

 
 

You can also access the thesaurus by right-clicking any word and choosing Synonyms on the menu. 

 
Customize AutoCorrect 

You can set up the AutoCorrect tool in Word to retain certain text the way it is.  To customize AutoCorrect: 

 Click the Microsoft Office button  

 Click the Word Options Button 

 Click the Proofing tab 

 Click AutoCorrect Options button 
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 On the AutoCorrect Tab, you can specify words you want to replace as you type 

 
Create a New Default Dictionary 

Often you will have business or educational jargon that may not be recognized by the spelling and/or 

grammar check in Word.  You can customize the dictionary to recognize these words. 

 Click the Microsoft Office button  

 Click the Word Options Button 

 Click the Proofing tab 

 Click the When Correcting Spelling tab 

 Click Custom Dictionaries 

 Click Edit Word List 

 Type in any words that you may use that are not recognized by the current dictionary. 
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  Check Word Count 

To check the word count in Word 2007 look at the bottom left corner of the screen.  It will give you a 

total word count or if you have text highlighted it will tell you how many words are highlighted out of 

the total. 

 
Formatting a Paragraph 

Formatting paragraphs allows you to change the look of the overall document.  You can access many of 

the tools of paragraph formatting by clicking the Page Layout Tab of the Ribbon or the Paragraph 

Group on the Home Tab of the Ribbon. 

 

 
Change Paragraph Alignment 

The paragraph alignment allows you to set how you want text to appear.  To change the alignment: 

 Click the Home Tab 

 Choose the appropriate button for alignment on the Paragraph Group. 

o Align Left:  the text is aligned with your left margin 

o Center:  The text is centered within your margins 

o Align Right:  Aligns text with the right margin 

o Justify:  Aligns text to both the left and right margins. 
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Indent Paragraphs 

Indenting paragraphs allows you set text within a paragraph at different margins. There are several 

options for indenting: 

 First Line:  Controls the left boundary for the first line of a paragraph 

 Hanging:  Controls the left boundary of every line in a paragraph except the first one 

 Left:  Controls the left boundary for every line in a paragraph 

 Right:  Controls the right boundary for every line in a paragraph 

To indent paragraphs, you can do the following: 

 Click the Indent buttons to control the indent.   

 Click the Indent button repeated times to increase the size of the indent. 

 
 Click the dialog box of the Paragraph Group 

 Click the Indents and Spacing Tab  

 Select  your indents 

 
 

Add Borders and Shading 

You can add borders and shading to paragraphs and entire pages.  To create a border around a paragraph 

or paragraphs: 

 Select the area of text where you want the border or shading. 

 Click the Borders Button on the Paragraph Group on the Home Tab  

 Choose the Border and Shading  

 Choose the appropriate options 
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Apply Styles 

Styles are a present collection of formatting that you can apply to text. To utilize Quick Styles: 

 Select the text you wish to format.   

 Click the dialog box next to the Styles Group on the Home Tab.   

 Click the style you wish to apply.   

 
Create Links 

Creating links in a word document allows you to put in a URL that readers can click on to visit a web 

page.  To insert a link: 

 Click the Hyperlink Button on the Links Group of the Insert Tab.   

 Type in the text in the ―Text to Display‖ box and the web address in the ―Address‖ box. 

 

 
 

 



School of Distance Education 
 

Information Technology for Business & Management                       32 
 

Change Spacing Between Paragraphs and Lines 

You can change the space between lines and paragraphs by doing the following: 

 Select the paragraph or paragraphs you wish to change. 

 On the Home Tab, Click the Paragraph Dialog Box 

 Click the Indents and Spacing Tab 

 In the Spacing section, adjust your spacing accordingly 

 
Creating and Bulleted Numbered Lists 

Lists allow you to format and organize text with numbers, bullets, or in an outline. Bulleted lists have 

bullet points, numbered lists have numbers, and outline lists combine numbers and letters depending on 

the organization of the list. To create one of your own, do the following. 

 Highlight the last three lines in your Crime Statistics document 

 On the Home ribbon at the top of Microsoft Word, locate the Paragraph panel 

 On the Paragraph panel, locate the three bullet options: 

 

 
 

 

The first of the three is for bullets that are not numbers or letter. The default for the first option is to have 

round bullets. If this is all you want then simply click the first option, after you have highlighted your 

text. You can, however, have other symbols for your bulleted list. Click the arrow next to the first bullet 

option to see the following: 

You can select any of the bullets in the Bullet Library. Move your mouse over each one and you'll see a 

preview on your page. Click with the left mouse button to choose a particular bullet. 

You have a wider range of choices if you click the link at the bottom that says "Define New bullet".  

 



School of Distance Education 
 

Information Technology for Business & Management                       33 
 

 
 

Click the Symbol button at the top to see the symbol screen: 

Select the symbol you want and then click OK. You'll then be returned to the Define New Bullet dialogue 

box. If you like the Preview, click OK on this dialogue box, as well. You can however, select a picture, 

or a font as your bullet. Click the buttons at the top to see how these work. 

The second bullet option on the Paragraph panel is for numbers and letters. The default is for consecutive 

numbers starting from 1. Again, click the arrow to see more options: 

 
 

So if you wanted lowercase letters instead of numbers, select this option from the list. You can also set 

your own style by clicking the "Define New Number Format" link at the bottom. This opens a dialogue 

box similar to the one you've just seen. 

The third bullet option on the Paragraph panel is for lists that are more complex - bullets within bullets. 

A list like this, for example: 
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To get the list above, we first typed the text "Heading One". After highlighting this text, we clicked the 

third bullet option on the Paragraph panel to see this: 

 
Clicking the first option got us the number 1 as a bullet. We then typed the next two items. However, this 

gets you a numbered list, 1 to 3. To change the list into the one above, highlight an item on your list. 

Then click the link at the bottom that says "Change List Level". You'll then see the following: 

 
Select the List Level you want. Do the same for any other items on your list. 

TABLES 

Tables are used to display data in a table format. In other words, the table are facilities where the  data 

structure is divided into too many rows and columns to provide  better analysis and presentation  

 

 To Create a Table 

 

 Place the cursor on the page where you want the new table 

 Click the Insert Tab of the Ribbon 

 Click the Tables Button on the Tables Group.  You can create a table one of four ways: 

o Highlight the number of row and columns 

o Click Insert Table and enter the number of rows and columns 

o Click the Draw Table, create your table by clicking and entering the rows and columns 

o Click Quick Tables and choose a table 
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Enter Data in a Table 

Place the cursor in the cell where you wish to enter the information.  Begin typing. 

Modify the Table Structure and Format a Table 

To modify the structure of a table: 

 Click the table and notice that you have two new tabs on the Ribbon:  Design and Layout.  These 

pertain to the table design and layout. 

 
On the Design Tab, you can choose: 

 Table Style Options 

 Table Styles 

 Draw Borders  

To format a table, click the table and then click the Layout Tab on the Ribbon.  This Layout tab allows 

you to: 

 View Gridlines and Properties (from the Table Group) 

 Insert Rows and Columns (from the Rows & Columns Group) 

 Delete the Table, Rows and/or Columns (from the Rows & Columns Group) 

 Merge or Split Cells (from the Merge Group) 

 Increase and Decrease cell size (Cell Size Group) 

 Align text within the cells and change text directions (Alignment Group) 
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Page Formatting 

Set the Orientation 

Before you print your document, you may want to change the orientation of your pages. There are two 

orientations you can use: portrait and landscape. Paper, such as paper sized 8 1/2 by 11, is longer on one 

edge than it is on the other. If you print in Portrait, the shortest edge of the paper becomes the top of the 

page. Portrait is the default option. If you print Landscape, the longest edge of the paper becomes the top 

of the page. 

Portrait 

Landscape 

Set the Orientation 

1. Choose the Page Layout tab. 

2. Click Orientation in the Page Setup group. A menu appears. 

3. Click Portrait. Word sets your page orientation to Portrait. 

 

 
 

Set the Page Size 

  Paper comes in a variety of sizes. Most business correspondence uses 8 1/2 by 11 papers which is the 

default page size in Word. If you are not using 8 1/2 by 11 papers, you can use the Size option in the 

Page Setup group of the Page Layout tab to change the Size setting. 
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1. Choose the Page Layout tab. 

2. Click Size in the Page Setup group. A menu appears. 

3. Click Letter 8.5 x 11in. Word sets your page size. 

Set the Margins   

 

  Margins define the amount of white space that appears at the top, bottom, left, and right edges of your 

document. The Margin option in the Page Setup group of the Page Layout tab provides several standard 

margin sizes from which you can choose.  

 

 
1. Choose the Page Layout tab.  

2. Click Margins in the Page Setup group. A menu appears. 

3. Click Moderate. Word sets your margins to the Moderate settings. 

Add Page Numbers 

          Page numbers help you keep your document organized and enable readers to find information 

quickly. You can add page numbers to the top, bottom, or margins of your pages, and you can choose 

where the numbers appear. For example, numbers can appear at the top of the page, on the left, right, or 

center of the page. Word also offers several number styles from which you can choose. 
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1. Choose the Insert tab. 

2. Click the Page Number button in the Header & Footer group. A menu appears. 

3. Click Bottom of Page. 

4. Click the right-side option.  

Insert Page Breaks 

       As you learned in earlier, you can display your document in any of five views: Draft, Web Layout, 

Print Layout, Full Screen Reading, or Online Layout. In Print Layout view you see your document as it 

will appear when you print it. You can clearly see where each page ends and a new page begins. 

     As you review your document, you may find that you want to change the point at which a new page 

begins. You do this by inserting a page break. For example, if a page heading appears on one page and 

the first paragraph under the heading appears on the next page, you may want to insert a page break 

before the heading to keep the heading and the first paragraph together. 

Change to Print View 

 
1. Choose the View tab. 

2. Click Print Layout in the Document Views group. Your document changes to the Print Layout 

view. 

 

Insert Page Breaks 

1. Place your cursor before the D in "Displaced Homemakers" 

2. Choose the Insert tab. 

3. Click Page Break. Word places a page break in your document. 

To delete a page break, you select the page break and then press the Delete key. 
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Modify Page Margins and Orientations 

The page margins can be modified through the following steps: 

 Click the Page Layout Tab on the Ribbon 

 On the Page Setup Group, Click Margins 

 Click a Default Margin, or 

 Click Custom Margins and complete the dialog box. 

I  

 

To change the Orientation, Size of the Page, or Columns: 

 Click the Page Layout Tab on the Ribbon 

 On the Page Setup Group, Click the Orientation, Size, or Columns drop down menus 

 Click the appropriate choice 

 
 

Apply a Page Border and Color 

To apply a page border or color: 

 Click the Page Layout Tab on the Ribbon 

 On the Page Background Group, click the Page Colors or Page Borders drop down menus 
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Insert Common Header and Footer Information 

 

To insert Header and Footer information such as page numbers, date, or title, first, decide if you want the 

information in the header (at the top of the page) or in the Footer (at the bottom of the page), then: 

 Click the Insert Tab on the Ribbon 

 Click Header or Footer 

 Choose a style 

I  

 The Header/Footer Design Tab will display on the Ribbon 

 Choose the information that you would like to have in the header or footer (date, time, page 

numbers, etc.) or type in the information you would like to have in the header or footer 

 
 

Create a Page Break 

To insert a page break: 

 Click the Page Layout Tab on the Ribbon 

 On the Page Setup Group, click the Breaks Drop Down Menu 

 Click Page Break 

 

Preview and Print Documents 

         When you have your margins, tabs, and so on the way you want them, you are ready to print. In 

Word, You can preview your document before you print. In the Preview mode, you can review each 

page, view multiple pages at the same time, zoom in on a page, and access the Size, Orientation, and 

Margin options. 

        If you press the Zoom button while you are in Preview mode, the Zoom dialog box appears. In the 

Zoom dialog box you can set the sizes of the pages that display as well as the number of pages that 

display. 

When you are ready to print, you use the Print dialog box. In the Print Range area, choose All to print 

every page of your document, choose Current Page to print the page you are currently on, or choose 

Pages to enter the specific pages you want to print. Type the pages you want to print in the Pages field. 

Separate individual pages with commas (1,3, 13); specify a range by using a dash (4-9). 

 

Print Preview 

1. Click the Microsoft Office button. A menu appears. 

2. Highlight the Print option. The Preview and Print the Document menu appears. 

3. Click Print Preview. The Preview window appears, with your document in the window. 

4. Click One Page to view one page at a time. Click Two Pages to view two pages at a time. 

5. To view your document in normal size, click 100%. 

6. Click the Zoom Button. The Zoom dialog box appears. 

7. Select an option and then click OK. Perform this task for each option and note the results. 
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MACROS 

Macros are advanced features that can speed up editing or formatting you may perform often in a Word 

document. They record sequences of menu selections that you choose so that a series of actions can be 

completed in one step. Simply put, a macro is a series of commands that is recorded so it can be played 

back, or executed, later 

 

Recording a Macro 

To record a Macro: 

 Click the View Tab on the Ribbon 

 Click Macros 

 Click Record Macro 

 

 
 

 

 
 

 

 Enter a name (without spaces) 

 Click whether you want it assigned to a button (on the Quick Access Toolbar) or the keyboard 

(a sequence of keys) 

 To assign the macro a button on the Quick Access Toolbar: 

o Click Button 

o Under the Customize Quick Access Toolbar, select the document for which you want 

the Macro available 
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o Under Choose Commands:  Click the Macro that you are recording 

o Click Add  

o Click OK to begin Recording the Macro 

o Perform the actions you want recorded in the Macro 

o Click on Macros 

o Click on Stop Recording Macros 

 

 
 To assign a macro button to a keyboard shortcut: 

o Click Keyboard 

o In the Press New Shortcut Key box, type the key sequence that you want and click 

Assign 

o Click Close to begin recording the Macro 

o Perform the actions you want recorded in the Macro 

o Click on Macros 

o Click on Stop Recording Macros 

Running a Macro 

Running a macro depends on whether it‘s been added to the Quick Access Toolbar or if it‘s been given a 

Keyboard Shortcut. 

 To run a Macro from the Quick Access Toolbar, simply click the Macro Icon 

 

 
 To run a Macro from the Keyboard shortcut, simply press the keys that you have programmed to 

run the Macro. 
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Mail Merge/Merge printing 

  Mail Merge is an automated feature of MS Word that enables you to merge a data source( a file that stores 

fields and records of information, like first name, last name, etc...) into a copy of a document to customize 

or personalize the document. 

 

The Word 2007 Mail Merge toolbar looks as follows:  

 

 
 

Mail Merge in Word is accomplished by the following steps: 

 

Step 1: Set the data document type. 

           The data document holds the text that repeats for all merged documents. In the Mailings tab, click 

Start Mail Merge and select the document type. 

 

Word offers the following types of documents: 

 Letters: 

Use this option for composing and designing mass mailings for which only the recipient 

information varies.    This document type is also used when sending out a form letter or invoice. 

 E-mail Messages: 

Using e-mail merge, multiple addresses in the To, Cc or Bcc fields can be avoided. Each recipient 

can receive a personalized e-mail. 

 Envelopes: 

Use this option for producing envelopes. 

 Labels: 

Use this option to print sheets of labels. Many addresses can be printed on the same page, in 

different label formats. 

 Directory: 

Use this option when printing a catalog or any other document that requires printing multiple 

records per page. 

http://www.pixel2life.com/collections/usr46117/938/img2159.jpg
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Step 2: Associate a data source with the document: In the Mailings tab, choose Select Recipients. 

The various options are: 

 Use Existing List: 

 The Select Data Source dialog box appears when you choose this option. Navigate to and select a 

data source file. Typically, the data source is created in Excel or Access. 

 Type New List: If you choose this, click create, and then use the dialog box that appears to enter 

names and addresses. If you don't plan to use the entire database, you can use the Mail Merge 

Recipients dialog box, to select just the recipients you want. To open the dialog box, click Edit 

Recipient list in the Start Mail Merge group of the Mailings tab. 

 

                      

 

The recipient list can be refined by Sort, Filter, Find Duplicates, Find Recipient and Validate 

addresses.       

 

 Select from Outlook Contacts.  

 

Step 3: Design your data document by combining ordinary document features with Word merge 

fields. 

             Place holders can be used when designing the data document for information pertaining to the 

intended recipient. When you are done, edit your document and substitute Merge Fields for the 

placeholders. To insert a merge field, position the insertion point where you want the field to appear. In 

the Mailings tab, choose Insert Merge Field in the Write & Insert Fields group. Click on the field 

you want to insert. Special sets of merge fields like Address Block and Greeting Line can be inserted 

to save time! 

 

 
 

Step 4: Preview the finished document by testing to see how it looks with different data records. 

             Click the Preview Results button in the Preview Results group of the Mailings tab. 

Navigation     buttons help you to traverse through the records. 

http://www.pixel2life.com/collections/usr46117/938/img2158.jpg
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Step 5: Finish the process. Merge the data document with the data source, creating a printed result, a 

saved document or an e-mailed 

document.

 
 

Your other option is to use the Mail Merge Wizard! In the Start Mail Merge group of the Mailings 

tab, click the Start Mail Merge button and choose Step by Step Mail Merge Wizard. 

 
 

Inserting Excel Data in a Word 2007 Document 

       If you‘re using Word to create business documents such as reports and business plans, it is inevitable 

that you will need to insert data created in Excel. While it is an easy process, you have to be aware of your 

options and the limitations inherent in each of the options. 

The first option is to insert a link to an Excel worksheet in your Word document. For users who want to 

ensure that the information is updated every time a change is made to the spreadsheet, this is the way to go. 

A one-way link is created that feeds the data from Excel into the Word document. It will also keep your 

Word file trim, as the data itself is not actually saved with the document.  

http://www.pixel2life.com/collections/usr46117/938/img2161.jpg
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Selecting Excel Data to Insert in Your Word Document 

 
In Excel, click and drag over a region of cells to select it. Be sure to include the entire Excel data you 

would like to link to in your Word 2007 document. 

1. Open the Excel document that contains the data you would like to link to in your Word 

document. 

 2. Select the data you would like to link to in your Word document. Press Ctrl+C to copy it. 

3.  After you have copied the data, you can minimize Excel.  

  Linking to an Excel Worksheet 

To insert a link to an Excel file to Word, follow these steps: 

1. Open both the Word document and the Excel spreadsheet 

2. In Excel, copy the range of cells you want to include (if you plan to insert more columns or rows into your 

spreadsheet, select the entire worksheet by clicking the box at the juncture of the row numbers and column 

letters) 

3. In your Word document position the cursor where you would like the table inserted 

4. On the Edit menu, select Paste Special… 

5. Click the radio button beside Paste link 

 
6. Under the label As:, select Microsoft Excel Worksheet Object 

7. Click OK 

 

Inserting PowerPoint slides to MS Word 

There are two ways to copy and paste slides from PowerPoint to Word:  

 To copy an entire presentation:  

1. Start PowerPoint. 

2. Open your PowerPoint presentation. 

3. Send the presentation to Word.  

 Click the Office button. 

 From the drop-down list, select Publish. 

 Select Create Handouts in Microsoft Office Word. 

4. Select the radio button that corresponds to the page layout that you want to use. 

http://0.tqn.com/d/wordprocessing/1/0/e/5/excelcopy.png
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5. Select the Paste radio button. 

6. Click OK. 

 To copy individual slides:  

1. Start PowerPoint 

2. Open your PowerPoint presentation. 

3. Select the slide you want to insert into your Word document. 

4. Copy the slide.  

 Select the Home tab. 

 In the Clipboard group, click the Copy icon. 

5. Start Word. 

6. Open the document into which you want to paste the slide. 

7. Place the cursor where you would like to insert the slide. 

8. Paste the slide.  

 Select the Home tab. 

 In the Clipboard group, click the Paste icon 

 

Microsoft Word shortcut keys 

  Below is a listing of all the major shortcut keys in Microsoft Word.  

 

Shortcut Keys Description 

Ctrl + 0 Adds or removes 6pts of spacing before a paragraph. 

Ctrl + A Select all contents of the page. 

Ctrl + B Bold highlighted selection. 

Ctrl + C Copy selected text. 

Ctrl + E Aligns the line or selected text to the center of the screen. 

Ctrl + F Open find box. 

Ctrl + I Italic highlighted selection. 

Ctrl + J Aligns the selected text or line to justify the screen. 

Ctrl + K Insert link. 

Ctrl + L Aligns the line or selected text to the left of the screen. 

Ctrl + M Indent the paragraph. 

Ctrl + P Open the print window. 

Ctrl + R Aligns the line or selected text to the right of the screen. 

Ctrl + T Create a hanging indent. 

Ctrl + U Underline highlighted selection. 

Ctrl + V Paste. 

Ctrl + X Cut selected text. 

http://www.computerhope.com/jargon/s/shortkey.htm
http://www.computerhope.com/software/msword.htm
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http://www.computerhope.com/jargon/i/italic.htm
http://www.computerhope.com/jargon/p/paste.htm
http://www.computerhope.com/jargon/c/cut.htm
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Ctrl + Y Redo the last action performed. 

Ctrl + Z Undo last action. 

Ctrl + Shift + L Quickly create a bullet point. 

Ctrl + Shift + F Change the font. 

Ctrl + Shift + > Increase selected font +1pts up to 12pt and then increases font +2pts. 

Ctrl + ] Increase selected font +1pts. 

Ctrl + Shift + < Decrease selected font -1pts if 12pt or lower, if above 12 decreases font by +2pt. 

Ctrl + [ Decrease selected font -1pts. 

Ctrl + / + c Insert a cent sign (¢). 

Ctrl + ' + <char> 

Insert a character with an accent (grave) mark, where <char> is the character you 

want. For example, if you wanted an accented è you would use Ctrl + ' + e as your 

shortcut key. To reverse the accent mark use the opposite accent mark, often on the 

tilde key. 

Ctrl + Shift + * View or hide non printing characters. 

Ctrl + <left arrow> Moves one word to the left. 

Ctrl + <right arrow> Moves one word to the right. 

Ctrl + <up arrow> Moves to the beginning of the line or paragraph. 

Ctrl + <down arrow> Moves to the end of the paragraph. 

Ctrl + Del Deletes word to right of cursor. 

Ctrl + Backspace Deletes word to left of cursor. 

Ctrl + End Moves the cursor to the end of the document. 

Ctrl + Home Moves the cursor to the beginning of the document. 

Ctrl + Spacebar Reset highlighted text to the default font. 

Ctrl + 1 Single-space lines. 

Ctrl + 2 Double-space lines. 

Ctrl + 5 1.5-line spacing. 

Ctrl + Alt + 1 Changes text to heading 1. 

Ctrl + Alt + 2 Changes text to heading 2. 

Ctrl + Alt + 3 Changes text to heading 3. 

Alt + Ctrl + F2 Open new document. 

Ctrl + F1 Open the Task Pane. 

http://www.computerhope.com/jargon/b/bullet.htm
http://www.computerhope.com/jargon/t/tilde.htm
http://www.computerhope.com/jargon/t/taskpane.htm
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Ctrl + F2 Display the print preview. 

Ctrl + Shift + > Increases the highlighted text size by one. 

Ctrl + Shift + < Decreases the highlighted text size by one. 

Ctrl + Shift + F6 Opens to another open Microsoft Word document. 

Ctrl + Shift + F12 Prints the document. 

F1 Open Help. 

F4 Repeat the last action performed (Word 2000+) 

F5 Open the find, replace, and go to window in Microsoft Word. 

F7 Spell-check and grammar check selected text or document. 

F12 Save as. 

Shift + F3 
Change the text in Microsoft Word from uppercase to lowercase or a capital letter at 

the beginning of every word. 

Shift + F7 Runs a Thesaurus check on the word highlighted. 

Shift + F12 Save. 

Shift + Enter Create a soft break instead of a new paragraph. 

Shift + Insert Paste. 

Shift + Alt + D Insert the current date. 

Shift + Alt + T Insert the current time. 

In addition to the above shortcut keys users can also use their mouse as a method of quickly do something 

commonly performed. Below some are examples of mouse shortcuts. 

Mouse shortcuts Description 

Click, hold, and 

drag 
Selects text from where you click and hold to the point you drag and let go. 

Double-click If double-click a word, selects the complete word. 

Double-click 
Double-clicking on the left, center, or right of a blank line will make the alignment 

of the text left, center, or right aligned. 

Double-click Double-clicking anywhere after text on a line will set a tab stop. 

Triple-click Selects the line or paragraph of the text the mouse triple-clicked. 

Ctrl + Mouse wheel 

Zooms in and out of document. 

 

 

Questions 

1. What is word processing? What are the advantages of computer based word processing. 

2. What are the features of word processing? 

http://www.computerhope.com/jargon/p/prinprev.htm
http://www.computerhope.com/jargon/u/uppercas.htm
http://www.computerhope.com/jargon/l/lowercas.htm
http://www.computerhope.com/jargon/s/softretu.htm
http://www.computerhope.com/jargon/t/tabstop.htm


School of Distance Education 
 

Information Technology for Business & Management                       50 
 

3. What are the text formatting facilities available in MS word? 

4. What is proofing? What are the facilities available under proofing? 

5. Explain page set up and its options in MS word? 

6. Explain the parts of word window and its features? 

7. Explain mail merge in MS word?    

  8. Discuss the formatting of paragraph?  

 9. How do you insert header and footer?   

 10 how do you insert table in MS Word? 

 

2.2. MICROSOFT EXCEL 

Spreadsheet 

 

Electronic spreadsheet or worksheet stores information in the memory of computer performs data 

manipulation and displays results quickly. it can be saved, moved or printed. It can cater the needs of wide 

range of computer users. Application of spreadsheets includes: 

 Preparation of reports 

 Payrolls management 

 Preparation of bills 

 Income statements  

 Budget analysis 

 Loan analysis 

 Investment analysis 

 Inventory control 

 Production analysis etc., 

   Advantages of   spread sheet 

Following are the important benefit of using spreadsheet. 

 It produces accurate results. 

 Easy and quick calculation 

 Worksheet data can be displayed and manipulated 

 Data can be converted into graph 

 Entire worksheet or parts can be printed 

 Facilities carrying ―what if‖ analysis 

 Data in a worksheet can be transferred to other programmes easily. 

There are many spread sheet packages and of them Microsoft Excel is the most popular one 

MS EXCEL 

                Microsoft Excel is an electronic spreadsheet. As with a paper spreadsheet, you can use Excel to 

organize your data into rows and columns and to perform mathematical calculations. Spreadsheets can do 

more than perform simple arithmetic calculations. A spreadsheet can translate complicated data and reports 

into a combination of numbers and graphs. Modern versions include an extensive list of financial 

calculators, such as interest calculations, loan amortization, even calculations for Treasury bill rates. 

Statistical functions from common calculations (Chi Square, Pearson Coefficient of Correlation and 

Standard Deviation) to abstruse functions like the hyper geometric Distribution and the Poisson distribution 

return needed values with no pain. There are at least 100 of these formulas included in contemporary 

spreadsheets. 

Excel 2007  
Parts of the Excel 2007 Screen 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/01_excel.htm
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Parts of the Excel 2007 Screen 

Active Cell\ 

In an Excel 2007 worksheet, the cell is with the black outline. Data is always entered into the active cell.  

Column Letter 

Columns run vertically on a worksheet and each one is identified by a letter in the column header.  

Formula Bar 

Located above the worksheet, this area displays the contents of the active cell. It can also be used for 

entering or editing data and formulas.  

Name Box 

Located next to the formula bar, the Name Box displays the cell reference or the name of the active cell.  

Row Numbers 

Rows run horizontally in a worksheet and are identified by a number in the row header. 

Together a column letter and a row number create a cell reference. Each cell in the worksheet can be 

identified by this combination of letters and numbers such as A1, F456, or AA34. 

Sheet Tabs 

By default there are three worksheets in an Excel file.  

The tab at the bottom of a worksheet tells you the name of the worksheet - such as Sheet1, Sheet2 etc. 

Switching between worksheets can be done by clicking on the tab of the sheet you wish to access.  

Renaming a worksheet or changing the tab color can make it easier to keep track of data in large 

spreadsheet files. 

Quick Access Toolbar 

This customizable toolbar allows you to add frequently used commands. Click on the down arrow at the 

end of the toolbar to display the available options.  

Office Button 

clicking on the Office Button displays a drop down menu containing a number of options, such as open, 

save, and print. The options in the Office Button menu are very similar to those found under the File menu 

in previous versions of Excel.  

Ribbon 

The Ribbon is the strip of buttons and icons located above the work area in Excel 2007. The Ribbon 

replaces the menus and toolbars found in earlier versions of Excel. 

http://0.tqn.com/d/spreadsheets/1/0/a/2/-/-/excel_2007_screen_parts.gif
http://spreadsheets.about.com/od/a/g/active_cell.htm
http://spreadsheets.about.com/od/uvw/g/worksheet_def.htm
http://spreadsheets.about.com/od/d/g/data_definition.htm
http://spreadsheets.about.com/od/c/g/column_header.htm
http://spreadsheets.about.com/od/uvw/g/worksheet_def.htm
http://spreadsheets.about.com/od/c/g/column_header.htm
http://spreadsheets.about.com/od/f/g/Formula_bar_def.htm
http://spreadsheets.about.com/od/f/g/formula_defined.htm
http://spreadsheets.about.com/od/glossary/g/name_box_def.htm
http://spreadsheets.about.com/od/c/g/cell_ref_def.htm
http://spreadsheets.about.com/od/glossary/g/row_definition.htm
http://spreadsheets.about.com/od/r/g/row_head_def.htm
http://spreadsheets.about.com/od/c/g/cell_ref_def.htm
http://spreadsheets.about.com/od/uvw/g/worksheet_def.htm
http://spreadsheets.about.com/od/excel-tips/ss/2011-08-17-rename-excel-worksheet.htm
http://spreadsheets.about.com/od/tipsandfaqs/qt/090809-change-worksheet-tab-color-excel-2007.htm
http://spreadsheets.about.com/od/pq/g/81018quickbar.htm
http://spreadsheets.about.com/od/no/g/office_button.htm
http://spreadsheets.about.com/od/r/g/Ribbon.htm
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The Microsoft Office Button 

 
In the upper-left corner of the Excel 2007 window is the Microsoft Office button. When you click the 

button, a menu appears. You can use the menu to create a new file, open an existing file, save a file, and 

perform many other tasks. 

The Quick Access Toolbar    

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar gives you with 

access to commands you frequently use. By default, Save, Undo, and Redo appear on the Quick Access 

toolbar. You can use Save to save your file, Undo to roll back an action you have taken, and Redo to 

reapply an action you have rolled back. 

The Title Bar 

 
Next to the Quick Access toolbar is the Title bar. On the Title bar, Microsoft Excel displays the name of 

the workbook you are currently using. At the top of the Excel window, you should see "Microsoft Excel - 

Book1" or a similar name. 

The Ribbon 

 
You use commands to tell Microsoft Excel what to do. In Microsoft Excel 2007, you use the Ribbon to 

issue commands. The Ribbon is located near the top of the Excel window, below the Quick Access toolbar. 

At the top of the Ribbon are several tabs; clicking a tab displays several related command groups. Within 

each group are related command buttons. You click buttons to issue commands or to access menus and 

dialog boxes. You may also find a dialog box launcher in the bottom-right corner of a group. When you 

click the dialog box launcher, a dialog box makes additional commands available. 

To start MS EXCEL-To start Microsoft Excel, from the Taskbar, click 

Start > (All) Programs -> Microsoft Office -> Microsoft Office Excel 

 Worksheets 

 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/01_excel.htm
file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/01_excel.htm
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Microsoft Excel consists of worksheets. Each worksheet contains columns and rows. The columns are lettered A to 

Z and then continuing with AA, AB, AC and so on; the rows are numbered 1 to 1,048,576. The number of columns 

and rows you can have in a worksheet is limited by your computer memory and your system resources. A box 

formed by the intersection of column and row is called as Cells 

Work Book 

Work book is a collection of worksheets used in a single file. In otherwords, each file in a Microsoft excel is known 

as work book. 

The combination of a column coordinate and a row coordinate make up a cell address. For example, the cell located 

in the upper-left corner of the worksheet is cell A1, meaning column A, and row 1. Cell E10 is located under column 

E on row 10. You enter your data into the cells on the worksheet. 

The Formula Bar 

 
Formula Bar 

If the Formula bar is turned on, the cell address of the cell you are in displays in the Name box which is located on 

the left side of the Formula bar. Cell entries display on the right side of the Formula bar. If you do not see the 

Formula bar in your window, perform the following steps: 

1. Choose the View tab. 

2. Click Formula Bar in the Show/Hide group. The Formula bar appears.The current cell address displays on 

the left side of the Formula bar. 

The Status Bar 

  

The Status bar appears at the very bottom of the Excel window and provides such information as the sum, 

average, minimum, and maximum value of selected numbers. You can change what displays on the Status 

bar by right-clicking on the Status bar and selecting the options you want from the Customize Status Bar 

menu. You click a menu item to select it. You click it again to deselect it. A check mark next to an item 

means the item is selected. 

Move around a Worksheet 

By using the arrow keys, you can move around your worksheet. You can use the down arrow key to move downward 

one cell at a time. You can use the up arrow key to move upward one cell at a time. You can use the Tab key to move 

across the page to the right, one cell at a time. You can hold down the Shift key and then press the Tab key to move 

to the left, one cell at a time. You can use the right and left arrow keys to move right or left one cell at a time. The 

Page Up and Page Down keys move up and down one page at a time. If you hold down the Ctrl key and then press 

the Home key, you move to the beginning of the worksheet. 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/01_excel.htm
file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/01_excel.htm
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Move around the Worksheet 

The Down Arrow Key 

 Press the down arrow key several times. Note that the cursor moves downward one cell at a time. 

The Up Arrow Key 

 Press the up arrow key several times. Note that the cursor moves upward one cell at a time. 

The Tab Key 

1. Move to cell A1. 

2. Press the Tab key several times. Note that the cursor moves to the right one cell at a time. 

The Shift Tab Keys 

 Hold down the Shift key and then press Tab. Note that the cursor moves to the left one cell at a 

time. 

The Right and Left Arrow Keys 

1. Press the right arrow key several times. Note that the cursor moves to the right. 

2. Press the left arrow key several times. Note that the cursor moves to the left. 

Page Up and Page Down 

1. Press the Page Down key. Note that the cursor moves down one page. 

2. Press the Page Up key. Note that the cursor moves up one page. 

The Ctrl-Home Key 

1. Move the cursor to column J. 

2. Stay in column J and move the cursor to row 20. 

3. Hold down the Ctrl key while you press the Home key. Excel moves to cell A1. 

Go To Cells Quickly  

The following are shortcuts for moving quickly from one cell in a worksheet to a cell in a different part of 

the worksheet. 

 For eg: Go to G5 

The G5 function key is the "Go To" key. If you press the G5 key, you are prompted for the cell to which 

you wish to go. Enter the cell address, and the cursor jumps to that cell. 

1. Press G5. The Go To dialog box opens. 

2. Type J3 in the Reference field. 

3. Press Enter. Excel moves to cell J3. 

The Name Box 

You can also use the Name box to go to a specific cell. Just type the cell you want to go to in the Name box 

and then press Enter. 

 
1. Type B10 in the Name box. 

2. Press Enter. Excel moves to cell B10. 

Select Cells 

If you wish to perform a function on a group of cells, you must first select those cells by highlighting them. 

The exercises that follow teach you how to select. 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/01_excel.htm
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To select cells A1 to E10: 

1. Go to cell A1. 

2. Press the F8 key. This anchors the cursor. 

3. Note that "Extend Selection" appears on the Status bar in the lower-left corner of the window. You 

are in the Extend mode. 

4. Click in cell E10. Excel highlights cells A1 to E10. 

5. Press Esc and click anywhere on the worksheet to clear the highlighting. 

Alternative Method: Select Cells by Dragging 

You can also select an area by holding down the left mouse button and dragging the mouse over the area. 

In addition, you can select noncontiguous areas of the worksheet by doing the following: 

 
1. Go to cell A1. 

2. Hold down the Ctrl key. You won't release it until step 9. Holding down the Ctrl key enables you to 

select noncontiguous areas of the worksheet. 

3. Press the left mouse button. 

4. While holding down the left mouse button, use the mouse to move from cell A1 to C5. 

5. Continue to hold down the Ctrl key, but release the left mouse button. 

6. Using the mouse, place the cursor in cell D7. 

7. Press the left mouse button. 

8. While holding down the left mouse button, move to cell F10. Release the left mouse button. 

9. Release the Ctrl key. Cells A1 to C5 and cells D7 to F10 are selected. 

10. Press Esc and click anywhere on the worksheet to remove the highlighting. 

Enter Data 

In order to enter data, first, place the cursor in the cell in which you want to start entering data. Type some 

data, and then press Enter. If you need to delete, press the Backspace key to delete one character at a time. 

1. Place the cursor in cell A1. 

2. Type Manohar. Do not press Enter at this time. 

Delete Data 

The Backspace key erases one character at a time.  

*Press the Backspace key until Manohar is erased. 
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Edit a Cell 

After you enter data into a cell, you can edit the data by pressing F2 while you are in the cell you wish to 

edit. 

Change "John" to "Jones." 

1. Move to cell A1. 

2. Press F2.  

3. Use the Backspace key to delete the "n" and the "h." 

4. Type nes. 

5. Press Enter. 

 

Editing a Cell by Using the Formula Bar 

You can also edit the cell by using the Formula bar. You change "Jones" to "Joker" in the following 

exercise. 

 

 
 

1. Move the cursor to cell A1. 

2. Click in the formula area of the Formula bar. 

 

 
 

3. Use the backspace key to erase the "s," "e," and "n." 

4. Type ker. 

5. Press Enter. 
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By Double-Clicking in the Cell 

You can change "Joker" to "Johnson" as follows: 

 
1. Move to cell A1. 

2. Double-click in cell A1. 

3. Press the End key. Your cursor is now at the end of your text. 

 
3. Use the Backspace key to erase "r," "e," and "k." 

4. Type hnson. 

5. Press Enter. 

Wrap Text 

When you type text that is too long to fit in the cell, the text overlaps the next cell. If you do not want it to overlap 

the next cell, you can wrap the text.  

 Move to cell A2.  

 
1. Type Text too long to fit.  

2. Press Enter. 

3. Return to cell A2. 

4. Choose the Home tab. 

5. Click the Wrap Text button . Excel wraps the text in the cell. 
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Delete a Cell Entry 

To delete an entry in a cell or a group of cells, you place the cursor in the cell or select the group of cells 

and press Delete. 

1. Select cells A1 to A2. 

2. Press the Delete key. 

Save a File 

To save your file: 

1. Click the Office button. A menu appears. 

2. Click Save. The Save As dialog box appears. 

3. Go to the directory in which you want to save your file. 

4. Type name of file in the File Name field. 

5. Click Save. Excel saves your file. 

Close Excel 

Close Microsoft Excel. 

1. Click the Office button. A menu appears. 

2. Click Close. Excel closes.  

Formatting of Work sheet 

Convert Text to Columns 

Sometimes you will want to split data in one cell into two or more cells.  You can do this easily by utilizing 

the Convert Text to Columns Wizard. 

 Highlight the column in which you wish to split the data 

 Click the Text to Columns button on the Data tab 

 Click Delimited if you have a comma or tab separating the data, or click fixed widths to set the data 

separation at a specific size.   

Modify Fonts 

Modifying fonts in Excel will allow you to emphasize titles and headings. To modify a font: 

 Select the cell or cells that you would like the font applied 

 On the Font group on the Home tab, choose the font type, size, bold, italics, underline, or color 
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Format Cells Dialog Box 

In Excel, you can also apply specific formatting to a cell. To apply formatting to a cell or group of cells: 

 Select the cell or cells that will have the formatting  

 Click the Dialog Box arrow on the Alignment group of the Home tab 

 
There are several tabs on this dialog box that allow you to modify properties of the cell or cells.  

Number:  Allows for the display of different number types and decimal places 

Alignment:  Allows for the horizontal and vertical alignment of text, wrap text, shrink text, merge cells and the 

direction of the text. 

Font:  Allows for control of font, font style, size, color, and additional features 

Border:  Border styles and colors 

Fill:  Cell fill colors and styles 

Add Borders and Colors to Cells 

Borders and colors can be added to cells manually or through the use of styles.  To add borders manually: 

 Click the Borders drop down menu on the Font group of the Home tab 

 Choose the appropriate border 

To apply colors manually: 

 Click the Fill drop down menu on the Font group of the Home tab 

 Choose the appropriate color 

To apply borders and colors using styles: 

 Click Cell Styles on the Home tab 

 Choose a style or click New Cell Style 
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Change Column Width and Row Height 

To change the width of a column or the height of a row: 

 Click the Format button on the Cells group of the Home tab 

 Manually adjust the height and width by clicking Row Height or Column Width 

 To use AutoFit click AutoFit Row Height or AutoFit Column Width 

 
Hide or Unhide Rows or Columns 

To hide or unhide rows or columns: 

 Select the row or column you wish to hide or unhide 

 Click the Format button on the Cells group of the Home tab 

 Click Hide & Unhide 

 
Merge Cells 

To merge cells select the cells you want to merge and click the Merge & Center button on the Alignment 

group of the Home tab.  The four choices for merging cells are: 

Merge & Center: Combines the cells and centers the contents in the new, larger cell 

Merge Across: Combines the cells across columns without centering data 

Merge Cells: Combines the cells in a range without centering 

Unmerge Cells: Splits the cell that has been merged 
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Align Cell Contents 

To align cell contents, click the cell or cells you want to align and click on the options within the 

Alignment group on the Home tab.  There are several options for alignment of cell contents: 

Top Align:  Aligns text to the top of the cell 

Middle Align:  Aligns text between the top and bottom of the cell 

Bottom Align:  Aligns text to the bottom of the cell 

Align Text Left:  Aligns text to the left of the cell 

Center:  Centers the text from left to right in the cell                         

 

Align Text Right:  Aligns text to the right of the cell 

Decrease Indent:  Decreases the indent between the left border and the text 

Increase Indent:  Increase the indent between the left border and the text 

Orientation:  Rotate the text diagonally or vertically 

Insert and Delete Columns and Rows 

 

To delete columns F and G:  

1. Click the column F indicator and drag to column G. 

2. Click the down arrow next to Delete in the Cells group. A menu appears. 

3. Click Delete Sheet Columns. Excel deletes the columns you selected. 

4. Click anywhere on the worksheet to remove your selection. 
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To delete rows 7 through 12: 

 

1. Click the row 7 indicator and drag 

to row 12.  

2. Click the down arrow next to 

Delete in the Cells group. A menu 

appears. 

3. Click Delete Sheet Rows. Excel 

deletes the rows you selected. 

4. Click anywhere on the worksheet 

to remove your selection. 

 

To insert a column: 

1. Click on A to select column A. 

2. Click the down arrow next to 

Insert in the Cells group. A menu 

appears. 

3. Click Insert Sheet Columns. Excel inserts a new column. 

4. Click anywhere on the worksheet to remove your selection. 

To insert rows:  

1. Click on 1 and then drag down to 2 to select rows 1 and 2. 

2. Click the down arrow next to Insert in the Cells group. A menu appears. 

3. Click Insert Sheet Rows. Excel inserts two new rows. 

4. Click anywhere on the worksheet to remove your selection. 

Your worksheet should look like the one shown here. 

. 

 

 Printing the worksheet 

To print a work sheet, open the workbook containing the worksheet. Click the sheet tab of the worksheet to 

be printed. 

Click “print” on file menu 

Excel displays the print dialogue box. Excel allows printing a range of selected active worksheet or the 

entire work book. It is also possible to print a range of pages in excel. 

.FUNCTIONS AND FORMULAS IN EXCEL 

         A function is a predetermined formula in excel. It performs calculation by using specific values, 

called arguments, in a particular order, or structure. For example, the ―SUM‖ function adds values or 

ranges of cells and the ―PMT‖ function calculates the loan payments based on the interest rate, length of 

loan and the principal amount etc.  
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The way to enter a Function in Excel is through the panels on the Ribbon, there is a function library 

consisting of tabs of function wizard, auto sum, recently used functions, financial, logical, text, date &time, 

math& trig etc., This is more user friendly. 

 Click the Formulas menu at the top of Excel 

 Locate the Function Library panel: 

 
.Performing Mathematical Calculations 

A major strength of Excel is that you can perform mathematical calculations and format your data. In 

Microsoft Excel; you can enter numbers and mathematical formulas into cells. Whether you enter a number 

or a formula, you can reference the cell when you perform mathematical calculations such as addition, 

subtraction, multiplication, or division. When entering a mathematical formula, precede the formula with 

an equal sign. Use the following to indicate the type of calculation you wish to perform:+ Addition,- 

Subtraction,* Multiplication,/ Division,^ Exponential etc., 

Addition 

 
1. Type Add in cell A1. 

2. Press Enter. Excel moves down one cell. 

3. Type 1 in cell A2. 

4. Press Enter. Excel moves down one cell. 

5. Type 1 in cell A3. 

6. Press Enter. Excel moves down one cell. 

7. Type =A2+A3 in cell A4. 

8. Click the check mark on the Formula bar. Excel adds cell A1 to cell A2 and displays the result in 

cell A4. The formula displays on the Formula bar. 

Subtraction 

1. Press F5. The Go To dialog box appears. 

2. Type B1 in the Reference field. 

3. Press Enter. Excel moves to cell B1. 
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4. Type Subtract. 

5. Press Enter. Excel moves down one cell. 

6. Type 6 in cell B2. 

7. Press Enter. Excel moves down one cell. 

8. Type 3 in cell B3. 

9. Press Enter. Excel moves down one cell. 

10. Type =B2-B3 in cell B4. 

11. Click the check mark on the Formula bar. Excel subtracts cell B3 from cell B2 and the result displays in cell 

B4. The formula displays on the Formula bar. 

Multiplication 

1. Hold down the Ctrl key while you press "g" (Ctrl+g). The Go To dialog box appears. 

2. Type C1 in the Reference field. 

3. Press Enter. Excel moves to cell C1 

4. Type Multiply. 

5. Press Enter. Excel moves down one cell. 

6. Type 2 in cell C2. 

7. Press Enter. Excel moves down one cell. 

8. Type 3 in cell C3. 

9. Press Enter. Excel moves down one cell. 

10. Type =C2*C3 in cell C4. 

11. Click the check mark on the Formula bar. Excel multiplies C1 by cell C2 and displays the result in cell C3. 

The formula displays on the Formula bar. 

Division 

1. Press F5. 

2. Type D1 in the Reference field. 

3. Press Enter. Excel moves to cell D1. 

4. Type Divide. 

5. Press Enter. Excel moves down one cell. 

6. Type 6 in cell D2. 

7. Press Enter. Excel moves down one cell. 

8. Type 3 in cell D3. 

9. Press Enter. Excel moves down one cell. 

10. Type =D2/D3 in cell D4. 

11. Click the check mark on the Formula bar. Excel divides cell D2 by cell D3 and displays the result in cell D4. 

The formula displays on the Formula bar. 
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When creating formulas, you can reference cells and include numbers. All of the following formulas are valid: 

=A2/B2 

=A1+12-B3 

=A2*B2+12 

=24+53 

AutoSum  

You can use the AutoSum button on the Home tab to automatically add a column or row of numbers. 

When you press the AutoSum button , Excel selects the numbers it thinks you want to add. If you then 

click the check mark on the Formula bar or press the Enter key, Excel adds the numbers. If Excel's guess as 

to which numbers you want to add is wrong, you can select the cells you want.  

The following illustrates AutoSum: 

 
1. Go to cell F1. 

2. Type 3.  

3. Press Enter. Excel moves down one cell. 

4. Type 3. 

5. Press Enter. Excel moves down one cell. 

6. Type 3.  

7. Press Enter. Excel moves down one cell to cell F4. 

8. Choose the Home tab. 

9. Click the AutoSum button in the Editing group. Excel selects cells F1 through F3 and enters a 

formula in cell F4. 

 
10. Press Enter. Excel adds cells F1 through F3 and displays the result in cell F4. 

Perform Automatic Calculations 

By default, Microsoft Excel recalculates the worksheet as you change cell entries. This makes it easy for 

you to correct mistakes and analyze a variety of scenarios. Make the changes described below and note 

how Microsoft Excel automatically recalculates. 
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1. Move to cell A2. 

2. Type 2. 

3. Press the right arrow key. Excel changes the result in cell A4. Excel adds cell A2 to cell A3 and the 

new result appears in cell A4. 

4. Move to cell B2. 

5. Type 8.  

6. Press the right arrow key.  Excel subtracts cell B3 from cell B3 and the new result appears in cell 

B4. 

7. Move to cell C2. 

8. Type 4. 

9. Press the right arrow key. Excel multiplies cell C2 by cell C3 and the new result appears in cell C4. 

10. Move to cell D2. 

11. Type 12.  

12. Press the Enter key. Excel divides cell D2 by cell D3 and the new result appears in cell D4. 

Advanced Calculations 

1. Move to cell A7. 

2. Type =3+3+12/2*4. 

3. Press Enter. 

 Microsoft Excel divides 12 by 2, multiplies the answer by 4, adds 3, and then adds another 3. The answer, 

30, displays in cell A7. 

 
To change the order of calculation, use parentheses. Microsoft Excel calculates the information in 

parentheses first. 

1. Double-click in cell A7. 

2. Edit the cell to read =(3+3+12)/2*4. 

3. Press Enter. 

Microsoft Excel adds 3 plus 3 plus 12, divides the answer by 2, and then multiplies the result by 4. 

The answer, 36, displays in cell A7. 



School of Distance Education 
 

Information Technology for Business & Management                       67 
 

 
Absolute Cell Addressing 

You make a cell address an absolute cell address by placing a dollar sign in front of the row and column 

identifiers. You can do this automatically by using the F4 key. To illustrate: 

1. Move to cell C12. 

2. Type =. 

3. Click cell C9. 

4. Press F4. Dollar signs appear before the C and the 9. 

5. Type +. 

6. Click cell C10. 

7. Press F4. Dollar signs appear before the C and the 10. 

8. Type +. 

9. Click cell C11. 

10. Press F4. Dollar signs appear before the C and the 11. 

11. Click the check mark on the formula bar. Excel records the formula in cell C12. 

 
 

Financial functions 

          Microsoft Excel provides a series of functions designed to perform various types of financially 

related operations. These functions use common factors depending on the value that is being calculated. 

Many of these functions deal with investments or loan financing. 

Present Value – It is the current value of an investment or a loan. The initial value that the customer 

deposits or has in the account is the Present Value. If the customer is making deposits, this value must be 

negative. If the customer is receiving money (interest, rent, lottery installments, etc), then this value should 

be positive. 

Future Value- it is the value the loan or investment will have when the loan is paid off or when the 

investment is over. To calculate the future value of an investment, you can use the FV() function. The 

syntax of this function is:  

Function FV (Rate, Periods, Payment, Present Value, Payment Type) As Currency 

The Number of Periods is the number of payments that make up a full cycle of a loan or an investment. 

The Interest Rate is a fixed percent value applied during the life of the loan or the investment. The rate 

does not change during the length of the Periods. 

It is very important to understand how these two arguments are passed to a function. The period could be 

the number of months of a year, which is 12; but it could be another length. Suppose a customer is getting a 

car loan that would be financed in 5 years. This is equivalent to 5 * 12 = 60 months. In the same way, a 

cash loan can stretch from 0 to 18 months, a carpenter truck loan can have a life financing of 40 months, 

and a condominium can be financed for 15 years of 12 months plus an additional 8 months; this is 
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equivalent to (15 * 12) + 8 = 188 months. Here is the tricky part, especially as far as Microsoft Excel deals 

with its finance functions. If you pass the number of Periods in terms of years, such as 5 for a car loan that 

stretches over 5 years, then you can pass the Rate as a percentage value, such as 8.75%. If you pass the 

number of Periods in terms of months, for example you can pass it as 44 for a car that is financed in 3 

years and 8 months, then you must communicate this to the Rate argument by dividing the Rate by 12. In 

other words, a Rate of 8.75% would be passed as 8.75%/12. If the Rate was typed in a cell named B2 that 

displays 8.75%, you can pass it as B2/12. 

For deposits made in a savings account, because their payments are made monthly, the rate is divided by 

the number of Periods of a year, which are 12. If an investment has an interest rate set at 14.50%, the Rate 

would be 14.50/12 = 1.208. Because the Rate is a percentage value, its actual value must be divided by 100 

before passing it to the function. For a loan of 14.50% interest rate, this would be 14.50/12 = 1.208/100 = 

0.012. 

The Payment is the amount the customer will be paying. For a savings account where a customer has 

pledged to pay a certain amount in order to save a set (goal) amount, this would be the amount the 

customer would pay every month. If the customer makes payments (car loan, mortgage, deposits to a 

savings account, etc) then this value must be negative. If the customer is receiving money (lottery 

installment or annuity, family inheritance, etc) this value must be positive. 

The Payment Type specifies whether the payment is made at the beginning or the end of the period. For a 

monthly payment of an item financed like a car, a boat, a guitar, or a house this could be the end of every 

month. 
1. Start a new workbook and fill up Sheet1 as follows: 

  

2. Save it as Business 

3. Double-click Sheet1 to put its label into edit mode. Type Future Value and press Enter 

4. Click cell C8 

5. On the Ribbon, click Formulas. 

In the Function Library section, click Financial and click FV. 

6. Move the Function Arguments dialog box so you can see the values on the worksheet 

7. Click the box to the right of Rate and, on the worksheet, click cell C5 and type /12 

8. In the Function Arguments dialog box, click the box to the right of Nper and, on the worksheet, click cell C7 

9. In the Function Arguments dialog box, click the box to the right of Pmt and type - 

10. On the worksheet, click cell C6 

11. In the Function Arguments dialog box, click the box to the right of Pv and type - 

12. On the worksheet, click cell C4 

13. Since this is a loan, the payments are expected at the end of the month. Therefore, in the Function 

Arguments dialog box, click the box to the right of Type and type 0 

14. Click OK 

The Number of Periods (NPER) is the number of payments that make up a full cycle of a loan or an 

investment    

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/fin%20exce.htm
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To calculate the number of periods of an investment or a loan, you can use the NPER() function. Its syntax 

is: Function NPER (Rate, Payment, Present Value, Future Value, Payment Type) As Currency 

15.  

  

 
Here is an example: 

 
  

Investment or Loan Payment 

The PMT() function is used to calculate the regular payment of loan or an investment. Its syntax is: 

Function PMT (Rate, Periods, Present Value, Future Value, Payment Type) As Currency 

In the following example, a customer is applying for a car loan. The cost of the car will be entered in cell 

C4. It will be financed at a rate entered in cell C6 for a period set in cell C7. The dealer estimates that the 

car will have a value of $0.00 when it is paid off. 

 Calculating the Monthly Payments of a Loan 

1. Double-click Sheet3 to put it in edit mode. Type Payments Amount and press Enter  
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2. Complete the worksheet as follows 

  

 
3. Click cell C8 and type =PMT( 

4. Click cell C6 and type /12,  

5. Click cell C7 and type ,- 

6. Click cell C4 and type , 

7. Click cell C5 

8. Type ,0) and, on the Formula Bar, click the Enter button  

 

The Amount Paid As Interest During a Period  

The IPMT () function is used to calculate the amount paid as interest on a loan during a period of the 

lifetime of a loan or an investment. It is important to understand what this function calculates. Suppose a 

customer is applying for a car loan and the salesperson decides (or agrees with the customer) that the loan 

will be spread over 5 years (5 years * 12 months each = 60 months). The salesperson then applies a certain 

interest rate. 

The syntax of the IPMT () function is: 

Function IPMT (Rate, Period, NPeriods, Present Value, Future Value, Payment Type) As Double 

The Rate argument is a fixed percent value applied during the life of the loan. 

The Present Value is the current value of the loan or investment. It could be the marked value of the car, 

the current mortgage value of a house, or the cash amount that a bank is lending. 

The Future Value is the value the loan or investment will have when the loan is paid off. 

The NPeriods is the number of periods that occur during the lifetime of the loan. For example, if a car is 

financed in 5 years, this value would be (5 years * 12 months each =) 60 months. When passing this 

argument, you must remember to pass the right amount. 

The Period argument represents the payment period. For example, it could be 3 to represent the 3rd year of 

a 5 year loan. In this case, the IPMT() function would calculate the interest earned in the 3rd year only. 

The Payment Type specifies whether the periodic (such as monthly) payment of the loan is made at the 

beginning (1) or at the end (1) of the period. 

The Future Value and the Payment Type arguments are not required. 

Calculating the Monthly Payments of a Loan 

1. To add a new worksheet, click the button on the right side of the Payment Amounts tab  

2. Double-click the new Sheet4 tab to put it in edit mode  

3. Type Periodic Interest Earned and press Enter  
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4. Complete the worksheet as follows 

  

 
5. Click cell C9 and type =IPMT( 

6. Click cell C5 and type /12,  

7. Click cell C6 and type , 

8. Click cell C7 and type ,- 

9. Click cell C4 and type , 

10. Click cell C8 and type ,0) 

11. On the Formula Bar, click the Enter button  

  

 
12. Save the workbook  

The Amount Paid as Principal 

While the IPMT() function calculates the amount paid as interest for a period of a loan or an investment, 

the PPMT() function calculates the actual amount that applies to the balance of the loan. This is referred to 

as the principal. Its syntax is: 

Function PPMT (Rate, Period, NPeriods, Present Value, Future Value, Payment Type) As Currency 

The arguments are the same as described in the previous sections. 

Evaluating amount paid as principal 
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Change the Periodic Interest Earned worksheet as follows 

  

 
1. Click cell C10 and type =PPMT( 

2. Click cell C5 and type /12,  

3. Click cell C6 and type , 

4. Click cell C7 and type ,- 

5. Click cell C4 and type , 

6. Click cell C8 and type , 

7. Type ,0) and, on the Formula Bar, click the Enter button  

  

 
8. Save the workbook  

 The PV() function calculates the total amount that a future investment is worth currently. Its syntax is: 

Function PV (Rate, NPeriods, Payment, Future Value, Payment Type) As Currency 

The arguments are the same as described earlier.  

RATE() function is used to calculate the interest applied on a loan or an investment. Its syntax is: 

Function RATE (NPeriods, Payment, Present Value, Future Value, Payment Type, Guess) As Double 

All of the arguments are the same as described for the other functions, except for the Guess. This argument 

allows you to give some type of guess for a rate. This argument is not required. If you omit it, its value is 

assumed to be 10. 

Calculating the interest rate 

1. To add a new worksheet, click the button on the right side of the Periodic Interest Earned tab  

2. Double-click the new Sheet5 tab to put it in edit mode  

3. Type Interest Rate and press Enter  
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4. Change the Interest Rate worksheet as follows 

  

 
5. Click cell C8 and type =-RATE( 

6. Click cell C7 and type ,  

7. Click cell C6 and type ,- 

8. Click cell C4 and type , 

9. Click cell C5 and type ,0)*12 and, on the Formula Bar, click the Enter button  

  

 
10. Use the Percent Style button in the Number section of the Home tab of the Ribbon to make the 

value display as a percentage value  

11. Save the workbook  

 

 

The IRR () function  

This function is used to calculate an internal rate of return based on a series of investments. Its syntax is:  

Function IRR (Values, Guess) As Double 

The Values argument is a series (also called an array or a collection) of cash amounts that a customer has 

made on an investment. For example, a customer could make monthly deposits in a savings or credit union 

account. Another customer could be running a business and receiving different amounts of money as the 

business is flowing (or losing money). The cash flows don't have to be the same at different intervals but 

they should (or must) occur at regular intervals such as weekly (amount cut from a paycheck), bi-weekly 

(401k directly cut from paycheck), monthly (regular investment), or yearly (income).  

The Values argument must be passed as a collection of values, such as a range of selected cells, and not an 

amount. Otherwise you would receive an error.  
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The Guess parameter is an estimate interest rate of return of the investment.  

Calculating the Internal Rate of Return 

1. To add a new worksheet, click the button on the right side of the other tab sheets  

2. Double-click the new Sheet1 tab to put it in edit mode. Type Internal Rate of Return and press 

Enter  

3. Change the worksheet as follows 

  

 
4. Click cell D12 and type =IRR( 

5. Select cells D4:D10 and, on the Formula Bar, click the Enter button  

 In cell D11, type 12 and click cell D12  

6. In the Formula Bar, change the function to =IRR(D4:D10, D11) and press Enter (you shouldn't see 

any significant difference unless you change the range of cells such as D4:D8)  

7. Save the workbook  

The Net Present Value  

The NPV () function uses a series of cash flows to calculate the present value of an investment. Its syntax 

is:  

Function NPV (Rate, Value1, Value2 ...) As Currency 

The Rate parameter is the rate of discount during one period of the investment.  

 Any payment made in the past should have a positive value (because it was made already). Any future 

payment should have a negative value (because it has not been made yet).  

 Calculating the Net Present Value 

1. To add a new worksheet, click the button on the right side of the other tab sheets  

2. Double-click the new Sheet7 tab to put it in edit mode  

3. Type Net Present Value and press Enter  
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4. Complete the worksheet as follows: 

  

 
5. Click cell D14 and type =-NPV( 

6. Click cell D13 and type ,  

7. Select cells D4:D12 and, on the Formula Bar, click the Enter button  

8. Save the workbook  

ISPMT function  

It calculates the interest paid during a specific period of an investment. Its syntax is given below 

     = ISPMT (Rate, Per, Nper, PV)  

Rate –interest rate for the investment 

Per – period for which we want to find the interest, and must be between 1 and nper 

Nper- total number of payment period 

PV – is the present value of investment.            

Excel Statistical Functions 

Excel's Statistical Functions can be used to analysis the data in a spreadsheet. For example, they can be 

used to tell you the number of data entries you have or the average value of your data. There are number of 

statistical functions in excel. The uses of some of the statistical functions are explained below. 

Covar 

In Excel, the Covar function returns the covariance, the average of the products of deviations for two data 

sets. The syntax for the Covar function is: Covar (array1, array2) array1 and array are two ranges or 

arrays of integer values. For example: Let's take a look at an example: =Covar({1,2;3,4}, {5,6;7,8}) The 

above example would return 1.25.   

Forecast 

In Excel, the Forecast function returns a prediction of a future value based on existing values provided. The 

syntax for the Forecast function is: Forecast(x-value, known_y_values, known_x_values ) x-value is the x-

value used to predict the y-value. Known_y_values is the known y-values used to predict the y-value.   

Intercept 

In Excel, the Intercept function returns the y-axis intersection point of a line using x-axis values and y-axis 

values. The syntax for the Intercept function is: Intercept (known_y_values, known_x_values) 

known_y_values is the known y-values used to calculate the intersect. Known_x_values is the known x 

values used to calculate the intercept. 
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Median 

In Excel, the Median function returns the median of the numbers provided. The syntax for the Median 

function is: Median (number1, number2, number_n) number1, number2, number_n are numeric values - 

they can be numbers, named ranges, arrays, or references to numbers. There can be up to 30 values entered.  

Percentile 

In Excel, the Percentile function returns the nth percentile from a set of values. The syntax for the 

Percentile function is: Percentile (array, nth_percentile) array is a range or array from which you want to 

return the nth percentile. Nth_percentile is the percentile value. It can be a value between 0 and 1. Note: If 

nth_percentile is not a numeric value, the Percentile function will return the #VALUE! error. If 

nth_percentile is a value greater than 1 or less than 0, the Percentile function will return the #NUM! error.    

Quartile 

In Excel, the Quartile function returns the quartile from a set of values. The syntax for the Quartile function 

is: Quartile (array, nth_quartile ) array is a range or array from which you want to return the nth quartile. 

Nth_quartile is the quartile value that you wish to return. It can be one of the following values: Value 

Explanation 0 Smallest value in the data set 1 First quartile (25th percentile) 2 Second quartile (50th 

percentile) 3 Third quartile (75th percentile) 4 largest value in the data set Note: If nth_quartile is not an 

integer, it will be truncated.  

Rank 

In Excel, the Rank function returns the rank of a number within a set of numbers. The syntax for the Rank 

function is: Rank (number, array, order ) number is the number to find the rank for. Array is a range or 

array of numbers to use for ranking purposes. Order is optional. It specifies how to rank the numbers. If 

order is 0, it ranks numbers in descending order. If order is not 0, it ranks numbers in ascending order. If 

the order parameter is omitted, the Rank function assumes order is 0 (descending order)  

StDev 

In Excel, the StDev function returns the standard deviation of a population based on a sample of numbers. 

The syntax for the StDev function is: StDev ( number1, number2 ... number_n ) number1, number2, ... 

number_n are numeric values - they can be numbers, named ranges, arrays, or references to numbers. 

There can be up to 30 values entered.  

CORREL 

In Excel, CORREL calculates the correlation coefficient of the array of cell ranges. In other words this 

function returns the correlation coefficient of two sets of variables. Its syntax is 

;=CORREL (array1, array2) . An example is given below 
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  Finding large, small, average etc in EXCEL 

MAX  Returns the largest value from a list of supplied numbers  

= MAX (number1, number2,) 

MAXA  Returns the largest value from a list of supplied values, counting text and the logical 

value FALSE as the value 0 and counting the logical value TRUE as the value 1  

MIN  Returns the smallest value from a list of supplied numbers  

=MIN ( number1,number2,) 

MINA  Returns the smallest value from a list of supplied values, counting text and the logical 

value FALSE as the value 0 and counting the logical value TRUE as the value 1  

LARGE  Returns the Kth LARGEST value from a list of supplied numbers, for a given value K  

SMALL  Returns the Kth SMALLEST value from a list of supplied numbers, for a given value K  

AVERAGE  Returns the Average of a list of supplied numbers  

=AVERAGE (number1,number2,…….) 

AVERAGEA  Returns the Average of a list of supplied numbers, counting text and the logical value 

FALSE as the value 0 and counting the logical value TRUE as the value 1  

AVERAGEIF  Calculates the Average of the cells in a supplied range, that satisfy a given criteria  

AVERAGEIFS  Calculates the Average of the cells in a supplied range, that satisfy multiple criteria  

 

Database in worksheet 

Database is a collection of related data organized in a meaningful manner. Data are stored in tables in 

database. A table is a collection of related records. Each record contains a number of fields. Only flat 

database can be created in excel. In a flat database, column represents fields and row represents record. A 

database can be created anywhere in a worksheet. But it must be separated from other data in the worksheet 

so as to recognize the database. Following rules must be observed for creating database in excel. 

 The first row of DB must be used for field names(column headings) 

http://www.excelfunctions.net/MaxFunction.html
http://www.excelfunctions.net/Excel-Maxa-Function.html
http://www.excelfunctions.net/MinFunction.html
http://www.excelfunctions.net/Excel-Mina-Function.html
http://www.excelfunctions.net/LargeFunction.html
http://www.excelfunctions.net/SmallFunction.html
http://www.excelfunctions.net/ExcelAverage.html
http://www.excelfunctions.net/Excel-Averagea-Function.html
http://www.excelfunctions.net/Excel-Averageif-Function.html
http://www.excelfunctions.net/Excel-Averageifs-Function.html
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 Field name must be unique. 

 Records must be entered without leaving any empty row between field names and the first record in 

the DB 

 Each row must contain one full record 

Let us see an inventory database 

 
A number of database functions are available in excel.Excel Database Functions are used to interrogate 

lists of data held on a worksheet. For a selected table they will perform their processing only on records (or 

rows) which meet specified criteria. These functions make Excel Project very versatile spreadsheet 

software indeed. Some of database function in excel are given here; 

DAverage 

In Excel, the DAverage function averages all numbers in a column in a list or database, 

based on a given criteria. The syntax for the DAverage function is: DAverage (range, 

field, criteria) range is the range of cells that you want to apply the criteria against. Field 

is the column to average the values. You can either specify the numerical position of the 

column in the list or the column label in double quotation marks. Criteria are the range of 

cells that contains your criteria. 

  

DCount 

In Excel, the DCount function returns the number of cells in a column or database that 

contains numbers and meets a given criteria. The syntax for the DCount function is: 

DCount( range, field, criteria )  

  

DCountA 

In Excel, the DCountA function returns the number of cells in a column or database that 

contains nonblank values and meets a given criteria. The syntax for the DCountA function 

is: DCountA ( range, field, criteria ) range is the range of cells that you want to apply 

the criteria against.  

  

DGet 

In Excel, the DGet function retrieves from a database a single record that matches a given 

criteria. The syntax for the DGet function is: DGet (database, field, criteria) database is the 

range of cells that you want to apply the criteria against. Field is the column to retrieve.  
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DMax 

In Excel, the DMax function returns the largest number in a column in a list or database, based 

on a given criteria. The syntax for the DMax function is: DMax( database, field, criteria )  

  

DMin 

In Excel, the DMin function returns the smallest number in a column in a list or database, 

based on a given criteria. The syntax for the DMin function is: DMin ( database, field, 

criteria ) database is the range of cells that you want to apply the criteria against.  

  

DProduct 

In Excel, the DProduct function returns the product of the numbers in a column in a list or 

database, based on a given criteria. The syntax for the DProduct function is: DProduct ( 

database, field, criteria ) database is the range of cells that you want to apply the criteria 

against.  

  

DStDev 

In Excel, the DStDev function returns the standard deviation of a population based on a sample 

of numbers in a column in a list or database, based on a given criteria. The syntax for the 

DStDev function is: DStDev( database, field, criteria ) database is the range of cells that you 

want to apply the criteria against. 

  

DStDevP 

In Excel, the DStDevP function returns the standard deviation of a population based on the 

entire population of numbers in a column in a list or database, based on a given criteria. The 

syntax for the DStDevP function is: DStDevP (database, field, criteria) database is the range 

of cells that you want to apply the criteria against. 

  

DSum 

In Excel, the DSum function sums the numbers in a column or database that meets a given 

criteria. The syntax for the DSum function is: DSum (range, field, criteria) range is the range 

of cells that you want to apply the criteria against. Field is the column to sum the values. 

  

DVar 

In Excel, the DVar function returns the variance of a population based on a sample of numbers 

in a column in a list or database, based on a given criteria. The syntax for the DVar function is: 

DVar (database, field, criteria) database is the range of cells that you want to apply the 

criteria against.  

  

DVarP 

In Excel, the DVarP function returns the variance of a population based on the entire population 

of numbers in a column in a list or database, based on a given criteria. The syntax for the DVarP 

function is: DVarP( database, field, criteria )  

 

 

Goal Seek in Excel 

Goal Seek is used to get a particular result when you're not too sure of the starting value. For 

example, if the answer is 56, and the first number is 8, what is the second number? Is it 8 

multiplied by 7,or 8 multiplied by 6? You can use Goal Seek to find out. We'll try that example 

to get you started, and then have a go at amore practical example. 

Create the following Excel spreadsheet 
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In the spreadsheet above, we know that we want to multiply the number in B1 by the number in 

B2.Thenumber in cell B2 is the one we're not too sure of. The answer is going in cell B3. Our 

answer is wrong at the moment, because we have a Goal of 56. To use Goal Seek to get the 

answer, try the following: 

 From the Excel menu bar, click on Data 

 Locate the Data Tools panel and the What if Analysis item. From the What if Analysis 

menu, select Goal Seek 

 The following dialogue box appears: 

 

   
 

The first thing Excel is looking for is "Set cell". This is not very well named. It means "Which 

cell contains the Formula that you want Excel to use". For us, this is cell B3. We have the 

following formula in B3: 

= B1 * B2 

So enter B3 into the "Set cell" box, if it's not already in there. The "To value" box means "What 

answer are you looking for"? For us, this is 56. So just type 56 into the ―To value" box The "By 

Changing Cell" is the part you're not sure of. Excel will be changing this part. For us, it was 

cell B2. We're weren't sure which number, when multiplied by 8, gave the answer 56. So type 

B2 into the box. You Goal Seek dialogue 

 box should look like: 

 
Click OK and Excel will tell you if it has found a solution: 

Click OK again, because Excel has found the answer. Your new spreadsheet will look like this 

one: 
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As you can see, Excel has changed cell B2 and replace the 6 with a 7 - the correct answer.  

 Scenarios in Excel 

. Scenarios come under the heading of "What-If Analysis" in Excel. They are similar to tables 

in that you are changing values to get new results. For example, What if I reduce the amount 

I'm spending on food? How much will I have left then? Scenarios can be saved, so that you can 

apply them with a quick click of the mouse. A Scenario offers you different ways to view a set 

of figures, and allows you to switch between them quite easily.  

          To create scenarios in Excel 2007,carry out the following steps:  

 

 Create the values on the basis of which you wish to create the original scenario.  

 Select the cells in which the data is likely to change.  

 .Go to the 'Data' tab. 

 Click 'What - If Analysis' tool appearing under the 'Data Tools' group.  

 Click the 'Scenario Manager  ....' option from the drop-down list.  

 Click the 'Add' button appearing on the 'Scenario Manager' dialog box. 

 Enter a scenario name and click 'OK' to close the dialog box.  

 Check the values that are assigned to the scenario.  

 Creating Charts in excel 

Charts helps by converting numeric data into visual display. Once the numbers are converted 

into charts and graphs, it is easy to identify its trend and pattern. In Microsoft Excel, you can 

represent numbers in a chart. On the Insert tab, you can choose from a variety of chart types, 

including column, line, pie, bar, area, and scatter. The basic procedure for creating a chart is the 

same no matter what type of chart you choose. 

 As you change your data, your chart will automatically update.  

 

Create a Column Chart 

.  



School of Distance Education 
 

Information Technology for Business & Management                       82 
 

1. Select cells A3 to D6. You must select all the cells containing the data you want in your 

chart. You should  

2. Also include the data labels. 

3. Choose the Insert tab. 

4. Click the Column button in the Charts group. A list of column chart sub-types types 

appears. 

5. Click the Clustered Column chart sub-type. Excel creates a Clustered Column chart and 

the Chart Tools  

6. Context tabs appear. 

Apply a Chart Layout 

Context tabs are tabs that only appear when you need them. Called Chart Tools, there are three 

chart context tabs: Design, Layout, and Format. The tabs become available when you create a 

new chart or when you click on a chart. You can use these tabs to customize your chart. You 

can determine what your chart displays by choosing a layout. For example, the layout you 

choose determines whether your chart displays a title, where the title displays, whether your 

chart has a legend, where the legend displays, whether the chart has axis labels and so on. Excel 

provides several layouts from which you can choose 

 

Apply a Chart Layout 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click the Quick Layout button in the Chart Layout group. A list of chart layouts 

appears. 

4. Click Layout 5. Excel applies the layout to your chart. 

Add Labels 

When you apply a layout, Excel may create areas where you can insert labels. You use labels to 

give your chart a title or to label your axes. When you applied layout 5, Excel created label 

areas for a title and for the vertical axis. 

 

  

Before After 

1. Select Chart Title. Click on Chart Title and then place your cursor before the C in Chart 

and hold down the Shift key while you use the right arrow key to highlight the words 

Chart Title. 

2. Type Toy Sales. Excel adds your title. 

3. Select Axis Title. Click on Axis Title. Place your cursor before the A in Axis. Hold 

down the Shift key while you use the right arrow key to highlight the words Axis Title. 

4. Type Sales. Excel labels the axis. 

5. Click anywhere on the chart to end your entry. 
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Switch Data 

If you want to change what displays in your chart, you can switch from row data to column 

data and vice versa 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click the Switch Row/Column button in the Data group. Excel changes the data in your 

chart. 

Change the Style of a Chart 

A style is a set of formatting options. You can use a style to change the color and format of 

your chart. Excel 2007 has several predefined styles that you can use. They are numbered from 

left to right, starting with 1, which is located in the upper-left corner. 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click the More buttons in the Chart Styles group. The chart styles appear. 

4. Click Style you want. Excel applies the style to your chart. 

Change the Size and Position of a Chart 

When you click a chart, handles appear on the right and left sides, the top and bottom, and the 

corners of the chart. You can drag the handles on the top and bottom of the chart to increase or 

decrease the height of the chart. You can drag the handles on the left and right sides to increase 

or decrease the width of the chart. You can drag the handles on the corners to increase or 

decrease the size of the chart proportionally. You can change the position of a chart by clicking 

on an unused area of the chart and dragging. 

1. Use the handles to adjust the size of your chart. 

2. Click an unused portion of the chart and drag to position the chart beside the data. 

Change the Chart Type 

Any change you can make to a chart that is embedded in a worksheet, you can also make to a 

chart sheet. For example, you can change the chart type from a column chart to a bar chart 

 
1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click Change Chart Type in the Type group. The Chart Type dialog box appears. 

4. Click Bar. 

5. Click Clustered Horizontal Cylinder. 

6. Click OK. Excel changes your chart type. 

Questions 

1. What is spread sheet? What are its features? 
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2. What are the parts of a worksheet? 

3. What are the mathematical functions in excel? 

4. What are the important financial function in excel? 

5. Explain some of the statistical functions in excel? 

6. explain about Goalseak and Scenario functions in excel? 

7. How do you create a chart and graph in excel?    

8. How do you format a worksheet in excel? 

 

2.3 Microsoft PowerPoint 

      Microsoft PowerPoint is a software product used to perform computer-based presentations. 

It helps in quickly creating effective slide show presentation. There are various circumstances 

in which a presentation is made: teaching a class, introducing a product to sell, explaining an 

organizational structure, etc.There are two main kinds of presentations you can deliver: before 

an audience or not. The preparation and the actual delivery of each are quite different. Various 

term in connection with PPPare given here 

Presentation:  

The primary type of file PowerPoint is used to create. Presentations typically have the file 

extension .ppt; however, you can also save PowerPoint presentations as Adobe Acrobat 

documents with the file extension .pdf. Finally, you can save your presentation as a web page, 

with the file extension .html or .htm. 

Slides: 

 Individual parts of a presentation. Slides are similar to the individual pages in a print 

document, and can contain text, graphics, and animation. 

Layout: 

 The specific arrangement of text and images on a slide. Layouts can be very simple, consisting 

of simple titles and text, or they can be more complex and include elaborate colors and images. 

You can also include animation, sounds, and other multimedia objects in your layout. 

View: 

 Microsoft PowerPoint has three main views: normal view, slide sorter view, and slide show 

view. Normal view is the main editing view. Slide sorter view is an exclusive view of your 

slides in thumbnail form, helpful for rearranging the order of your slides. Slide show view takes 

up the full computer screen, like an actual slide show presentation. In this full-screen view, you 

see your presentation the way your audience will. 

Design Template: 

 The specific ―look‖ of a slide or group of slides. A design template can be very basic - with 

black text on a white background - or it can be very colorful and complex. Typically, 

PowerPoint presentations have the same design template for all slides, although it is possible to 

select a different design template for each slide. Later, I‘ll show you how to select different 

design templates. 

Slide Show: 

 The way a presentation appears when you are presenting it. When you display your slides in a 

slide show, the slides typically take up the whole screen, and they appear in sequence. 

Placeholder:  

Boxes with dotted or hatch-marked outlines that appear when you create a new slide. These 

boxes act as "placeholders" for objects such as the slide title, text, clip art, charts, and tables. 

Placeholders are sometimes called ―text boxes.‖  

Sizing handles: 
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 Small circles that appear along the edges of the selection rectangle around an object on your 

slide. You drag a sizing handle to change the shape or size of an object. To maintain the 

proportions of an object while resizing, simply drag a corner handle. 

Creating PowerPoint Presentation 

You create your PowerPoint presentation on slides. You use layouts to organize the content on 

each slide. PowerPoint has several slide layouts from which to choose. Themes are sets of 

colors, fonts, and special effects. Backgrounds add a colored background to your slides. You 

can add themes and backgrounds to your slides. After you complete your slides, you can run 

your presentation. 

Create a Title Slide 

When you start PowerPoint, PowerPoint displays the title slide in the Slide pane. You can type 

the title of your presentation and a subtitle on this slide. To enter text: 

 Click and type the title of your presentation in the "Click to add title" area. 

 Click and type a subtitle in the "Click to add subtitle" area.  

If you do not wish to use the title slide, click the Delete Slide button in the Slides group on 

the Home tab. To create a Title Slide 

1. Open PowerPoint. You are presented with a title 

slide.  

2. Enter the information shown here. Type College Scholarships and Financial Aid in 

the Click to Add Title text box. Type Paying for College in the Click to Add Subtitle 

text box. 

Create New Slides 

After completing your title slide, you can create additional slides. To create a new slide: 

1. Choose the Home tab. 

2. Click the New Slide button in the Slides group. The Office Theme dialog box 

appears and displays several layout templates.  

3. Click the layout you want. The layout appears in the Slide pane of the PowerPoint 

window. 

http://www.baycongroup.com/powerpoint2007/02_powerpoint.htm
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4To add text, click inside the placeholder and type. 

5To add an additional slide to your presentation, do one of the following: 

Right-click the slide layout. A menu appears. Click Layout and then click the layout 

you want. 

Choose the Home tab, click the New Slide button , and then choose the slide 

layout you want. 

1. Choose the Home tab.  

2. Click the New Slide button in the Slides group. The Office Theme dialog box 

appears. 

3. Click the Title and Content Layout. The slide appears on the Slides tab. 

 
4. Enter the information shown here. Type Here is what to do: (including the colon) in 

the Click to Add Title text box. Type the bulleted text in the Content text box. 
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Create an Outline 

If you need to present the information in your slide in outline form, you can easily create an 

outline by using the Increase List Level button to create a hierarchy. 

1. Choose the Home tab. 

2. Click the New Slide button in the Slides group. The Office Theme dialog box 

appears.  

3. Click the Title and Content layout. 

4. Enter the information shown here. Click the Increase List Level button in the 

Paragraph group to indent the bullets for Stafford Loans and PLUS Loans. If you ever 

need to decrease an indent, use the Decrease List Level button in the Paragraph 

group. 

Use Two-Column Text 

You can also place text in two separate columns. 

1. Choose the Home tab. 

2. Click the New Slide button in the Slides group. The Office Theme dialog box 

appears.  

3. Click the Two Content layout. 

4. Enter the information shown here. 

 
Make Changes to Your Slides 

After creating a slide, if you want to add text: 

1. Place the mouse pointer at the point at which you would like to add text. 

2. Type the information you want to add. 

If you would like to change text: 

1. Select the text you want to change. 

2. Type the new text. 

You can use the Backspace key to delete text. You can also delete text by highlighting the text 

and pressing the Delete key. 

Apply a Theme 

A theme is a set of colors, fonts, and special effects. Themes provide attractive backgrounds for 

your PowerPoint slides. 

http://www.baycongroup.com/powerpoint2007/02_powerpoint.htm
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To apply a theme to all of the slides in your presentation: 

1. Choose the Design tab. 

2. Click the More button in the Themes group.  

3. Click the design you want. 

To apply a theme to selected slides: 

1. Click the Slides tab, located on the left side of the window. 

2. Hold down the Ctrl key and then click to select the slides to which you want to apply a 

theme. 

3. Choose the Design tab. 

4. Click the More button in the Themes group. 

5. Right-click the theme you want to apply. A menu appears. 

6. Click Apply to Selected Slides. Excel applies the theme to the slides you selected. 

You can add a dramatic effect to your theme by applying a background. 

1. Choose the Design tab. 

2. Click the Background Styles button . 

3. Click the background you want. 

Apply a Theme 

 

1. Choose the Design tab. 

2. Click the More button in the Themes group.  

 
3. Click the theme you want. PowerPoint applies the theme to all of the slides in your 

presentation. 

Add a Background 

1. Choose the Design tab. 

2. Click the Background Styles button . 

3. Click the background you want. PowerPoint applies the background to your slides. 

Header and Footer on PowerPoint slides 
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In the Header and Footer dialog box, there are options for placing footers on slides, and both 

a header and footer on handouts and notes pages. 

Add Footers to Slides 

1. Click on the Slide tab of the Header and Footer dialog box, if it is not already selected. 

2. Select any options for your slides including:  

 Date and Time (Update automatically)- If you would like the date and/or time to 

show the current date each time the presentation file is opened, click on this option. 

You can then select the format that you would like the date to appear on the slide 

from the drop down box - for example: July 21, 2011 or 21/07/2011. This option is 

helpful if you always want your presentation to appear current. 

 Date and Time (Fixed) - Type the date. This date will be retained permanently 

(unless you choose to change it later). This option is helpful if you want to keep 

track of the creation date of the presentation. 

 Slide number - This option will add numbers to the slides. These slide numbers will 

be placed in the footer area of the slide, but the location on the slide will vary, 

depending on which design theme you choose for this presentation. 

 Footer - Choose this option to add a custom footer which will print on the slide(s). 

This selection is often chosen to brand the company name to the slides. 

 Don't show on title slide - Most presenters prefer that these settings are not added to 

the title slide. If that is the case for this presentation, then check that box. 

3. Click on the Apply to All or Apply button. 

Run PowerPoint Slide Show 

After you create your slides, you can run your slide show: 

1. Do any one of the following:  

 Press F5. 

 Choose the Slide Show tab. Click the From Beginning button in the Start 

Slide Show group. 

 Click the Slide Show icon in the bottom-right corner of your screen.  

 

 

 

http://0.tqn.com/d/presentationsoft/1/0/z/P/-/-/02header-footer.png
http://presentationsoft.about.com/od/powerpoint2010/ss/100826-Print-Powerpoint-2010-Slides_7.htm
http://presentationsoft.about.com/od/powerpoint2010/ss/100207powerpoint2010-slide-views_4.htm
http://presentationsoft.about.com/od/d/g/designtheme.htm
http://www.baycongroup.com/powerpoint2007/02_powerpoint.htm
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Your slide show appears on your screen. 

 Navigating the Slide Show 

Task Procedure 

Go to the next slide. Do one of the following: 

 Press the Right Arrow key. 

 Press the Enter key. 

 Press the Page Down key. 

 Left-click the slide. 

Go to the previous slide. Do one of the following: 

 Press the Left Arrow key. 

 Press the Backspace key. 

 Press the Page Up key. 

End the slide show and return to 

PowerPoint. 

Press the Esc key. 

Run Your Slide Show 

1. Press F5 to run the slide show. 

2. Use the arrow keys on your keyboard to move forward and backward through your 

slides. 

3. Use the Esc key to return to Normal  

Animations, Transitions, Spell Check, Outline Tab, Slides Tab, Sorter View, and Printing 

Animations control how objects move onto, off of, and around your slides. Transitions control 

how your presentation moves from one slide to the next.  

Add Animations  

You can animate the objects on your PowerPoint slides. PowerPoint provides four types of 

animations: Entrance, Emphasis, Exit, and Motion Paths.  

An Entrance animation determines the manner in which an object appears on a slide; for 

example, an object can move onto a slide. 

 An Emphasis animation does something to draw attention to an object; for example, the 

object can become larger.  

An Exit animation determines the manner in which an object leaves a slide; for example, an 

object can move off a slide. 

 A Motion Paths animation determines how an object moves around a slide; for example, an 

object can move from left to right. 

After you add an animation, you can use the Custom Animation pane to modify it by choosing 

an effect. Choosing an effect enables you to define what starts the animation, its properties 

(such the direction from which an object moves onto the slide), and control the speed of the 

animation. In addition, you can have an animation start when you click the mouse, start along 

with the previous animation, or start at a specified time after the previous animation. 

If the Auto Preview box is checked on the Custom Animation pane, PowerPoint provides you 

with preview of your animation after you create it and each time you modify it. You can also 

use the Play button on the Custom Animation pane to preview an animation.  

To choose an effect: 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/03_powerpoint.htm
file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/03_powerpoint.htm
file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/03_powerpoint.htm
file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/03_powerpoint.htm
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1. Select the object you want to animate. 

2. Choose the Animations tab. 

3. Click the Custom Animation button . The Custom Animation pane 

appears. 

4. Click the Add Effect button . A menu appears. 

5. Choose the type of effect you want. A submenu appears. 

6. Click the effect you want. PowerPoint applies the effect. 

To modify an effect: 

1. Click the down arrow next to the Start field on the Custom Animations pane and then 

select the start method you want. 

2. Click the down arrow next to the Property field on the Custom Animations pane and the 

select the property you want. The Property field might be labeled Direction, Size, or 

some other property. 

3. Click the down arrow next to the Speed field on the Custom Animations pane and then 

select the speed you want to apply to your animation. To preview the animation, click 

the Play button on the Custom Animations pane. 

Add an Animation to a Slide  

1. Click Slide 2 on the Slides tab. 

2. Select "Start saving early." 

3. Choose the Animations tab. 

4. Click the Custom Animation button . The Custom Animation pane 

appears. 

5. Click the Add Effect button . A menu appears. 

6. Choose Entrance. A submenu appears. 

7. Click Fly In. PowerPoint applies the effect. If the Auto preview box is checked, 

PowerPoint automatically provides you with a preview of the animation. 

 

 
8. Click Slide 2 on the Slides tab. 

9. Select "Start saving early." 

10. Choose the Animations tab. 

11. Click the Custom Animation button . The Custom Animation pane appears. 
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12. Click the Add Effect button . A menu appears. 

13. Choose Entrance. A submenu appears. 

14. Click Fly In. PowerPoint applies the effect. If the Auto preview box is checked, 

PowerPoint automatically provides you with a preview of the animation. 

Modify the Effect 

 
1. Click the down arrow next to the Start field and then select After Previous. 

2. Click the down arrow next to the Direction field and then select From Bottom. 

3. Click the down arrow next to the Speed field and then select Medium. 

Add another Animation 

1. Select "Apply for financial aid." 

2. Click the Add Effect button . A menu appears. 

3. Choose Entrance. A submenu appears. 

4. Click Fly In. PowerPoint applies the effect. If the Auto preview box is checked, 

PowerPoint automatically provides you with a preview of the animation. 

Modify the Animation 

1. Click the down arrow next to the Start field and then select After Previous. The Apply 

for Financial Aid field appears in the center of the Custom Animation pane. 

2. Click the down arrow next to the Apply for Financial Aid field and then click Timing. 

The Fly In dialog box appears. 

 
3. Type 0.05 in the Delay text box. 

4. Click OK. 
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5. Click the down arrow next to the Direction field and then select From Bottom. 

6. Click the down arrow next to the Speed field and then select Medium. If the Auto 

preview box is checked, PowerPoint automatically provides you with a preview of the 

animation. You can click the Play button on the Custom Animation pane at 

anytime to preview an animation. 

Add Transitions 

Transitions determine how your presentations move from one slide to the next. For example, a 

slide can move up onto the screen and replace the previous slide. PowerPoint provides several 

transition methods. You can add sound to a transition and you can control its speed. You can 

apply a transition to selected slides or to all of the slides in your presentation. 

A transition can occur when the presenter clicks the mouse or after the amount of time you 

specify. 

To apply a transition to selected slides: 

1. On the Slides tab, hold down the Ctrl key and then click the slides to which you want to 

apply the transition. 

2. Choose the Animations tab. 

3. Click the More button in the Transition to this Slide group. A menu of transitions 

appears. 

4. Click the transition you want to apply. PowerPoint applies the transition. As you roll 

your pointer over each transition, PowerPoint provides you with a live preview of the 

transition. 

To apply a transition to all slides: 

1. Choose the Animations tab. 

2. Click the More button in the Transition to this Slide group. A menu of transitions 

appears. 

3. Click the transition you want to apply. As you roll your pointer over each transition, 

PowerPoint provides you with a live preview of the transition. 

4. Click the Apply to All button in the Transition to This Slide group.  

To add a sound to a transition: 

1. Choose the Animations tab. 

2. Click the down arrow next to the Transition Sound field and then click the sound you 

want. As you roll your pointer over each sound, PowerPoint plays the sound. 

To set the speed of a transition: 

1. Choose the Animations tab. 

2. Click the down arrow next to the Transition Speed field and then click the speed you 

want.  

.Add Transitions 
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1. Choose the Animations tab. 

2. Click the More button in the Transition to this Slide group. A menu of transitions 

appears. 

s 

3. Click the Push Up transition. As you roll your pointer over each transition, PowerPoint 

provides you with a live preview of the transition. 

Add Sound and Set the Speed 

 
1. Click the down arrow next to the Transition Sound field and then click Click. 

2. Click the down arrow next to the Transition Speed field and then click Slow. 

Advance Slide 

 
1. Check the On Mouse Click check box. 

2. Click the Automatically After check box. 

3. Type 00:07 in the Automatically After text box. 

4. Click the Apply to All button . PowerPoint applies all of your changes to 

all of the slides. 

5. Click Slide 1 on the Slides tab. 

6. Type 00:03 in the Automatically After text box. PowerPoint changes the timing for Slide 1. 
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Spell Check  

PowerPoint checks you‘re spelling as you type and display errors with a red wavy line under 

the misspelled word. You can right-click and then select the correct spelling from the list of 

offerings on the menu that appears or select Spelling to open the Spelling dialog box. If you 

need to, you can initiate a spell check anytime you like. To start a spell check, do one of the 

following:  

 Press F7. 

 Choose the Review tab and then click the Spelling button . 

 

Spell Check 

1. Press F7 

2. Correct any spelling errors PowerPoint finds. If PowerPoint does not find any errors, 

the Spelling Check is Complete message box appears. Click OK. 

 

Use the Outline and Slides Tabs 

By default, the Outline and Slides tabs are located on the left side of your PowerPoint window. 

The Outline tab displays the text contained in your presentation. The Slides tab displays a 

thumbnail of all your slides. You click the thumbnail to view the slide in the Slide pane. 

1. Choose the Slides tab to view thumbnails of your slides. 

2. Choose the Outline tab to view the text of your presentation as an outline. 

 

Use Slide Sorter View 

After you have created your PowerPoint slides, you can move, cut, copy, paste, duplicate, 

navigate, and view them in Sorter view. To view the slides in Sorter view, do one of the 

following: 

 Choose the View tab and then click the Slide Sorter button in the Presentation 

Views group. 

 Click the Slide Sorter button in the bottom-right corner of the PowerPoint window. 

 

Slide Sorter View 

Task Procedure 

Move to first slide. Use Ctrl+Home. 

Move to last slide.  Use Ctrl+End.  

Move to next slide. Use the right arrow. 

Move to previous slide. Use the left arrow. 

Select a slide. Single-click the slide. 

Open a slide in Normal 

view. 

Double-click the slide. 

Select slides. Select a single slide:  

1. Click the slide you want to select.  
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Select multiple slides: 

1. Hold down the Ctrl key. 

2. Click the slides you want to select. 

Delete a slide. 1. Select the slide or slides you want to delete. 

2. Press the Delete key. 

1. Select the slide or slides you want to delete. 

2. Choose the Home tab and then click the Delete 

button . 

Copy a slide. 1. Select the slide. 

2. Choose the Home tab. 

3. Click the Copy button in the Clipboard 

group. 

1. Select the slide. 

2. Press Ctrl+C. 

Paste a slide. 1. Select the slide after which you want the new 

slide or slides to appear. 

2. Choose the Home tab. 

3. Click the Paste button in the Clipboard group. 

1. Select the slide after which you want 

the new slide or slides to appear. 

2. Press Ctrl+V. 

Cut a slide. 1. Select the slide or slides you want to cut. 

2. Choose the Home tab. 

3. Click the Cut button in the Clipboard group. 

1. Select the slide or slides you want to cut. 

2. Press Ctrl+X. 

Move a slide. 1. Select the slide (or slides) you want to move. 

2. Drag it to the new location. 

Duplicate a slide. 1. Select the slide (or slides) you want to duplicate. 

2. Press Ctrl+D. 

 

Print  

Power Point provides you with many printing options. You can print a large view of your slides 

or you can print your slides as handouts with 1, 2, 3, 4, 6, or 9 slides per page. You can also 

print your Notes pages or the Outline view of your slides. To print slides: 
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1. Click the Microsoft Office button. A menu appears. 

2. Choose Print. 

3. Click Print Preview. The Print Preview tab appears. 

4. Click the down arrow next to the Print What field in the Page Setup group and then 

select Slides. 

5. Click the Print button . The Print dialog box appears. 

6. Click the down arrow next to the Color/Grayscale field to select whether you want your 

slides to print in color, grayscale, or black and white. If you are using a black and white 

printer, choose black and white. You will use less ink or toner. 

7. Set the other print settings. 

8. Click OK. Your slides prints 

 

Questions 

1. Explain the steps in creating a power point presentation? 

2. Explain various parts of a slide? 

3. How do you add animation, transition and sound effect to a presentation? 

4. Explain about running and printing slides? 
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MODULE-3 

Database System  
 

Database 

           Database is an integrated collection of logically related records and files. In other words, it is a 

collection of inter related data item that can be processed by one or more application systems. The first 

databases were developed in the early 60s in US.  

          A database is a set of logically connected data files that have common access methods between them. 

It gives a centralized control over the database resources.    A database system is a way of organizing 

information on a computer, implemented by a set of computer programs. Most commercial and non-

commercial organizations use a database for storing their important information. Simply database is an 

ordered collection of information. Usually this is organized into tables, so we define a database as a 

collection of tables (together with some other, supporting, data structures, such as indices and views, and 

perhaps some computer code). 

 Its characteristics include:  

* Simplicity - an easy way to collect, access-connects, and display information;  

* Stability - to prevent unnecessary loss of data;  

* Security - to protect against unauthorized access to private data;  

* Speed - For fast results in a short time and for easy maintenance in case of changes in the organization 

that stores the information. 

* Reduce redundancy- redundancy arises when the same data are stored unnecessarily at different places. 

DB system will avoid redundancy or duplication of data 

Advantages of database system 

The database system approach has the following advantages 

1. Data independence 

This exists when it is possible to make changes in the data storage characteristics without affecting 

the application program's ability to access the data. 

2. Data shareability 

Database permits simultaneous multiple access to the database. Thus multiple users can share the 

same data. 

3. Data integrity 

Access to the database is controlled by the database management system. The system prevents the 

unauthorized access and manipulation of data in the database. 

4. Data availability 

The database is centrally controlled and access to data permitted through authorization scheme. So 

the data resources are available to the authorized persons 

5. Data evolvability 

The database is flexible and can store huge quantity of data. It can evolve as the number of 

applications and queries increases to meet the data requirements 

 

Components of database system. 

Nutshell, the components of database systems are 

 hardware 

 software 

 people 

 procedures 

 Data. But this can further reclassified into: 
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a. Database file- it store the transaction data 

b. DBMS – it is a set of programmes that manages the database. It controls the access, ensures 

security etc., 

c. Host language interface system- this interacts with application programmes and interpret their 

data request that are issued in high level languages 

d. Natural language interface-it performs interpreting the queries and requests in natural languages 

like English 

e. Application programmes- application programmes request data from the database for variety of 

uses 

f. Data dictionary- data dictionary contains schema of the database. It defines each data item in the 

database, lists its structure, source, person authorized to modify it etc., 

g. Report generator- this generates output for users in the form of query response, reports, forms etc, 

It also produce documents like invoice and process adhoc queries and special report requests 

h. Users of DB-there are three classes related users for DB, they are 

 Application programmers who writes the application programmes 

 End users  who access the DB for various purposes 

 Database administrators  who administer the database 

Data Base Management System 

DBMS = Database Management System- it is a collection of programs that manages the database structure 

and controls access to the data stored in the database. (Think electronic filing cabinet).it updates files and 

retrieve data by applications for processing It serves as the intermediary between the user and the database. 

DBMS maintains database by adding, deleting and modifying records in database. it permits multiple users 

to access the same files simultaneously. 

            DBMS is general purpose system software. It works in conjunction with the operating system to 

create process, store, retrieve, control and manage data. Its tasks include defining (specifying data types, 

structure, storage constraints etc.,), constructing (storing the data in storage medium under the control of 

DBMS) and manipulating (merging, generating reports, processing queries etc.,) database for application. 

Three main components of DBMS are; 

1. Data definition language (DDL) 

The contents of database are created by using the DDL. It defines relationship between different data 

elements and serves as an interface for application programmes that uses data 

2. Data Manipulation Language(DML) 

Data processed and updated by using a language called data manipulation language. It allows a user 

to query database and receive summary or customized reports. DML is usually integrated with other 

programming languages. 

3. Data Dictionary               

  Data dictionary contains schema of the database. It defines each data item in the database, lists its 

structure, source, persons authorized to modify it etc. in other words it gives metadata ie data about 

data, through which the end user data are integrated and managed. 

Functions of a DBMS: 

 Data dictionary management 

 Data storage management 

 Data transformation and presentation 

 Data security management 

 Multiuser access control 

 Backup and recovery management 

 Data integrity management 
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 Database access languages and application programming interfaces. 

 Database communication interfaces 

Advantages of DBMS                                      

 improved data sharing 

 improved data security 

 better data integration  

 minimized data inconsistency 

 improved data access 

 improved decision making 

 increased end-user productivity 

 Disadvantages of DBMS 

 increased costs 

 management complexity 

 maintaining currency 

 vendor dependence 

 frequent upgrade/replacement cycles 

Data Base Administrator (DBA) 

He is a person responsible for the design and management of one or more databases and for the evaluation, 

selection and implementation of database management systems. In smaller organizations, the data 

administrator and database administrator are often one in the same; however, when they are different, the 

database administrator's function is more technical. The database administrator would implement the 

database software that meets the requirements outlined by the organization‘s data administrator and 

systems analysts.  His tasks might include controlling an organization‘s data resources, using data 

dictionary software to ensure data integrity and security, recovering corrupted data and eliminating data 

redundancy and uses tuning tools to improve database performance. 

 

Functions of DBA 

One of the main reasons for using DBMS is to have a central control of both data and the programs 

accessing those data. A person who has such control over the system is called a Database Administrator 

(DBA). The following are the functions of a Database administrator  

1. Schema Definition 

The Database Administrator creates the database schema by executing DDL statements.  Schema includes 

the logical structure of database table (Relation) like data types of attributes, length of attributes, 

integrity constraints etc.  

2. Storage structure and access method definition  

Database tables or indexes are stored in the following ways: Flat files, Heaps, B+ Tree etc..        

                        

3. Schema and physical organization modification 

The DBA carries out changes to the existing schema and physical organization. 

4. Granting authorization for data access 

The DBA provides different access rights to the users according to their level. Ordinary users might 

have highly restricted access to data, while you go up in the hierarchy to the administrator, you will get 

more access rights. 

5. Routine Maintenance 

 Some of the routine maintenance activities of a DBA include; taking backup of database periodically. 

Ensuring enough disk space is available all the time. Monitoring jobs running on the database. Ensure 

that performance is not degraded by some expensive task. Performance tuning etc., 

http://dictionary.reference.com/browse/databases
http://dictionary.reference.com/browse/database+management+systems
http://dictionary.reference.com/browse/systems+analysts
http://dictionary.reference.com/browse/data+dictionary
http://dictionary.reference.com/browse/data+dictionary
http://dictionary.reference.com/browse/data+integrity
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Database architecture  

There are three basic ways of organizing data in database. They are; 

1. Hierarchical structure 

The records or aggregates‘ of data are logically conceived to be stored at different levels of 

hierarchy. Relations between records form a hierarchy. One record can be linked only one record. 

So it is one-to-one relationship (parent-child) 

2. Network structure 

This structure can represent more complex logical relationship. This structure permits multiple 

relationships between data items. Any data element can be linked to any other data element so it is 

many-to -many relationships 

3. Relational structure  

Relational structure is most recent of these three structures. All data element stored in the database 

are conceived to be stored in tables. Different data tables are linked up using common type of data 

item in different tables. The table is called relation, the columns of table are called as domains and 

the rows are called tuples 

Relational database management system (RDBMS) 

A relational database management system (RDBMS) is a database management system (DBMS) that is 

based on the relational model as introduced by E. F. Codd. Most popular databases currently in use are 

based on the relational database model. 

Definition of an RDBMS is: a DBMS in which data is stored in tables and the relationships among the data 

are also stored in tables. The data can be accessed or reassembled in many different ways without having to 

change the table forms. 

Popular Relational Database Packages 

In order to suit to the requirements of the users there are nearly 100 of RDBMS soft ware‘s developed by 

various corporations are readily available. Examples of currently available soft wares are - 4th Dimension, 

Adabas D,    Black Ray, CA-Data com, Clarion, Clustrix, CSQL,  ,  DataEase   IBM DB2 Express-C   

Infobright, Mckoi SQL Database, Microsoft Access, Microsoft Jet Database Engine (part of Microsoft 

Access, Microsoft SQL Server, Microsoft SQL Server Express, SQLBase,  SQLite.,Sybase Adaptive 

Server Enterprise.,  XSPRADA, Zoduna Data Store (Designed for mobile platform) etc., 

Following are the important popularly used current RDBMS packages 

Microsoft SQL Server 

Microsoft SQL Server is a relational database server, developed by Microsoft: It is a software product 

whose primary function is to store and retrieve data as requested by other software applications, be it those 

on the same computer or those running on another computer across a network (including the Internet). 

There are at least a dozen different editions of Microsoft SQL Server aimed at different audiences and for 

different workloads (ranging from small applications that store and retrieve data on the same computer, to 

millions of users and computers that access huge amounts of data from the Internet at the same time). 

Oracle Database 

The Oracle Database (commonly referred to as Oracle RDBMS or simply as Oracle) is an object-relational 

database management system (ORDBMS) produced and marketed by Corporation. An Oracle database 

system—identified by an alphanumeric system identifier or SID comprises at least one instance of the 

application, along with data storage. An instance—identified persistently by an instantiation number (or 

activation id: SYS.V_$DATABASE.ACTIVATION#)—comprises a set of operating-system processes and 

memory-structures that interact with the storage. Typical processes include PMON (the process monitor) 

and SMON (the system monitor).The Oracle RDBMS stores data logically in the form of table spaces and 

physically in the form of data files ("data files").Table spaces can contain various types of memory 

segments, such as Data Segments, Index Segments, etc. Segments in turn comprise one or more extents. 
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Extents comprise groups of contiguous data blocks. Data blocks from the basic units of data storage. There 

is also a partitioning feature available on newer versions of the database, which allows tables to be 

partitioned based on different set of keys. Specific partitions can then be easily added or dropped to help 

manage large data sets. 

Microsoft Office Access 

Microsoft Office Access, previously known as Microsoft Access, is a relational database management 

system from Microsoft that combines the relational Microsoft Jet Database Engine with a graphical user 

interface and software-development tools. MS Access is detail is given in next chapter 

Database Security and security measures 

          Database security concerns the use of a broad range of information security controls to protect 

databases (potentially including the data, the database applications or stored functions, the database 

systems, the database servers and the associated network links) against compromises of their 

confidentiality, integrity and availability. It involves various types or categories of controls, such as 

technical, procedural/administrative and physical. Database security is a specialist topic within the broader 

realms of computer security, information security and risk management. 

Security risks to database systems include, for example: 

 Unauthorized or unintended activity or misuse by authorized database users, database 

administrators, or network/systems managers, or by unauthorized users or hackers (e.g. 

inappropriate access to sensitive data, metadata or functions within databases, or inappropriate 

changes to the database programs, structures or security configurations); 

 Malware infections causing incidents such as unauthorized access, leakage or disclosure of personal 

or proprietary data, deletion of or damage to the data or programs, interruption or denial of 

authorized access to the database, attacks on other systems and the unanticipated failure of database 

services; 

 Overloads, performance constraints and capacity issues resulting in the inability of authorized users 

to use databases as intended; 

 Physical damage to database servers caused by computer room fires or floods, overheating, 

lightning, accidental liquid spills, static discharge, electronic breakdowns/equipment failures and 

obsolescence; 

 Design flaws and programming bugs in databases and the associated programs and systems, 

creating various security vulnerabilities (e.g. unauthorized privilege escalation), data 

loss/corruption, performance degradation etc.; 

 Data corruption and/or loss caused by the entry of invalid data or commands, mistakes in database 

or system administration processes, sabotage/criminal damage etc. 

Types of information security control are appropriate to databases, including: 

 Access control- access control includes authentication, authorization and audit. It also includes 

measures such as physical devices, including biometric scans and metal locks, hidden paths, digital 

signatures, encryption, social barriers, and monitoring by humans and automated system 

 Auditing-the purposes of an IT audit are to evaluate the system's internal control design and 

effectiveness. This includes, but is not limited to, efficiency and security protocols, development 

processes, and IT governance or oversight. IT audits are also known as "automated data processing 

(ADP) audits" and "computer audits". They were formerly called "electronic data processing (EDP) 

audits" 

 Authentication-A computer system that is supposed to be used only by those authorized must 

attempt to detect and exclude the unauthorized. Access to it is therefore usually controlled by 

insisting on an authentication procedure to establish with some degree of confidence the identity of 

the user, granting privileges established for that identity 
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 Encryption-encryption is the process of transforming information (referred to as plaintext) using an 

algorithm (called a cipher) to make it unreadable to anyone except those possessing special 

knowledge, usually referred to as a key. The result of the process is encrypted information (in 

cryptography, referred to as cipher text). The reverse process, i.e. to make the encrypted 

information readable again is referred to as decryption, (i.e. to make it unencrypted). 

  Integrity controls- Integrity control means keeping the data consistent and correct by means of 

controls that a database administrator puts on the database. Only persons with privileged accounts 

can load data into the database. Even with that, there are rules on the table fields that allow only a 

certain type of data to be inserted. 

 Backups-In information technology, a backup or the process of backing up is making copies of data 

which may be used to restore the original after a data loss . Primary purpose of back up is to recover 

data after its loss, be it by data deletion or corruption. Data loss is a very common experience of 

computer users. The secondary purpose of backups is to recover data from an earlier time, 

according to a user-defined data retention policy, typically configured within a backup application 

for how long copies of data are required. 

 Application security- purpose of application security includes:  

a) Knowing your threats. 

b) Securing the network, host and application. 

c) Incorporating security into your software development process 

Digital signature and Digital certificate- Digital signatures are commonly used for software distribution, 

financial transactions, and in other cases where it is important to detect forgery or tampering. A digital 

signature or digital signature scheme is a mathematical scheme for demonstrating the authenticity of a 

digital message or document. A valid digital signature gives a recipient reason to believe that the message 

was created by a known sender, and that it was not altered in transit. a public key certificate (also known as 

a digital certificate or identity certificate) is an electronic document which uses a digital signature to bind a 

public key with an identity — information such as the name of a person or an organization, their address, 

and so forth. The certificate can be used to verify that a public key belongs to an individual. 

Microsoft Access 

           Microsoft Access is a database package. It is an important part of MS Office. It is a relational 

database application. A database is an organized collection of records. Telephone and address books are 

examples of paper databases. With Access, you can create a computerized database. For example, you can 

use Access to organize the students who attend a school, the courses they take, and the instructors who 

teach them. After you create an Access database, you can search it, manipulate it, and extract information 

from it. Table is the basic unit of recording data in Access. 

To start Access 

You use windows to interact with Access. To begin, start Access 2007. You screen will look similar to the 

one shown here. 
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The Microsoft Office Button 

 
In the upper-left corner of the Access window is the Microsoft Office button. When you click the button, a 

menu appears. You can use the menu to create a new file, open an existing file, save a file, and perform 

many other tasks. 

The Quick Access Toolbar 

 
Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar provides you 

with access to commands you frequently use. By default, Save, Undo, and Redo appear on the Quick 

Access toolbar. You use Save to save an object, Undo to roll back an action you have taken, and Redo to 

reapply an action you have rolled back. 

The Title Bar 

 
The Title bar is located at the top in the center of the Access window. The Title bar displays the name of 

the database on which you are currently working. 

The Ribbon 

 
 In Access 2007, you use the Ribbon to issue commands. The Ribbon is located near the top of the Access 

window, below the Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab displays 

related command groups. Within each group there are related command buttons. You click buttons to issue 

commands or to access menus and dialog boxes. You may also find a dialog box launcher in the bottom-

right corner of a group. When you click the dialog box launcher , a dialog box makes additional 

commands available. 
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Access Objects 

 
 You click the double down-arrows  to view objects. The double down-arrows change to double 

up-arrows . 

 You click the double up-arrows  to hide objects. The double up-arrows change to double down-

arrows . 

 

Objects 

Tables In Access, data is stored in tables. A table is a set of columns and rows, with each column 

referred to as a field. Each value in a field represents a single type of data. Each row of a 

table is referred to as a record. 

Queries You use queries to retrieve specific data from your database and to answer questions 

about your data. For example, you can use a query to find the names of the employees in 

your database who live in a particular state. 

Forms Forms give you the ability to choose the format and arrangement of fields. You can use a 

form to enter, edit, and display data. 

Reports Reports organize or summarize your data so you can print it or view it onscreen. You 

often use reports when you want to analyze your data or present your data to others. 

Macros Macros give you the ability to automate tasks. You can use a macro to add functionality 

to a form, report, or control. 

Modules Like macros, modules give you the ability to automate tasks and add functionality to a 

form, report, or control. Macros are created by choosing from a list of macro actions, 

whereas modules are written in Visual Basic for Applications. 

 

You double-click an object to open the object. Objects that are open appear on tabs. Right-click a tab to 

view a menu of options you can perform, such as save the object, close the object, or change the view. 

Change Views 

 
A view is a way of looking at an object. For example, in Access, data is stored in tables. Two of the 

possible ways you can view a table are Datasheet view and Design view. You can see the data contained in 

a table in Datasheet view. You can see the design of a table in Design view. When you open an object, 

buttons appear in the lower-right corner of the Access window. You can use the View button on the Home 

tab to change views, or you can click the proper button in the lower-right corner of the window. 

Close a Database and Exit Access 

This completes the introduction to Access using the Northwind database. The following describes how you 

close a database and exit Access. 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/01_access.html
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To close a database: 

1. Click the Microsoft Office button. A menu appears. 

2. Click Close Database. Access closes the database. 

To exit Access: 

1. Click the Microsoft Office button. A menu appears. 

2. Click Exit Access. You exit Access. 

Create a Database 

      When you start Access, the Getting Started with Microsoft Office Access screen appears. You can use 

this screen to create a database. Within a database, you can do such things as enter data, create reports, and 

retrieve data. You can create a blank database or you can use one of the templates provided by Microsoft. 

When you use a template, Access creates forms you can use to enter data, reports you can use to retrieve 

data, and more. You can modify the forms, reports, and other objects to suit your needs. The following 

templates are included with Access: Assets, Contacts, Events, Faculty, Issues, Marketing Projects, Projects, 

Sales Pipeline, Students, and Tasks. Other templates are available online. Each template creates a database 

related to the title. For example, the Faculty template creates a faculty database that includes tables, 

queries, forms, and reports related to faculty. In Access, you use tables to store data, queries to retrieve 

data, forms to enter data, and reports to display data. 

To use a template to create a database: 

 

 

1. Start Access. The Getting Started with Microsoft Office Access screen appears. 

2. Click Local Templates. Icons representing local templates appear in the center of the window. 

3. Click the icon for the template you want to use. 

4. Click the Browse button. The File New Database window appears. 

5. Locate the folder in which you want to store your database. 

6. Click OK. 

7. Click Create. Access creates and opens your database.          

8. Open the Navigation pane. Access displays the tables, queries, forms, reports and other objects 

related to the database you selected. You may wish to display the objects by type.  
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  Opening an existing database 

1. Click the Office button. A menu appears. 

2. Click Open. 

3. Locate the folder in which you stored your database. 

4. Click the database name. 

5. Click Open. Access opens the database. 

 We can also open an existing database by pressing Ctrl-O and then following steps 3 through 5 

Create a Blank Database 

A blank database is a database with nothing in it. You must create all the tables, forms, reports, queries, 

and so on. If you cannot find a template that suits your needs, create a blank database. After you create the 

database, Access opens to a datasheet and makes available the tools you need to create objects. Creating 

tables is the first step in building a database. You will learn more about creating tables in the next lesson. 

 

 

1. Start Access. 

2. Click Blank Database. 

3. Type the name you want to give your database in the File Name field. Access will automatically 

append .accdb to the name. 

4. Click the Browse button. The File New Database window appears. 

5. Locate the folder in which you want to store your database. Note that the name of the file appears in 

the File Name field. 

6. Click OK. 

7. Click the Create button. Access creates the database and opens a datasheet with the Table Tools 

available to you. 

Datasheet 

In Access, data is stored in tables. A datasheet displays the information stored in a table in columns and 

rows. The columns are called fields and the rows are called records. You can use a datasheet to create a 

table, enter data, retrieve data, and perform other tasks. 
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Creating Microsoft Access Tables 

Tables are the foundation of an Access database. Access stores data in tables. This lesson teaches you how 

to create a table, add fields to a table, assign data types to fields, and set field properties. 

Understanding Tables 

A table is a set of columns and rows. Each column is called a field. Within a table, each field must be given 

a name and no two fields can have the same name. Each value in a field represents a single category of 

data. For example, a table might have three fields: Last Name, First Name, and Phone Number.  

 
    After Access creates a blank database, it opens in Datasheet view and makes available the tools you need 

to create a table. Datasheet view displays a table as a set of columns and rows. When you view a blank 

database for the first time in Datasheet view, you see a column named ID. This column is by default the 

primary key field. 

A primary key is a field or combination of fields that uniquely identify each record in a table. No two 

records in a table should have the same values in every field. For example, the following should not occur 

in a table. 

Last Name First Name City 

Saju Ravi Calicut 

Saju Ravi Calicut 

In cases like this, you can use the ID field as the primary key field and use it to make each record unique. 

The ID field has a data type of AutoNumber; as a result, Access automatically creates a unique number for 

each record in the database. The resulting table will look like the one shown here. 

ID Last Name First Name City 

1 Saju Ravi Calicut 

2 Saju Ravi Calicut 

   When you save your table for the first time, Access gives you the opportunity to name your table. Each 

table name must be unique; hence, two tables in the same database cannot have the same name. The table 

name should describe the data in the table; can consist of letters, numbers, and spaces; and can be up to 64 

characters long. When choosing a table name, try to keep it short.  

You can save a table by clicking the Save button on the Quick Access toolbar or by right-clicking the 

Tables tab and then choosing ‗save‘ from the menu that appears. 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/02_access.html
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To add fields to a table: 

 
1. Click the Add New Field column label. 

2. Activate the Datasheet tab. 

3. Click Rename in the Fields & Columns group. 

4. Type the field name. 

5. Press Enter. Access creates the field. 

6. Type the next field name. Access creates the field. Continue until you have created all of the fields 

in your table.  

7. Press Enter without entering a field name to end your entries.     Or 

1. Right-click the Add New Field column label. A menu appears. 

2. Click Rename Column. 

3. Type the field name. 

4. Press Enter. Access creates the field. 

5. Type the next field name. Access creates the field. Continue until you have created all of the fields 

in your table. 

Name and Save a Table 

After you create a table, you must name and save it. 

To name and save a table: 

 
1. Click the Save button on the Quick Access toolbar. The Save As dialog box appears. 

2. Type the name you want to give your table. 

3. Click OK. Access names your table. 

.Understanding Data Types 

In Access, you use data types to specify the type of data each field can capture. A field with a data type of 

text can store alphabetic characters and numbers. Generally speaking, you cannot perform mathematical 

calculations by using a text field. For example, you can use a text field to store a House address. Unless 

you do some manipulation, you cannot use the numbers in the street address in mathematical calculations. 

The following list summarizes all the field data types available in Microsoft Access, their uses, and their 

storage sizes. 
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Text -Use for text or combinations of text and numbers, such as addresses, or for numbers that do not 

require calculations, such as phone numbers, part numbers, or postal codes. Stores up to 255 characters.  

Memo -Use for lengthy text and numbers, such as notes or descriptions. Stores up to 65,536 characters.  

Number -Use for data to be included in mathematical calculations, except calculations involving money 

(use Currency type).  

Date/Time -Use for dates and times. Stores 8 bytes.  

Currency -Use for currency values and to prevent rounding off during calculations. Stores 8 bytes.  

AutoNumber-Use for unique sequential (incrementing by 1) or random numbers that are automatically 

inserted when a record is added. Stores 4 bytes 

Yes/No -Use for data that can be only one of two possible values, such as Yes/No, True/False, On/Off. 

Null values are not allowed. Stores 1 bit.  

OLE Object -Use for OLE objects (such as Microsoft Word documents, Microsoft Excel spreadsheets, 

pictures, sounds, or other binary data) that were created in other programs using the OLE protocol. Stores 

up to 1 gigabyte (limited by disk space).  

Hyperlink -Use for hyperlinks. A hyperlink can be a UNC path or a URL. Stores up to 64,000 characters.  

Views 

Views are different ways of looking at the same object. Tables have four views:  

Datasheet view - to create a table, edit data, or view data 

Pivot Table view - to create a pivot table 

 Pivot Chart view- to create a pivot chart 

Design view - to create a table or modify an existing table. 

Design View 

Access provides several ways to view the objects in your database. You can use Design view to create or 

modify an Access table. You can use the View button on the Home tab or the Table Design button on the 

Create tab to change to Design view.  

To use Design view to create a new table: 

 
1. Activate the Create tab. 

2. Click Table Design in the Tables group. Access changes to Design view and the Table Tools 

become available. 

 
3. Type the first field name in the Field Name field. 

4. Press the Tab key. 

5. Click the down-arrow that appears when you click in the Data Type field and then select a data 

type. 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/02_access.html
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6. Click Primary Key if the column you created is a primary key. A small key appears next to the field 

name. 

7. Press the Tab key. 

8. Type a description. The description is optional. 

9. Press the Tab key. Access moves to the Field Name field. 

10. Repeat steps 3 through 10 until you have created all of your fields. 

To set field properties: 

 

 

 

1. Click the field for which you want to set the field properties. 

2. Activate the General tab in the Field Properties area. 

3. Set the properties you want to set. 

4. Repeat steps 1 through 3 until you have set all the properties for all fields. 

.To change the view: 

1. Activate the Home tab. 

2. Click the down-arrow under the View button. A menu appears. 

3. Click the view you want. Access changes to the view you chose. 

Create Relationships 

In Access, you store data in multiple tables and then use relationships to join the tables. After you have 

created relationships, you can use data from all of the related tables in a query, form, or report. 

Primary key and foreign key 

A primary key is a field or combination of fields that uniquely identify each record in a table. A foreign 

key is a value in one table that must match the primary key in another table. You use primary keys and 

foreign keys to join tables together—in other words, you use primary keys and foreign keys to create 

relationships. 
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There are two valid types of relationships: one-to-one and one-to-many. In a one-to-one relationship, for 

every occurrence of a value in table A, there can only be one matching occurrence of that value in table B, 

and for every occurrence of a value in table B, there can only be one matching occurrence of that value in 

table A. In a one-to-many relationship, for every occurrence of a value in table A, there can be zero or 

more matching occurrences in table B, and for every one occurrence in table B, there can only be one 

matching occurrence in table A. 

When tables have a one-to-many relationship, the table with the one value is called the primary table and 

the table with the many values is called the related table. Referential integrity ensures that the validity of 

the relationship between two tables remains intact. It prohibits changes to the primary table that would 

invalidate an entry in the related table. For example, a school has students. Each student can make several 

payments, but each payment can only be from one student. The Students table is the primary table and the 

Payments table is the related table. 

Students  

Student ID Last Name Place 

Primary Key   

1 Raja Vatakara 

2 Manu Quilandy 

3 Vijay Kozhikode 

         

Payments  

Payment ID Student ID  Amount Due Amount Paid 

Primary key Foreign key   

1 1 500 500 

2 2 700 300 

3 3 500 250 

4 2 400 300 

5 3 250 250 

If you delete Student ID 1 from the Students table, Student ID 1 is no longer valid in the Payments table. 

Referential integrity prevents you from deleting Student ID 1 from the Students table. Also, if the only 

valid Student IDs are 1, 2, and 3, referential integrity prevents you from entering a value of 4 in the Student 

ID field in the Payments table. A foreign key without a primary key reference is called an orphan. 

Referential integrity prevents you from creating orphans. 

To create relationships: 

1. Close all tables and forms. (Right-click on the tab of any Object. A menu appears. Click Close All.) 

 
2. Activate the Database Tools tab. 

3. Click the Relationships button in the Show/Hide group. The Relationships window appears. 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/04_access.html
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4. If anything appears in the relationships window, click the Clear Layout button in the Tools group. If 

you are prompted, click Yes. 

5. Click the Show Table button in the Relationships group. The Show Table dialog box appears. 

 
6. Activate the Tables tab if your relationships will be based on tables, activate the Queries tab if your 

relationships will be based on queries, or activate the Both tab if your relationships will be based on 

both. 

7. Double-click each table or query you want to use to build a relationship. The tables appear in the 

Relationships window. 

8. Click the Close button to close the Show Table dialog box. 

 
9. Drag the Primary table‘s primary key over the related table‘s foreign key. After you drag the 

primary key to the related table‘s box, the cursor changes to an arrow. Make sure the arrow points 

to the foreign key. The Edit Relationships Dialog box appears. 
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10. Click the Enforce Referential Integrity checkbox. 

11. Click Create. Access creates a one-to-many relationship between the tables. 

 
12. Click the Save button on the Quick Access toolbar to save the relationship  

 Creating Microsoft Access Queries 

Queries are very useful tools when it comes to databases and they are often called by the user through a 

form. They can be used to search for and grab data from one or more of your tables, perform certain actions 

on the database and even carryout a variety of calculations depending on your needs. 

 Microsoft Access allows for many types of queries, some of the main ones being select, action, parameter 

and aggregate queries. They can be thought of as just another part of your database – essentially an object 

like a table or a macro. 

When it comes time to build a query for your database, you have two ways to go about creating it. 

1. Either use the Query Wizard that Microsoft Access provides for you, or 

2. Create your own queries from scratch. 

Query types: 

Select Query 

The select query is the simplest type of query and because of that, it is also the most commonly used one in 

Microsoft Access databases. It can be used to select and display data from either one table or a series of 

them depending on what is needed. It is the user-determined criteria that tell the database what the selection 

is to be based on. After the select query is called, it creates a "virtual" table where the data can be changed, 

but at no more than one record at a time. 

Action Query 

When the action query is called, the database undergoes a specific action depending on what was specified 

in the query itself. This can include such things as creating new tables, deleting rows from existing ones 

and updating records or creating entirely new ones.Action queries are very popular in data management 

because they allow for many records to be changed at one time instead of only single records like in a 

select query. 

Four kinds of action queries are: 

1. Append Query – takes the set results of a query and "appends" (or adds) them to an existing table. 

2. Delete Query – deletes all records in an underlying table from the set results of a query.  

3. Make Table Query – as the name suggests, it creates a table based on the set results of a query. 

4. Update Query – allows for one or more field in your table to be updated. 

Parameter Query 

In Microsoft Access, a parameter query works with other types of queries to get whatever results you are 

after. when using this type of query, you are able to pass a parameter to a different query, such as an action 

or a select query. It can either be a value or a condition and will essentially tell the other query specifically 

what you want it to do. 

http://www.databasedev.co.uk/append_query.html
http://www.databasedev.co.uk/delete_query.html
http://www.databasedev.co.uk/make-table-query.html
http://www.databasedev.co.uk/update_query.html
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Aggregate Query 

A special type of query is known as an aggregate query. It can work on other queries (such as selection, 

action or parameter) just like the parameter query does, but instead of passing a parameter to another query 

it totals up the items by selected groups. 

Designing and running queries 

Following are the steps for designing queries in MS Access 

1.  Open the Query Design Grid 

The first stage is to select the CREATE TAB and then go to the OTHER group on the far right of the 

ribbon. Then click on the QUERY DESIGN ICON to bring up the query design grid.  

 
2.  Select Table for Query 

The next stage is to select which table you are going to use in this query. When the query design grid 

opened, the SHOW TABLE pop up window should also have opened. If necessary you can open this 

window manually by clicking the SHOW TABLE icon in the QUERY SET UP group on the Access 

Ribbon. 

 
Suppose  there is only one table in your database - TABLE1. This should be highlighted when the window 

opens, but if not, just click on it once. Next click ADD. When you close the pop-up window by clicking x, 

you should see a box labeled TABLE1 above the query design grid. 

3. Select fields from Table 

In the table1 box, you will see a list of its field names. We are going to use all the fields in this query, so 

select each one individually by double clicking on their names. You will now see the field names at the top 

of each column in the Query Design Grid. 

 

http://www.databasedev.co.uk/aggregate_functions.html
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4. Enter query criteria 

As you may remember, the purpose of our query is to extract records where the persons name is greater 

than or equal to 35. To do this we enter the criteria into the appropriate cell of the query design grid. In this 

case you need to go to the AGE column of the CRITERIA row, and enter the formula >=35. 

 
 

5. Save and Run Query 

Click the save icon above the Access Ribbon. When prompted for the query name, just use the default 

QUERY1. To run your query, click the RUN icon in the RESULTS GROUP of the Access Ribbon. You 

should now be presented with a datasheet displaying your query results - JOHN JONES 35 and JOE 

BROWN 39. 

 
Now we have created and run query.  

 

 Creating Reports 

Reports organize and summarize data for viewing online or for printing. A detail report displays all of the 

selected records. You can include summary data such as totals, counts, and percentages in a detail report. A 

summary report does not list the selected records but instead summarizes the data and presents totals, 

counts, percentages, or other summary data only. Access has several report generation tools that you can 

use to create both detail and summary reports quickly. This lesson teaches you how to create reports. 

Use the Report Button 

The Report button creates a simple report that lists the records in the selected table or query in a columnar 

format. 

 

By using the Report button: 

 
1. Open the Navigation pane. 

2. Click the table or query on which you want to base your report. 

3. Activate the Create tab. 

4. Click the Report button in the Reports group. Access creates your report and displays your report in 

Layout view. You can modify the report. 

file:///C:/Documents%20and%20Settings/Shiji/My%20Documents/Downloads/07_access.html
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: After you create a report, you can save it. 

1. Click the Save button on the Quick Access toolbar. Access saves the report unless you are saving 

for the first time. If you are saving for the first time, the Save As dialog box appears. 

2. Type the name you want to give your report. 

3. Click OK. Access saves the report. You can now access the report by using the Navigation pane. 

Use the Report Wizard 

You can also use the Report Wizard to create a report. The Report Wizard provides you with more 

flexibility than you get by using the Report button. You can choose the tables and fields, group the data, 

sort the data, summarize the data, choose a layout and orientation, apply a style, and title your report. 

Follow the steps shown here to create a report by using the Report Wizard: 

 Create a report by using the Report Wizard: 

Open the Report Wizard 

 
1. Activate the Create tab. 

2. Click Report Wizard in the Reports group. The Report Wizard appears. 

Select tables, queries and fields 

When using the Report Wizard, you can use fields from multiple tables and/or queries if the tables/queries 

have a relationship. 

1. Click the down-arrow next to the Table/Queries field and then click the table from which you 

want to select fields. 

2. Click a field and then click the single-right arrow to select a single field, click the double-right 

arrows to select all fields, click a field and then click the single-left arrow to deselect a single 

field, or click the double-left arrow to deselect all fields. 

3. Repeat steps 1 and 2 for each table from which you want to select fields. 

4. Click Next. The Report Wizard moves to the next page 

 
. 

By using report wizard we can format and modify report in Access. 
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A. Group 

When using the Report Wizard, you can group data. For example, if your data is grouped by the 

Department field and the records in the Department field have values such as Administration, Computer 

Science, and English. Access will group all of the data for the Administration department together, all of 

the data for the Computer Science department together, and all of the data for the English department 

together. 

B. Sort and summarize 

By using the Report Wizard, you can create up to four levels of sort. Access sorts the first level, and then 

sorts the second level within that sort, and so on. If you have grouped your data, you can summarize it by 

displaying the sum, average, and minimum or maximum value for each numeric field 

C.  Layout and orientation 

You can choose the layout and orientation of your report.  

D. .Style 

A style is a set of formats consisting of such things as background colors, fonts, font colors, and font sizes. 

Access supplies predesigned styles that format titles, labels, and more. When you choose a style, the left 

side of the window displays a preview. 

1. Click to select a style. 

2. Click Next. The Report Wizard moves to the next page. 

E.   Create a title 

On the final page of the Report Wizard, you can title your report. The title appears at the top of the report 

and on the Navigation pane. 

1. Type the title you want to give the report. 

2. Click Finish. Access creates, saves, and opens your report in Layout view. 

F. Printing of report 

Print a Report 

Often, the people who use Access data only see a printed report. In Print Preview, you can see exactly how 

your report will look when printed, you can make changes to it, and you can print it. To print, click the 

Print button in the Print group. The Print dialog box opens and you can select your print options. 

To change to print Preview: 

1. Open your report. 

2. Activate the Home tab. 

3. Click the down-arrow under the View button. A menu appears. 

4. Click Print Preview. Access changes to Print Preview. 

Questions 

1. What is database system? What are its features? 

2. What is DBMS? Explain its components and advantages? 

3. Who is DBA? What are his functions? 

4. Discuss types of database architecture? 

5. Discuss database security and security measures? 

6. What is MS Access? What is its use? 

7. How do you create a table in MS Access? 

8. What is RDBMS? And how to you create relationship? 

9. Describe the steps for designing simple Query? 

10. Discuss various types of queries in MS Access? 

11. How do you create and print report in Access? 

12. Explain the terms-primary key, foreign key and referential integrity. 
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Module- 4 
INTERNET 

 The Internet is a worldwide network of networks. The Internet, sometimes called simply ―the Net,‖ 

is a universal system of computer networks. It is a configuration of smaller networks and other connected 

machines spanning the entire globe. Around the world, each country has at least one backbone network that 

operates network that operates at very high speed and carries the bulk of the traffic. Other smaller 

Networks connect to that backbone. 

 The Internet, a global system of connected computers, was once available only to the government, 

academic, and research communities. Now the greatly publicized   information superhighway is accessible 

to anyone with time, interest, and curiosity .Information on the internet and opportunities to use it are 

growing at a phenomenal rate. The last decade has witnessed an explosion of internet activity. Many of 

these users are in Corporation, Universities, and Government Institution . But the number of users 

connecting from home also continues to grow dramatically   

 Development of Internet  

 In 1969, the American defense Department wanted to connect all the computers in the department offices 

and military research institutions. When it was connected, the network was called ARPANET (Advanced 

Research Project Agency network).It also included many universities doing military funded research. Later 

the span of this network expanded covering the whole of USA.As it was very successful, various research 

institution and universities wanted to get connect themselves with the ARPANET. 

 Hence, the defense wanted to preserve its privacy and thereby, divided the network in to two 

divisions, viz, ARPANET ad MILNET (Military Network). These two divisions are connected with a 

technology called network protocol. Protocol means, a set of communication rules.  In the network protocol 

means a set of rules to contact a person on the network. Hence we need a protocol to connect a person on 

the other networks. The protocol in- between the networks is called internet protocols. Thus, internet 

protocol is a technical switching scheme, which enables a node of network to communicate. With anode of 

another network. To control and monitor the network communications, the department of defense 

redesigned the existing protocol and protocols Transmission Control protocol/ Internet protocol (TCP\IP) 

were developed.  

At this stage, the ―American National Foundation ―developed another network of computers in 

USA. In this new network all universities and research institution were allowed to join in to and provide 

their contribution in the development of super computer. 

In early 1990, many institution turn to‖ American National Foundation`s ―network and as a result 

ARPANET was shutdown. During 1994 many privet organization introduced global networks. They 

designed protocols and communicate between the nodes of different networks. This network is called 

internet. 

 

Definition  

 

“INTERNET” refers to the global information system that- 

i) Is logically linked together by a globally unique address space based on the  Internet protocol (IP) 

or its subsequent extension /follow –on: 

ii) Is able to support communications using the transmission Control protocol / Internet protocol 

(TCP/IP)suite  its subsequent extension /follow –ones ,and/ or other IP compatible protocols; 

and  

iii) Provides, uses or make accessible either publicly or privately .high level service layered on the 

communication and related infrastructure described therein. 
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       Today the internet is a public, cooperative, and self-sustaining facility accessible to thousand of 

millions of people worldwide. Physically, the Internet uses a portion   of the total resources of the currently 

existing public telecommunication networks. Technically, what distinguishes the internet is its use of asset 

of protocols called TCP/IP) for Transmission Control protocol / Internet protocol). 

 

HOW INFORMATION TRAVELS ACROSS THE INTERNET  

 The internet comprises network that are attached to one another via pathway that facilitate the exchange of 

information, data and files. Being connected to the internet means having access to these pathway. The 

computer sends information over this pathway to any other computer connected to the Internet.  The 

information or data that is being sent over the Internet must be broken up in to small packets. Each of these 

packets is given a header that contains a variety of information, such as the order in which the packets 

should be assembled with other related packets, the address of the destination, etc. 

 

 So when one sends information across the Internet, the information is first broken down into 

packets these are then delivered to the proper destinations. Where is they are reassembled into their 

Original form so that receiving computer can use them. This job is done by the two most important 

communication protocols on the Internet – the Transmission Control Protocol (TCP) and Internet 

protocol (IP). They are frequently referred to as TCP/IP.TCP breaks and reassembles the packets, 

whereas, IP is responsible for ensuring the packets are sent to the right destination. 

 

INTERNET ADDRESS  

 To do just about anything on the Internet one need to understand internet address. The internet protocol 

(IP) uses internet address information to deliver mail and other data from computer to computer. Every IP 

address on the internet is actually a series of four numbers separated   by dots, such as 163.52.128.72. 

However, it would be difficult for one to remember such numeric addresses when one want to access 

something on the net .And also numeric IP addresses something change. So to overcome this problem Sun 

Microsystems developed Domain Name Server (DNS). The DNS establishes a hierarchy of domains, 

which are group of computers on the internet. The DNS give each computer on the Internet and Internet 

address, or domain name, using letter and words instead of numbers. 

 

 DNS address has two parts: an individual name, followed by a domain (a name for a computer 

connected to the internet) that generally identifies the type of institution that uses the address such as .com 

for commercial business or .edu for school, college and universities. For example, DNS address of 

Microsoft is microsoft.com. 

 

 DNS address and numeric IP address identify individual computers, but a single computer might 

have separate users, each of whom must have an account. When a person sends a message to another 

person rather than a computer, than the recipient`s user name must be included in the address. The standard 

format is the user name first, separated from the DNS address (Which identifies the specific computer 

where the person has an Interne e-mail account) by an‖at‖ symbol (@).For example, a person named xyz 

would have e-mail address has xyz@widgets.com. 

 

CLIENTS AND SERVERS  

The basic architecture of all Internet connection is based on client –server relationship. A client application 

on user`s computer requests information from a server already connected to the Internet. A server is a 

powerful computer, generally containing a large hard disk, which acts as a shared storage resource. In 

addition to containing stored files, a server my also allow access to program and data from other computer. 

mailto:xyz@widgets.com
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  To make this   relationship work there are major components: 

 Telecommunication connection- This connection is the physical electrical connection between 

your computer and the sever computer. This connection is used to pass requests and data between 

your computer and the server. 

 Server-The server in an Internet connection is usually a service provider or Internet access 

provider. The server provider is the company that owns and operates the particular network to 

which you are going to connect your computer. 

 Client –The  client in an internet connection is one or more software programs that run on your 

computer and interact directly with the server provider  or route their date request to and from the 

Internet  through the service  provider`s network 

INTERNET 

An enormous amount of information and entertainment is available on the Internet . To access this 

information various Internet tools are provided. These tools include: 

 Information Retrieval Tools(FTP and Gopher) 

 Communication Tools(E-mail, telnet ,Usenet  ) 

 Multimedia information Search  Tools(WAIS, Archie,  Veronica) 

INFORMATION RETRIEVAL TOOLS 

FTP 

   FTP or File transfer protocol is the Internet tool used to copy files from one computer to another. 

When the user has accounts on more than one computer. FTP can be used to transfer data or programs 

between them. It is basically a command that activates the client – server relationship. The user sends the 

request for a particular file to the server and server responds back by sending the requested file if the 

requested file is that found on that server  

Another popular way to retrieve file is through an anonymous file server. In this case, the user logs on to 

the server using the special user ID and the password. This server is called anonymous as it allows anyone 

to make copies of their files. Using FTP is simple. The only difficult part locating a file that one wants to 

download. 

Gopher    

The second type of information retrieval tool on the Internet is Gopher a menu based interface that 

provides access to information residing on special server, called Gopher server. Although, Gopher 

performs primarily the same tasks as FTP command, its interface is more user-friendly and it provides 

additional function, such as links to other Internet service. By selecting an item from the Gopher menu, 

users can move retrieve, or display files from remote sites .The menu   also allows user to move from one 

Gopher sit to another, where each site provides different information. 

 

COMMUNICATION TOOLS    

E-mail  

E-mail or Electronic mail refer to exchanging message or files electronically. Anyone with an e-mail 

account can send message to other users of the Internet. 

 E-mail systems have two basic part: user agents message transfer agent.. User agent allows people 

to read and send e-mail and message transfer agent move the message from the source to the destination. 

The user agents are generally local program that provide a command based, menu –based or graphical 

method for interacting with the e-mail system. E-mail. The message transfer agents run in the background 

and move e-mail though the system E-mail is not a live connection between the originator of the message   

and its recipient. There is always a delay between the time a massage is send and the time it arrives. This 

delay can be of few second and more  
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When one sends a message, your computer passes it to post office server. Which identifies the destination 

address and passes it though the Internet to a mail server, where a message is stored in a mailbox unit the 

recipient opens his/her mailbox. Figure 5.1 show how the mail is being sent and received .E-mail system 

support five basic function: 

 

 Composition: Process of creating message and answers.  

 Transfer: Moving message from the original to the recipient. 

 Reporting: Telling the originator what happened to the message. 

 Displaying: Incoming message are being displayed for the people to read. 

 Disposition: Concerns with what the recipient does with the message after receiving it. Possibilities 

include deleting it after reading or before reading, saving it and so on. 

 

In addition on these basic service ,most e-mail system provide a large variety of advanced features such as 

mailboxes (to store incoming mails),automatic notification of undelivered e-mail, facility to make carbon 

copies (cc) and blind  carbon copies (bcc)of mail, etc. 

 

 

 

 

 

 

 

 Fig.5.1 Sending and Receiving Mail  

 

 

 

 

 

 

 

 

 

Telnet 

Telnet is a command that connects the user to a remote machine may be located anywhere on the internet. 

In other word it is tool for using one computer to control a second computer. Using Telnet one can send 

command that run program and open text or data files on same computer The telnet program is basically a 

transparent window between your one computer and a computer that you are logging onto. 

 

Usenet   

The Usenet is a network that provides users with discussion groups forums. A user posts an article to a 

chose newsgroup on the Usenet, where each newsgroup id devoted to a particular topic such as politics, 

environment, surfing and so one. The article is routed only to those sites that have expressed an interest in 

receiving information on the topic .May find the Usenet to be helpful for gathering information on a variety 

of topics. Another popular application of Usenet is downloading new or upgraded software from vendors 

and obtaining quotes for products and services.  
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MULTIMEDIA INFORMATION TOOLS 

World Wide Web (WWW) 

World Wide Web or WWW I one of the newest and most popular hypertext –based Internet tools. It allows 

users to access and display document and graphics stored on any server on the Internet. Its capability to 

provide an enormous wealth of information on almost every conceivable subject in a graphical colorful 

way has led to its popularity.WWW is also based on client –server model. Here the client is the browser 

that runs on your local system. Web browser or browser is software that is used to request resources from 

the Internet. Some of the popular web browsers are Microsoft Internet Explorer, Netscape Navigator 

,Mosaic etc Server is a program that  runs somewhere on the Internet and is used to serve the resources that 

have been made available on the server .The main components of WWW are : 

 

 URL(Uniform Resource Locator): It is a way of specifying the location of web page on the net. 

URLs look like: 

Type://address/path  

Where type specifics the type of server in which the file is located address of the server and path is 

the location within the file structure of the server .For example, http://www.microsoft.com. 

 

 HTTP(Hyper Text Transfer Protocol):The internal structure  of the WWW is built on the set of 

rules called HTTP. It establishes the communication path between a web server and a client. The 

communication takes place in for steps: First the connection is established between the client and 

the server. Then the client sends some request like requesting some particular file. The server then 

responds by sending a message that the file is being found .If the file is not found on the server then 

an error message indicating that file is not found, is sent back and the connection is closed.   

 

 HTML(Hyper Text MARKUP Language):HTML is the language in which WWW documents 

are written in , it allows users to produce web pages that included text ,graphics ,and like to other 

pages . 

 

Unlink Gopher which organize information on the Internet into logical menu, the WWW does not 

provide a basic structure for locating resources. To overcome this, an assortment of directories and search 

tools is available online. 

 

INFORMATION SEARCH TOOLS   

Archie 

Archie is a search tool designed specifically to locate files on anonymous FTP servers. It creates a 

central index of all the files available on anonymous FTP sites and creates a central database that users can 

access to locate information. Uses who have ARCHIE software can access this database   The only 

disadvantage is that the use must know at least part of the filename in order to be able to search for the file. 

When the desired file is located. the server identifies the file`s address and the user can use the FTP 

command to access and retrieve the file. Though Archie is a very tool for locating files, not all anonymous 

FTP sites are included in the Archie database   

Veronica  

Veronica is a search tool specifically designed to locate all files on Gopher sites and it is listed 

under Other Gopher and Information Sever on the Gopher menu. Users who have access to a Gopher 

server and a veronica server can access the database. One of the biggest advantages of Veronica over 

Archie is that the user doesn`t have to know the filename. 

http://www.microsoft.com/
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WAIS 

WAIS (Wide area Information Server)is a search system that accesses servers all over the world to 

locate requested files. The WAIS database has an index of keyword that helps users to locate files. When 

given the keyword, WAIS returns the address where the file are located The user can them use one of the 

other services discussed above to download the files. If a particular file is not found on a given WAIS 

server, the server will automatically direct the query to other WAIS server on the Internet    

INTERNET PROTOCOL 

A communication protocol allows different kind of computer using different operating system to 

communicate with one another .It is high essential because Internet is not made up of any single type of 

computer system. Instead there are great diversities found in the computer used on the internet. The user 

connected on any network on the Internet can communicate with others or software. Locate on any other 

network connected to the internet using common set of protocols.  An Internet protocol is a set of standards 

or rules for exchanging information between computer systems in a network. The most commonly used 

protocols are: 

1. Transmission Control Protocol/ Internet Protocol(TCP/IP) 

2. File Transfer Protocol(FTP) 

3. Hyper Text transfer Protocol (HTTP) 

4. Telnet  

5. Gopher 

6. Wide Area Information Service(WAIS) 

 

                 1. Transmission Control Protocol/ Internet Protocol (TCP/IP) 

TCP/IP/ is actually a collection of protocols that govern the way travel from one computer to another 

computer across networks. A user connected on any network on the Internet can communicate with people 

or software locates on any other network connected to the internet using this common set of protocols, the 

TCP/IP. Thus any computer that speaks the language TCP/IP can talk to any internet machine 

On the Internet, the protocol that permits two internet connected computers to establish a reliable 

connection is called TCP/IP.TCP ensures reliable data delivery. The computer that sends the data continues 

to do so until it receives a confirmation from the receiving computer that the data has been received intact. 

Simply this is the set of standards (Protocols) for data transmission and error correction that allow the 

transfer of data from one computer to another computer over Internet  

2 File Transfer Protocol (FTP) 

FTP Is the protocol set of rules which enable files to be transferred between computers. It is a powerful tool 

which allows files to be transferred from one computer to another computer. 

FTP work on the client / server principle. A client program enables the user to interact with a server 

in order to access  information and service on the server computer. Files that can be transferred are store on 

server computer. A client can access these files only though a client application program helps a client 

computer to locate the required file to be transferred and start the process of transfer. 

To access other computer, user has to normally supply a login name and password and after that he 

can access  the computer file dictionary system and can upload (send)and download (receive) files 

.Anonymous FTP facilities are also available which allows the user to access any information without 

giving a password . Sometime an anonymous FTP site may ask for your electronic mail address as 

password. May web browsers can function as FTP client to download files from anonymous file archives. 

3.   Hyper Text transfer Protocol (HTTP) 

HTTP is can internet standard or set of rules that allows the exchange of information on the World Wide 

Web (WWW). Hyper text is an method of preparing and publishing text ideally suited to the computer, in 

which users can select their own text .To prepare hyper text, the whole material should be divided into 
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small segment such as single pages of text. These small segments are called nodes. Then hyper links (also 

called anchors) are embedded in the text .When the user clicks on a hyper link, the hypertext software 

display a different node. The process of navigating among the nodes linked in this way is called 

`browsing`. A collection of nodes that are interconnected by hyper links is called a web    

The World Wide Web (WWW) is a hyper text system on global scale. Hyper link enable the user to 

access document that have been linked with other document. Web document contain highlighted words/ 

phrases, and a click of the mouse on that spot will transport the user to another site. A hyper text is 

prepared using Hyper Text Markup Language (HTML). The HTML codes are used to create links  

HTML is also based on the client /server principle .It allows the client computer to contact with 

sever computer and make a request. The server accepts the connection requested by the client and sends 

back a response. An HTTP request identifies the information or text that the client is needed and it tell the 

server to supply the text. In short HTTP allows the user to jump from one to another according to his 

requirements 

           4. Telnet 

Telnet is an internet protocol of set of rules that enable internet users to connect to another 

computer linked to the internet .This process is also called as remote login. The user`s computer is referred 

to as the local computer and the computer being connected to is referred to as remote or host computer. 

One access is established between local and host computer. Local computer can give command so that they 

are executed in the host computer. 

The user`s computer clearly display the process undertaken by the remote computer during the 

telnet session. After getting connection to a remote computer, instruction or menus appear. Sometimes the 

user has to give his own user name or password .However, much information such as library catalogues are 

available through telnet even without giving password.  

5. Gopher 

Gopher is a protocol linked to the internet to search, retrieve and display documents from remote 

sites on the internet . It is a menu based program that helps the user to find file program, definition and 

other topics that the user specifies. Gopher protocol allows the user to free from the troubles of specifying 

the details of host, directory and file name. Instead, the user can browse through menus and press Enter 

when he finds some interesting topic.  

The user usually sees another menu, with more option, until finally the selects an option that 

displays information. The user can then read the information or save it on disk after retrieving it with 

anonymous FTP .When information is displayed the user may feel as if all the information available to 

Gopher resides on their local computer ,when in fact Gopher is interacting  with a large number of 

independently Owned computer around the world. 

6. Wais 

WAIS stands for wide Area Information service .WAIS is a internet search tool and describes as a 

protocol for computer to computer information retrieval. It is a program that permits the user to search 

information worldwide based on a service of key words WAIS has the capability of simultaneously 

searching in more than one database. 

INTERNET ADDRESSING   

Internet address is used to identify people computer and information related with internet  

IP Address 

IP address is required to communicate with other computers in the net. One must known the address 

of the computer to transfer file , send e-mail messages etc 

An IP(Internet Protocol) address is an identifier for a particular computer on a particular 

network.A32-bit  binary number that uniquely and precisely identifies the location of a particular  computer 

on the Internet . Every computer that is directly connected to the  Internet must have an IP address . An IP 
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address consists of four sections separate by period .Each section contains a number ranging from 0 to 255. 

Example, 128.43.7.12.The address has the following common characteristic. 

1. IP address is unique number  

2. No two computers can have the same IP number. 

3. IP addresses are also global and standardized. 

Domain Name   

A domain name is a name used to identify and locate computers connected to the internet. No two 

organizations can have the same domain name. 

A domain name  always contains two or more components separated by periods called `dots` Some 

example of domain name are Microsoft .com, Indiacapital.com, Kerala.com pugmark .org,Mid.edu ,etc 

,.The last portion of the domain name is the top level domain name and describes the type of organization 

holding that name . The important types of top level domain names are the following. 

 .com -Commercial Institutions 

 .edu -Education Institutions 

 .org  - Miscellaneous organization not included above  

Country codes – A two letter abbreviation for a particular country. For example ―in‖ for India  ,‖uk‖ for 

United  Kingdom. Or‖fr‖ for France, etc., 

Each domain name is an English Version of an IP address consists of four selection separated by periods. 

The Internet uses the numeric IP address to send data. A user is using a domain name, but a net work is 

connecting to the web server with IP address related with that domain name. The domain name like 

kerala.com is easy to remember than IP address like 204-28.12.5.Domain name and corresponding IP 

addresses must be unique. Domain name system server are software that translates domain names to IP 

addresses  

FACILITIES AVAILABLE ON THE INTERNET 

 Internet provides several software tools to take maximum benefits from the net. It is possible to 

communicate with people all around the world. Information on various subjects can be accessed very 

easily. A user can navigate from one topic to another and download any information required by him. 

Friendship can be built with people of related interest from around the world. Further business can be done 

and product can be advertised on the Internet. The following are some of the services that can be exploited 

by an internet user. 

1. E-mail 

2. Internet Relay(IRC) 

3. World Wide Web 

4. FTP 

5. Telnet (FTP,Telnet are explained in previous page) 

1 .Electronic Mail (E-mail) 

E-mail is an electronic message sent one computer to another. Message can be prepared and sent reliably 

over communication networks from the computer of the sender to be received at the computer of recipient  

  This facility allows the exchange mail with millions of people all over the world at economical 

rates. One can communicate with his friends, Institution, various departments through electronic mail much 

faster and at much cheaper cost compared to telephone or ordinary mail. On its way, message passed from 

one computer to another along the network. Each computer reads the e-mail address and routes it to another 

computer until it reaches its destination. It is then stored in an electronic mail box. All this process will be 

completed within few minutes and that allows the users to communicate quickly and easily with millions of 

people around the world anytime for the cost of a local phone call .The recipient of the message can open 

the mailbox and read the message at his convenience. There are e-mail programs which can manage all 

electronic messages. The reply to the message can also over internet 
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Working of e-mail  

Working of e-mail is quite simple. The sender has to type the message first and then type the e-mail 

address of the recipient. Proper are should be taken while typing e-mail address .If address is not correct, 

the message will not be received by the recipient. After that, press the` send` button of the e-mail program. 

Immediately on processing the send button, the message passes to the modem and then coded analog 

signals are sent over the telephone line. The e-mail message then arrives at the server of our ISP. If it 

recognizes the e-mail address, the mail will be sent. The mail is then sent through Internet .The message 

will be received by the recipient. ISP and server where it will be delivered to the recipient`s mail box. 

Finally, the recipient modem and computer decode the data and the message now can be read by him. 

 

E-mail Address  

Electronic message are delivered to the recipient at his e-mail address. E-mail address is a series of 

character that precisely identifies the location of person`s electronic mail box. 

E-mail addresses are made up of the following. 

 The user name (sometimes only 8 characters) 

 Then @symbol. 

 Then the name of the user`s ISP 

 The last 2 or 3 characters describe the type of service called the top level domain name. For 

example .com stand for commercial site, .org stands for organization, edu. Stands for 

educational institutions, net-network, etc…………. 

For example sarath@imageequity.com is an e-mail address. An e-mail address is read from left to right. 

Sarath is the users‘ name. He is the person who received or sends message. Image equity is part of the 

domain name of the organization.` com` is also part of the domain name  and indicates that image equity is 

a commercial organization 

An e-mail user can also make use of customize facilities available in e-mail programs. E-mail can 

be sent both in text format or HTML format. The advantage of using HTML format is that color can be 

added with text .Moreover formatting facilities like bold italic, bulleted or numbered lists etc. can also be 

used .Spell checking facilities are also available in e-mail program. 

We can also attach files to email message to sent picture, sound, documents, Videos and other types 

of file with your email. Some email program automatically open attachment such as photos and html code. 

Change the program`s properties or option to turn to the feature on or off. 

Unrequested spam email has become a problem on the Internet. A large percentage of the email 

sent is this unrequested email which takes up band width and causes prices to rise. Most ISPs provide 

software known as span filters that will filter out this type of email. 

 

2. Internet Relay Chat (IRC) 

Internet Relay Chat is a real time internet based chat service, in which one can find `live` participants from 

the world over. It is a multi user chat system that allows many people to communicate simultaneously 

across the Internet.  Developed in 1988 by j. Oikarimen in Finland, the IRC offering a unique type of 

talking experience on the net has been used extensively for live coverage of world events, news and sports 

commentary .The IRC network on the internet consists of multiple interconnected servers. The IRC service 

provides a number of channels; public, private, secret or invisible. A user can select a channel of his choice 

and be part of a particular conference on the internet .The user`s interaction with his fellow people is 

achieved through a specially designed software namely the IRC client. 

The IRC also allows the facility to the user to change from one chat group to another, join any conversation 

or listen only .It is also possible to invite somebody for a secret chat in the internet. 

 

mailto:sarath@imageequity.com
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3. World Wide Web(WWW) 

World Wide Web or simply web is one of the main reasons for the growing popularity of the Internet.  

Information can be accessed on the internet through World Wide Web. Web is a system of organizing, 

linking and providing access to related internet files, resources and services. Files can be access to related 

internet files, resources and services. Files can be accessed at the click of the mouse. This is mainly due to 

the arrangement of file based a hyper-text or hyper media approach. The web is an internet based 

navigational system, an information distribution and management system with vast potential of trade and 

commerce.  

      The World Wide Web is the graphical internet service that provides a network of interactive document 

and the software to access them. It is an internet based navigational system based on document called pages 

that combine text, picture, forms, sound, animation and hyper links. In simple words, the web is a 

collection of distributed document referred to as pages located on computers or servers all over the world. 

Servers store hyper text mark-up language (HTML) files and respond to requests. Users can access 

documents through the use of a browser. 

Internet provides several facilities for its maximum exploitation. File transfer, electronic mail and news 

group are some of the important facilities provided by internet. However World Wide Web (WWW) is 

perhaps one of the most popular and fastest growing facilities in the history of networking. Experts predict 

that use of web going to be so widespread like the use of telephone in the near future. It has become not 

only an integral part of internet but has become the exciting aspect of the internet. 

The ever increasing use of web has accelerated the growth of the internet. Web is an easy to use, point and 

click graphical interface. It is also interactive because it is easy to use and combines graphics, text, sound, 

and animation into an effective communication medium. It also enables the creation, manipulation, 

organization and retrieval of documents that contain audio and video clips, graphical images and formatted 

text. Web servers, also called web sites are equivalent of a book and we` page` are the specific pages of the 

book. A web server is essentially a collection of multimedia pages. Use start their exploration of a web site 

at the  `home page` which often server as a table of contents. A home page is accessed by entering the 

domain name of a site. Then user can `surf` from one page to another pointing and clicking on the hyper 

link in text or graphics. 

Originally, web was developed to share document between distant scientists. In 1989, Tim Berners Lee at 

CERN (European Laboratory for particle physics) an engineer, began the web project. As soon as the basic 

outline of the web was complete, CERN To made all the software source code publicly available. Many 

programmers in USA participated in the initial development of the web. Later in1993, programmers 

developed `Mosaic` the first browser with graphical user interface. Use the web facilities, user needs 

special software called a web browser .It acts as an interface between the user and the internet. It sends 

request for data to other computers and then formats them for the users screen. Documents are formatted 

using hyper text Mark-up Language (HTML) 

 

Electronic Data Interchange 

EDI (Electronic Data Interchange) is simply the means to communicate between companies from one 

computer to another. For many years companies have been using computers to send business documents 

instead of mailing paper documents (i.e. most of our pay checks are directly deposited into our bank 

accounts). This transfer of funds is accomplished by the use of an electronic file being sent from your 

company to your bank). In 1979 the American National Standards Institute (ANSI) formed the Accredited 

Standards Committee (ASC) X12 to rectify this situation. Electronic Data Interchange (EDI) is simply a 

set of data definitions that permit business forms that would have been exchanged using paper in the past, 

to be exchanged electronically. This simple set of definitions has spurred a number of organizations to put 

in place an operational environment in which the exchange of electronic business forms substitutes for the 
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exchange of paper forms. This has resulted, in some cases, in the establishment of an EDI environment, 

which arguably represents the most advanced state of electronic commerce today, causing some to view 

EDI and electronic commerce as one and the same. We view EDI only as a subset of electronic commerce, 

albeit a very important one. As such, EDI provides an excellent example of a working electronic commerce 

environment and is a good starting point for examining electronic commerce. 

 

OBJECTIVE 

The basic documents for transaction of business will be taken only once by one agency and other agencies 

will take the information from that agency, electronically, avoiding the need to either physically take the 

document from one office to another or keying in the data again and again involving the attendant 

problems of manual labor and errors creeping in at each stage of data entry.          

       

 The use of EDI allows for the following benefits: 

 Reduced manual data entry 

 Reduced postage and handling costs 

 Reduced labor processing costs 

 Reduced order cycle 

 Increased customer service 

 Improved accuracy of data 

 Reduced lead times 

 Reduced paper handling 

 Reduced inventory carrying costs 

 

Business application of EDI 

 

EDI is paperless document transfer between companies. A document is any form of communication, 

usually paper, sent between two companies. Examples include:  

 Purchase Orders 

 Invoices 

 Shipping Notices 

 Export/Import Information 

 Carrier-to carrier waybills 

 Funds Transfers 

 Design Specifications 

 Health Insurance Claims 

 

EDI is a data processing concept independent of communication protocols or transmission media. EDI is a 

logical outgrowth of the standard computerization going on within business for the last several decades. 

The type of electronic communication between departments within a business is now being extended to 

reach out to other business, or trading partners. 
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EDI is computer-to-computer communication. Contrast this with the other forms of communications like 

Electronic mail. E-mail is person-to person communications over a computer. A person creates a text 

message, which is sent to another person. While this form of communications is electronic, it still requires 

people to interpret the message.  

EDI replaces human-readable, paper or electronic based documents with machine readable, electronically 

coded documents. With EDI the sending computer creates the message and the receiving computer 

interprets the message without human involvement.  

 

Questions 

1. What is internet? Explain its features? 

2. What are the components of internet? 

3. What are the popular internet services? 

4. What is internet protocol? Discuss commonly used protocols? 

5. What is WWW and explain its uses? 

6. What is EDI? What are its objects? 

7. What are the benefits of EDI? 

8. What are the business applications of EDI? 

9. What is internet addressing ? 

10. Explain the terms: 

 

 IRC 

 Telnet 

 WAIS 

 Gopher 

 Usenet 
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Module 5 

Computerized Accounting and  

           Accounting is a necessary function for any business. All businesses must keep a record of their 

income and expenses and the records should be as detailed as possible. For some, the idea of spreadsheets, 

general journal books and ledger sheets is frightening. For these people, computerized accounting could be 

a welcome relief. 

The two biggest advantages of a computerized accounting system are speed and accuracy. When using a 

manual accounting system, each step in the accounting cycle must be performed by hand. For example, if a 

business pays their electric bill, a cheque has to be written, an entry must be recorded into the cheque 

register, and the transaction has to be posted to the respective ledgers, In this case, a debit to the electric 

company‘s ledger account and a credit to cash. With a computerized accounting system, the steps described 

above are completed with one entry. The journal entries for cash and the electric company are 

automatically posted to their respective ledgers. What could take several minutes manually takes only 

seconds with a computerized accounting system. Also, because only one entry needs to be made with a 

computerized system, the likelihood of an incorrect entry is greatly reduced. 

Another advantage is the ease of producing end of period reports. With a manual system, each general 

ledger entry would have to be posted to the financial statements by hand. With a computerized accounting 

system, each computerized transaction is automatically posted to both the general journal and the 

respective ledgers, which makes producing balance sheets, trial balances, and end of period financial 

reports as simple as selecting the desired report from the menu.  

Other advantages to using computerized accounting are: 

 Instant access to accounting information. Because each entered transaction is automatically 

posted to its respective account, all account information is always up-to-date. 

 Easy document production. Purchase orders, debit memos, sales receipts, sales invoices, 

inventory lists and others can be printed in moments. 

 Staff motivation. Accounting and bookkeeping departments should run more smoothly and be 

more efficient with computerized accounting software. There will be less time spent on compiling 

reports. 

 Legibility. Computerized accounting software eliminates the need to decipher poor or odd 

handwriting, eliminating much of the possibility of error due to misreading a hand-written line item.  

 Ability for taxes to be computed automatically. This makes paying quarterly or annual taxes 

easier since the computerized system will keep a running total of all taxes owed. 

Many financial accounting software packages are available in the market. Most popular packages are Tally, 

Peachtree, DacEazy, EX_NGN, Wings etc., let us discuss the features of Tally. 

Introduction of Tally 9  

Tally 9 is the wonderful accounting software. It attained good reputation in the field of business .A 

businessman wanted an accounting software which be handled easily. Tally 9 is pure on this desire of 

businessman.There is no difficulty in operating tally 9, accounting software.  It uses three fundamental 

formula for recording: 

1
st
 formula à is to record different companies‘ creation, display and alteration 

2
nd

 formula à is to record all ledger accounts vie create, display and alter under different head or master 

accounts. 

3
rd

 formula à is to record all voucher entries. 

 

http://nirushi.blogspot.com/
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Components of Tally Screen (Gateway of Tally) 

Gateway of Tally of an "Accounts Only" Company  

The Gateway of Tally menu of an Account Only Company appears as: 

The Gateway of Tally screen is separated into four sections, – Title Area, Main Area (Ctrl + M), Calculator 

Area (Ctrl + N) and the Button Bar. 

 

Main Area  

The left-hand side of the Main Area gives information of 

Current Period – this is the currently loaded or selected company's accounting period. 

Current Date – this is the date of the last Voucher Entry of the selected company (this is NOT the 

calendar date). 

List of Selected Companies – This displays the name of the loaded or selected company.  

Masters – for creation of Accounting Masters and Importing Master information 

Transactions / Vouchers - for creation of Accounting Vouchers and Importing transaction information 

Reports – for viewing and printing financial reports using the information given in Masters and 

Transactions.  

 

Button Bar 

The Button Bar area on this screen, displays the following buttons (keys): 

Help (Alt + H) – to access Tally's online context-sensitive help 

F1: Select Cmp – to select a company 

F1: Shut Cmp – to shut or close the company 

F2: Period – to change the period 

F3: Cmp Info – to access the Company Information Menu 

 

F11: Features – to access the Company features for a company 

F12:Configure – to access the configuration settings to manage the information put into Tally.  

You cannot load more than one company at one time. The loaded or selected company will be shut first and 

then the other company is loaded.  

 

Company creation in tally 

To start accounting with tally you need to create company. Here we are going to learn how to create a 

company in tally. Since tally launched the latest version ERP9, We are using tally ERP9 for our study 

 

Step I 

Double click on tally icon from your desktop you will have a company info menu on the right side of the 

screen like below 

 

http://tallyguide.blogspot.com/2008/12/gateway-of-tally-of-accounts-only.html
http://1.bp.blogspot.com/_-s4xHtbG_y0/S8bHk0f1chI/AAAAAAAAAOs/fYngNEOzwv0/s1600/company+info+menu.gif
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Step II  

Select Create company by pressing down arrow key  and press enter Company Creation screen will be 

displayed 

 
This is the company creation screen where we can enter company details, Data storage etc. Let us explain each 

section separately. 

Directory:-  Directory means the data storage location , This is the place where tally store all data‘s you entered in 

tally. By default the data storage will be inside the installation folder, Data will be stored in D:/ if you installed tally 

in D drive. You can change it at your desired location by typing it manually. 

Name: Type the name of the company in this field, for Example. ABC LTD 

Address: This is the place where we can enter the address of the company. 

Statutory compliance for:  Select the country in which your business exists. 

State: Select the state in which you want to comply statute 

Pin code: Pin code of the location where your company office exists. 

Telephone: Enter telephone number 

Mobile No: Enter mobile number 

Email: Enter your official communication mail id 

Currency Symbol: Enter the currency symbol for example Rs for Indian Rupees, USD for US dollar etc. 

Maintain:  Here you can select how you maintain your company. Some companies are required to maintain stock 

items along with accounts, in such cases select 'Accounts with inventory' or else your requirement is only to keep 

accounts only select 'Accounts only' 

Financial year from:  

Type financial year in which you want create a company. Suppose you may be starting company on September 01 

2010, you should enter the financial year from as 01.04.2010. 

Book beginning from:  

Most of the companies have a book beginning date same as above field but may differ for companies which are 

starting in the middle of the financial year. From above example your book beginning date is 01.09.2010 

Tally vault password:  

This is for security purpose, by entering password you can prevent unauthorized access of company data. But keep 

the password in writing in a safe place to prevent future password lost. You will have to enter this password each 

time you open your company. Be careful, forgetting your password, you will not be able to use tally data 

http://4.bp.blogspot.com/_-s4xHtbG_y0/S8bIaGy_o4I/AAAAAAAAAO8/vSfUuSzUJuw/s1600/company+creation+screen.GIF
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Use Security control: 

 By enabling this you will get a complete control over your data, you can assign some people only for data 

entry, give more access to some other using this feature. We will have a detailed discussion about security 

controls later. 

Base currency information 

You can configure currency option under this field. You can see a company creation screen below. 

 
Step3 

Accept the screen. If you have entered a tally vault password you will be asked  a password to create 

company in screen like below. 

 
 

Enter tally vault password here and press enter you can see a screen importing statutory masters  

 
 

Immediately after completing statutory masters importing you will lead to a new screen Gateway of tally 

 

 

http://4.bp.blogspot.com/_-s4xHtbG_y0/S8cm6_tzGzI/AAAAAAAAAPE/UkKYU6V-qoY/s1600/COMPANY+CREATION+FILLED+SCREEN.GIF
http://1.bp.blogspot.com/_-s4xHtbG_y0/S8cn_gPV2JI/AAAAAAAAAPM/7CarBPBctbY/s1600/TALLY+VAULT+PASSWORD.gif
http://1.bp.blogspot.com/_-s4xHtbG_y0/S8cp0pPdXJI/AAAAAAAAAPc/qwN1s9-sEHU/s1600/STATUTORY+IMPORT.gif
http://1.bp.blogspot.com/_-s4xHtbG_y0/S8cpBqMxsoI/AAAAAAAAAPU/kQiC1SgGW4U/s1600/gateway+of+tally.gif
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On the left side you can see the current period, current date, Name of the company ,Name of last Entry etc. 

Just under Name of the company you can see the name of newly created company in boldface. This means 

that listed company is loaded. Next time when you open tally this company will have loaded automatically.  

On the right side you can see tally data entry voucher to enter data. 

Classification of Account-heads  

Tally follows the 'Single Ledger' concept of accounting, which is the modern way of managing accounts. 

This is in direct contrast to Subsidiary Ledger Accounting. Thus, all financial entries are performed using 

ledgers or account heads. Ledger account heads are created to identify transactions. Groups, in Tally, serve 

to both classify and identify account heads according to their nature and enable presentation of summarized 

information. Tally gives you great flexibility in setting up your chart of accounts. It allows you to group 

your ledger accounts right at time of creating your accounts chart. Your reports and statements will reflect 

the desired classification at all times 

     Groups have a hierarchical organization. At the top of the hierarchy are Primary Groups. These are the 

main asset, liability, income or expenditure groups of accounts that determine the entire accounting and 

their presentation, i.e., whether a ledger affects Profit & Loss Account (as a revenue item) or goes into the 

Balance Sheet. The Reserved Primary Groups and subgroups (shown indented) are:  

1) Primary Groups of capital nature 

a)Capital Account 

b)Reserves and Surplus [Retained Earnings] 

2) Current Assets 

a)Bank Accounts 

b)Cash-in hand 

c)Deposits (Asset) 

d)Loans & Advances (Asset) 

e)Stock-in-hand 

f)Sundry Debtors  

3) Current Liabilities 

a) Duties and Taxes 

b) Provisions 

c) Sundry Creditors  

d) Fixed Assets 

4) Investments 

5) Loans (Liability) 

a) Bank OD Accounts [Bank OCC Accounts] 

b) Secured Loans 

c) Unsecured Loans  

6) Suspense Account 

7) Miscellaneous Expenses (Asset) 

8) Branch/Divisions 

9) Sales Account 

10)Purchase Account 

11)Direct Income [Income Direct] 

12)Indirect Income [Income Indirect] 

13)Direct Expenses [Expenses Direct] 

14)Indirect Expenses [Expenses Indirect]  

Voucher entry- Major types  

http://tallyguide.blogspot.com/2009/01/classification-of-account-heads.html
http://tallyguide.blogspot.com/2009/02/vocher-entry-major-types.html
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In Tally, Voucher entry consist of mainly two types I) material in & out II) Amount in & out. 

In each type sub varieties are there as below 

I) Material In & Out 

1. Sales voucher 

2. Purchase voucher 

3. Goods receipt notes 

4. Rejection in 

5. Rejection Out 

6. Delivery notes Etc. 

II) Amount In & Out 

1. Receipts 

2. Payments 

3. Contra 

4. credit notes 

5. Debit notes 

6. Commission 

7. Discounts. Etc 

If we learn OR understand mainly Sales, Purchase, Payment & Receipts entry, Then all other entry are 

similar to above entry only relevant situation different names are there.  

Contra Entry (F4)  

Gateway of Tally > Accounting Vouchers > selecting F4: Contra > displays the Contra voucher entry 

screen. As per accounting rules, Contra Entry is a transaction indicating transfer of funds from: 

1. Cash account to Bank account 

2. Bank account to Cash account 

3. Bank account to Bank account 

Contra Entry screen appears in the Single Entry Mode by default. You are prompted to choose the account, 

which will receive the amount (the debit ledger). 

Payment Voucher  

Gateway of Tally > Accounting Vouchers > selecting F5: Payment > displays the Payment voucher entry 

screen. Payment transactions can be entered using Tally's Payment Voucher. 

Voucher entry  

A voucher is the basic recording document. To input any data into Tally, you must use a voucher. Inputting 

data through the voucher entry mode may be called creating a voucher or voucher entry. You may create a 

voucher on-line on Tally and print it for hard copy and authentication. Vouchers/Transactions are used to 

enter/record a transaction in Tally. 

Gateway of Tally > Accounting Vouchers 

This will open the Accounting Voucher Creation screen. Tally is pre-programmed with a variety of 

accounting vouchers, each designed to perform a different job. The standard vouchers are: 

Payment Voucher 

Receipt Voucher 

Contra Voucher 

Sales voucher 

Sales Orders 

Sales Vouchers/Invoices 

Delivery Notes 

Rejection In  

Purchase Voucher 

http://tallyguide.blogspot.com/2009/01/contra-entry-f4.html
http://tallyguide.blogspot.com/2009/01/payment-voucher.html
http://tallyguide.blogspot.com/2009/01/voucher-entry.html
http://tallyguide.blogspot.com/search/label/Payment%20Voucher
http://tallyguide.blogspot.com/search/label/Payment%20Voucher
http://tallyguide.blogspot.com/search/label/Receipt%20Entry%20%28F6%29
http://tallyguide.blogspot.com/2009/01/sales-item-invoice.html
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Purchase Orders 

Purchase Vouchers 

Goods Receipt Notes 

Rejection Out  

Journal Voucher 

Credit Notes 

Debit Notes 

Journal  

Memo Voucher 

Reversing Journal  

Stock Journal 

Physical Stock 

You can alter these vouchers to suit your company, and also create new ones. For example, if you wish to 

distinguish between cash and bank payments you can create vouchers to do this. 

 

 

Create a Voucher Type  

Create a new voucher type 

 

Gateway of Tally > Accounts Info. > Voucher Type > Create 

a new voucher type must assume the functions of a predefined voucher type, the following features should 

be specified 

Name 

Type of Voucher 

Abbreviation 

Method of Voucher Numbering 

Automatic - Manual -  

None - Advanced Usage 

Starting number 

Widths of Numerical Part. 

Prefilled with ZERO? E.g. 001 1 

Use common narration 

restart Numbering, Prefix Details, Suffix Details 

Financial Statements and Reporting 

    Tally has built in report formats that can be used for generating standard reports. Ratio analysis, cash 

flow statement, fund flow statement, budget and scenario management are some of the built- in- report or 

analysis facilities in tally. In additions to these tally can automatically generates bank reconciliation 

statement, inventory reports etc., 

Let us discuss in brief: 

 

Display Balance Sheet 

The term balance sheet implies that a report shows the balance between two figures. It shows a balance 

between the assets and liabilities of a firm and the owner's funds. The fundamental accounting equation 

applicable is therefore, Assets = Liabilities + Owner's Equity. 

To view the Balance Sheet: 

 

http://tallyguide.blogspot.com/2009/01/create-voucher-type.html
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Go to Gateway of Tally > Balance Sheet 

 

 
Press F12: Configuration and set the required parameters to display the Balance Sheet according to your 

preferences.  

Balance Sheet gets updated instantly with every transaction voucher that is entered and saved. You can 

view additional information or toggle to another report using the options available in the Button Bar.  

Some of the Button Bar options is 

 Select F1: Detailed/Condensed to explode the summarized information. 

 Change the date of the Balance Sheet using F2: Period. 

 View different effect of different Stock Valuations on the Balance Sheet. 

 Add  up new columns to 

 Display the Balance Sheet for a different date to compare with current one 

 Display the Balance Sheet of Another Company when more than One Company is opened 

 Display the Balance Sheet in a different currency 

 Display the Budget figures and analyze the variances 

 

Display Profit & Loss Account 

The profit and loss account in Tally.ERP 9 displays the information based on the default primary groups. It 

is updated instantly with every transaction/ voucher that is entered and saved. No special processing is 

required to produce a profit and loss account in Tally.ERP 9. 

To view the Profit & Loss Account of ABC Company, 

Go to Gateway of Tally > Profit & Loss A/c 

 Click F1: Detailed, to view the Profit & Loss Account in detailed format. 
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The Profit & Loss Account is displayed as shown: 

 

 
The Profit & Loss account is generated and updated immediately from the date of opening of books till the 

date of last entry. 

Press F2: Period to change the period as required. 

The Profit & Loss Account is displayed according to the configuration set up in the F12: Configure. The 

Profit & Loss A/c, by default is in horizontal form. You may configure the same to view in Vertical form 

by pressing it in F12: Configure. Some of the Button Bar options are  

 Select F1: Detailed/Condensed to display more information or condense. 

 Change the date of the Profit & Loss Account using F2: Period. 

 Add  new columns to  

 Display the Profit & Loss Account for a different period to compare with the current 

one    

 Display the Profit & Loss Account in a different currency  

 Display a column with Budget figures and analyze variances  

 See the effect of different Stock Valuations on the Profit/Loss account. 

 Select and compare Profit & Loss of different companies. 

Display Ratio Analysis Report 

Ratio analysis is a powerful tool for financial analysis. A meaningful analysis of a financial statement is 

made possible by the use of ratios.. A single ratio may sometimes give some information, but to make a 

comprehensive analysis, a set of inter-related ratios are required to be analyzed. 

To view the Ratio Analysis  

Go to Gateway of Tally> Ratio Analysis  

The Ratio Analysis screen is displayed as shown. 
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The screen is divided into two parts:  

 Principal Groups  

 Principal Ratios 

Principal Ratios relate two pieces of financial data to obtain a comparison that is meaningful.  

Principal Ratios 

You can compare Principal Ratios of your company over a certain period with industry averages as well 

as with ratios pertaining to other periods to assess current performance. 

Current Ratio 

(Current Assets: Current Liabilities)  

This indicates the solvency position of the enterprise. The ideal ratio is 2 under normal business conditions.  

Quick Ratio 

(Current Assets � Stock in Hand : Current Liabilities)  

This indicates the liquidity position of the enterprise. This ratio is useful in planning future cash 

requirements. 

Debt Equity Ratio 

(Loans (Liabilities) : Capital + Net Profit)  

This indicates the level of exposure to external borrowings and is a useful tool in determining the options 

of raising additional capital internally or externally. 

Gross profit %  

(Gross Profit / total Turnover) 

This indicates the percentage of profit earned from direct operations (manufacturing)., This ratio is useful, 

where an enterprise produces more than one product, in identifying the order of profitability and making 

decisions such as increasing production capacity, continuance of a product etc. 

Net Profit % 

(Net Profit/ Total Turnover)  

This indicates the percentage of net profit earned by the enterprise after considering all expenses of the 

enterprise. This is useful in identifying the overall profitability of the enterprise. 

Operating Cost % 

(As percentage of Sales Accounts) 

This is referred to as the percentage of operating cost with respect to the total turnover This ratio is useful 

in making decisions in the areas of cost control, cost reduction etc. 



School of Distance Education 
 

Information Technology for Business & Management                       141 
 

Receivables Turnover in days 

(Payment performance of Debtors) 

This is an analysis of debtor wise payment performance and a useful tool in identifying the most preferred 

and least preferred customers or agents and planning the receivables collection process. 

Return on Investment % 

(Nett Profit/Capital Account + Nett Profit) % 

This is a useful tool in measuring returns expected from the project/product and plan additional capital 

infusion, increase in production capacity (subject to market demand) etc. 

Return on working capital 

(Nett Profit/Working Capital) % 

This is referred to as the percentage of net profit to working capital (current assets � current liabilities). 

Working capital turnover ratio 

(Sales Account/Working Capital) 

This indicates how effectively working capital is used in terms of turnover it can help to generate. It is a 

useful tool in identifying the level of deployment of funds with respect to sales. 

Inventory turnover ratio  

(Turnover / inventory)  

This indicates the relationship of inventory with respect to sales. This is a useful tool in identifying the 

extent of investment in stock and indicates  

1. Stock control measures whether to be taken in case of change in demand 

2. Procurement planning 

Cash Flow Projection in Tally.ERP 9 

To view Cash Flow Projection: 

 Go to Gateway of Tally > Display > Cash/Funds Flow > Cash Flow Projection 

The Cash Flow Projection screen appears as shown: 

 

 
2. By default, the projected columns are displayed on monthly basis. Click N: Auto Column or press 

Alt+N to select the required column details. 
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Fund Flow in Tally.ERP 9 

To view Funds Flow 

Go to Gateway of Tally > Display > Cash/Funds Flow > Funds Flow 

1. Press ALT+F2, change period - From: 1-04-2008 to 31-8-2008. 

The funds flow statement is displayed as shown. 

 
2. A Monthly Funds Flow Summary with the movement of working capital for each month is 

displayed. It shows the Opening and Closing Balances of each month with a column for Funds 

Flow. 

3. Select a month and press Enter to drill down. 

4. Select F1: Detailed to see the funds flow for the selected month. 

 

 
 

Tally prepares inventory reports and various other reports, books, statements (e.g. BRS) etc, based on the 

voucher entered to date by the user. We can view and analyze these reports, statements, books etc., by 

using Display option from gateway of tally. For example: 

For display inventory report: 

Gateway of tally > Display >statements of inventory >Stock summery 

 

Printing Reports 

The user can print the current screen display in Tally by selecting PRINT from the top of the button bar 

menu. This brings up new button bar options and the print configuration screen for the report which asks 

Print? Yes or No. before a document is printed; the user can view the output beforehand With Preview 
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Questions 

1. What are the benefits of computerized accounting? 

2. How do you create a company in tally? 

3. Discuss classification of accounts in tally? 

4. What are the voucher types in tally? And how you crate voucher? 

5. Explain financial analysis and report generation in tally? 

6. How do you display and print reports in Tally? 

7. What are the components of Tally screen? 
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